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Extender Overview
Important! The documentation refers to the latest product update for the latest version of Sage 300,
currently version 2025. Unless otherwise specified, the content applies to all supported versions, cur-
rently versions 2025, 2024 and 2023.

Extender is a multi-function module that allows you to extend the functionality of Sage 300 (Accpac) in
many different ways.

Configure events to enable alerts, log changes and monitor changes in Sage 300 Data.
Design Python scripts to automate business processes, enhance systems integration and provide
tailored validation and alerting by extendingSage 300 Business Logic (as defined in the Sage 300
Views).
Develop Custom Tables and Custom Screens which form part of the Sage 300 database and data-
base dictionary to tailor the core system to meet a Customer's exact needs.

EXTENDER CONFIGURATOR OVERVIEW
With Extender Configurator Edition, you con configure

Log when a record is inserted, updated or deleted through Sage 300 View or log when a view field
being amended
Send an email when a view record is inserted, updated or deleted or a view field is amended
Create an Information Manager Note when a view record is inserted, updated or deleted or a view
field is amended
Run a program when a view record is inserted, updated or deleted or log a view field being
amended

EXTENDER DEVELOPER OVERVIEW
Extender Developer Edition allows you to attach any number of PYTHON 3 Scripts to a Sage 300 View are
executed each time the view is accessed. Using PYTHON 3 scripts for site/company specific cus-
tomisations provides a flexible way of implementing site specific customisations, without having to com-
pile the customisations and/or upgrade them for future versions of Sage 300.

EXTENDER ARCHITECTURE
Extender configurations and customizations work in the Sage 300 Development environment (SDK). You
can use Extender with Sage 300 core modules or 3rd party modules developed in the SDK. Con-
figurations and scripts are saved in the Sage 300 databases.

For more details, refer to the Video presentation below: 
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In the Image below, we represent in green standard Sage 300 and in Orange where Extender interacts
with the Sage architecture. Extender works both with the Sage 300 business logic and the classic desktop
screens.
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Extender Configurator Tutorials
Review examples to configure Sage 300 to log changes to records, send an email or create an Inform-
ation Manager Note.

Tutorial - Setup Extender to Log changes to A/R Customer Credit Limit 9
Tutorial : Make a field ReadOnly in Sage 300 12
Tutorial : Create a custom table in Sage 300 15
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TUTORIAL - SETUP EXTENDER TO LOG CHANGES TO
A/R CUSTOMER CREDIT LIMIT
A company wants to log all changes to the A/R Customer Credit Limit using Orchid Extender.

Extender Setup
Requirement! This functionality is available in Extender Levels Configurator, Customizer and
Developer.

Step 1: Create a "LOG" Event Type in Extender Setup / Event Types

Choose "Log Change" as the Action.

Choose "Don't Combine" so that the original and new values are logged.

Save the Event Type.
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Step 2: Attach the LOG Event to the A/R Customer Credit Field in Extender Setup / View Events and
Scripts.

Enter AR0024 as the View ID for A/R Customer.

Select AMTCRLIMT as the Field Name and choose LOG as the Event Code.

Note:
If you have already configured Extender for the A/R Customer View, a list of events configured
will be displayed.

If you don't know the View ID, you can click F6 or the "All Views Info" icon to display a list of
all Extender Views active in the database.

You can use Extender / Inquiries / View Info to view additional details on the Extender Views.

Step 3: Add / Save the View Event.

Viewing Log Details
In A/R Customers, Update the credit limit for Customer 1200, Mr Ronald Black.

You can view the Extender log directly from the A/R Customer Screen or from the Extender / Inquiries /
Log.

Note: If you update the customer credit limit by importing into Sage 300, from Sage CRM or other
Third Party applications that use the Sage 300 Views and API, Extender Logging will also take place.

From the AR Customer screen

Highlight value in a text field, and type ` (back tick) and tab - The Extender Log for the selected customer
will display (filtered by default for the current month. You can change the filter on the Extender Log
Screen.
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Tip:
You can view the Log for a particular view in the original screen. For example if you want to view the
changes made to the Customer view from the Customer entry screen, highlight any text field and enter
` (back tick) and [tab]and the Extender Log will be displayed, filtering on the appropriate View. An
example of a text field on the Customer screen on the processing tab is the Credit Bureau Information
Rating field or the Credit Bureau Information Number field. Other examples are the Address fields on
the Address tab.

`[tab] cannot be entered on a date, a number, a check box field or a lookup field with a mask on what
can be typed in the field. If the text field already has information – for example the Customer name,
you need to select all the text (highlight it), then type `[tab] – the VI Log will be displayed and the ori-
ginal text restored to the field.

If you are using Information Manager and have licences for Workflow Users, you can configure an icon
on the Sage 300 screen to view the Logs.

For details, refer to Extender LOG- Notes/DML/Extender Tray on page 199.

Extender Inquiries / Log

You can view all log entries in Extender Inquiries > Log.

Use [Ctrl F] in any of the columns to filter the log contents by the selected column.

The current filter is shown along the bottom of the screen, and is saved per user per screen.
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Tip: You can apply a filter on multiple columns by first clicking [Ctrl] on the first column required and
applying the filter, and then by clicking [Ctrl] on the second column required and applying the filter.

Tip: If the filter is not cleared prior to closing the screen, it will be remembered and re-applied the next
time the same user opens the same screen.

For More Details on Setting up Extender Configurator.
Event Types. on page 90

View Events, Scripts & WF on page 147

TUTORIAL : MAKE A FIELD READONLY IN SAGE 300
We often get asked "How do I make a field in Sage 300 Read Only with Extender"?

You can download the AR Sample script to make the Credit Limit field read only for all users except
Admin from the Resources area of the Orchid Website (Make AR Customer Credit Limit Read Only).

Save the script file.

Then in Extender Setup / View Events and Scripts, create a new entry for View ID AR0024 and attach
the script to the view. (Use F6 to open Windows Explorer to upload the script into Sage 300).

Extender Setup for AR Credit Limit
Requirement! This functionality is available in Sage 300 Levels Customizer and Developer. The tutori-
als assumes Extender is installed and activated in the Sage 300 database.

Download a Sample Extender Script from the Orchid website (available to registered users only).

Tip: Use Make AR Customer Credit Limit Read Only and Save it in a Temp directory.

In Extender, go to Sage 300 > Setup > View Events and Scripts

Attach the script to the A/R Customer View.

Enter AR0024 as the View ID for A/R Customer.

On the Scripts Tab, insert a row and click F6 to open a browser.

Navigate to the folder where you saved the script, select the script, click
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Note:
If you have already configured Extender for the A/R Customer View, a list of events and scripts
configured will be displayed.

If you don't know the View ID, you can click F6 to display a list of all Extender Views active in the
database.

You can use Extender / Inquiries / View Info to view additional details on the Extender Views.

Save the View Event.

Login as a Non Admin User.

Restart the Sage Desktop, login as a non Admin user, you will notice that the AR Customer Credit Limit
field is not editable.
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Important! Important: Because Extender works at the view level, this validate will apply to

Imports into Sage 300 and to external programs updating Sage 300 through the Views. So

if you are making a field read only that should be updated through imports or other pro-

grams, make sure those programs use credentials with appropriate rights.

Variation 1: Make AP Vendor credit limit read only
If you want to make the Credit Limit field on the AP Vendor screen, use Extender Inquiries / View Doc to
check the AP Vendor Credit Limit field name (AMTCRLIMT).

Save the AR Credit Limit script with a new name (it is suggested to use a separate script even though it is
the same field name to avoid confusion as you may want to have different user validation on A/P and
A/R).

in Extender Setup / View Events and Scripts, Attach the script to view AP0015 (AP Vendor view).

Variation 2: Make EXTCOST read only on Sage 300 I/C Adjustment
view
If you want to make a different field Read Only, for example EXTCOST in the Sage 300 I/C Adjustment
view,

Open the Script in your favourite Text Editor and replace the credit limit field with the 'EXTCOST'.
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Save the script file.

Then in Extender Setup / View Events and Scripts, create a new entry for View ID IC0110 and attach the
script to the view. (Use F6 to open Windows Explorer to upload the script).

Note:
The script works, but note that Sage 300 I/C Adjustments expect a value in the Cost Adjustment
(EXTCOST) field for Cost increase/Cost decrease script, so you probably need to adjust the script so
that the field is only read only for certain adjustment types or remove some adjustment types options,
depending on your requirements.

There is also a sample Extender script to default I/C Adjustment types, which might help if the exten-
ded cost validation is only for certain adjustment types. Default I/C Adjustment Type Sample Extender
Script.

TUTORIAL : CREATE A CUSTOM TABLE IN SAGE 300
You want to link Salesperson in Sage 300 to a Sales region group and report on Sales targets by
region.

1. Create a table in Extender to define Sales regions and targets by region

Extender Configurator Tutorials Page 15 of 222



Extender

2. Add a table in Extender to link Sage 300 sales person to a sales region (as you cannot attach
optional fields to a Sage 300 sales person out of the box).

3. Enter data

4. Add the custom tables to a custom Crystal Report or an Info Explorer cube.

Tips: As the tables are in the Sage 300 data dictionary, you can develop the report in one

database and deploy on another one and data is available for Dump and Load

Create a table in Extender to define Sales regions and targets by
region
Requirement! This functionality is available in Sage 300 Level Developer. The tutorials assumes
Extender is installed and activated in the Sage 300 database.

In Extender, go to Sage 300 > Setup > Custom Tables

Type a Table Name and a Description.

Tip: You can leave the View ID Blank, as Extender will give the table a unique ID
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Add the Fields you want to track.

See Custom Tables on page 102

Extender Configurator Tutorials Page 17 of 222



Extender

Define the key field/fields.
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Restart the Sage Desktop for the Custom Table to be available.
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Enter data in the Custom Table Editor

Note: If you have multiple key fields, you may want to build a custom screen in Python.

Create a table to track Region by Salesperson

Note: The table created above can be added
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Use the data in custom reports
The data is now held within the Sage 300 database, so is available for use in custom reports, will be
included in backups, database dump and loads. It can also be used in custom Extender Python scripts
and If using Information Manager Notes, the data can be displayed in the Alert box next to Sage 300
screens.

The Database table name can be viewed in the Extender Custom Tables Screen.

Extender Configurator Tutorials
Review examples to configure Sage 300 to log changes to records, send an email or create an Inform-
ation Manager Note.

A/R Credit Limit Approval 23
Customer On-Hold Alert and Approval 31
O/E Orders Approvals 37
A/P Payment Batch Approval 46
Vendor Alert Manual workflow 59
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I/C Options Notification 64
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A/R CREDIT LIMIT APPROVAL

Overview

A company wants to configure workflow using Orchid Extender to control who can approve
A/R Customer credit limits.

Users can approve up to $10,000

Between $10,000 and $50,000, a user in the A/R Team must approve and the Workflow console must
display the request in Yellow

Above $50,000, Anne must approve. Credit Limit requests above $50,000 must show in Red in the Con-
sole.

Tip: You can import the "Customer Credit Limit multi-level" Sample workflow.

Sample files
Workflow Template example- You can import the file: A/R Credit Limit approvals - Workflow template
tutorial

Go to Extender Setup > Workflow Templates > Import.

Continue the setup as per below.

Requires Extender PU12.00 or above

EXTENDER SETUP KEY STEPS
This A/R Credit Limit workflow template is designed to be started automatically when the A/R Credit
Limit field is updated in Sage 300. The workflow will restore the original credit limit until the request is
approved.

1. Configure Workflow Users. Refer to Extender License and Workflow Users on
page 127

2. Create User Group "ARAPPROVER" and add Sage 300 users that are in the A/R Team
to approve credit limits up to $50,000. (Workflow User Groups on page 93)

3. Configure SMTP Email settings in Extender Options (Extender Email Tab on page 80)
4. Add message templates (In the example workflow, 3 templates are

used: WFARCUSTCLMT when the credit limit changes, WFARCRLIMTAPPR when
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request is approved, WFARCRLMTREJECT when request is rejected) (Message Tem-
plates on page 100)

5. Add Workflow colours : Urgent (colour = Red) for large credit limits, Yellow for
pending requests, Approved (colour = Green) (Workflow Colours on page 92)

6. Create a "Workflow Template" in Extender Setup > Workflow Templates
7. To attach the workflow to the A/R Customer view, refer to Attach workflow to AR0024

{AMTCRLMT} Field on page 27
8. To configure workflow icons on screens, refer to Configure Information Manager on page 28

Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For details, refer to Workflow Templates - Screen Guide on page 130

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the Credit Limit changes and will
be attached to the A/R Customer view.

Auto Delete instance when complete: No - while testing.
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You can set it to Yes later- if there are too many records in the Console, as the workflow history is
accessible in the Log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.

Warning!
When you select "No" or "No with Message", if you update a field/View configured with the work-
flow template, and an existing workflow instance is active, the workflow is not triggered.

This may disable controls you are implementing with this workflow where this workflow has an act-
ive instance is active. USE WITH EXTREME CAUTION. Consider using the "IfWorkflowExists" action
and "Can start multiple workflow" = Yes

WORKFLOW STEPS
Add 5 steps - The detailed actions for each steps will be configured below.

Check - Entry Step: Compare the credit limit requested to the business limits and
based on the result, determine what actions to take, is an approval required, is an
alert or notification required?
Wait - Record is waiting for approval.
Approve - Approving User to confirm the amount approved, enter a comment and
when the credit limit is updated in Sage, send an email confirmation to the user who
started the workflow.
Reject - Rejecting user to enter a comment.
Reassign - this template uses a custom Reassign action so that the new user
assigned can receive an email.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For A/R Credit Approval, the request can be Approved or Rejected.

Select the Wait Step, add 2 steps that a user can select: Approve and Reject

VALUES
Values are used in the workflow and saved in the workflow history.

For A/R Credit Approval, the workflow will track the Customer ID to enable drill down, custom
description fields and Approvers.
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Customer: to enable drilldown - Set in the first workflow step
ORIGCRLIMT: original credit limit - Set in the first workflow step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the Approver details.

ARUSERLMT: (e.g. $10,000) Below that amount, no approval is required
ARMGRLMT: (e.g. $50,000) Above that amount, a manager approval is required
ARUSERAPPROV: ARAPPROVER, as defined in the Workflow User Groups above.
User group that can approve up to a certain amount
ARMGRAPPROV: Manager who can approve the larger credit limit requests

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

CHECK

SetDrilldown: Set the CUSTOMER value to the current customer to enable drilldown from the
console

Evaluate: Used to compare the requested credit limit to the Amounts that require approval. If the
Credit Limit is greater than $10,000, go to the True action to evaluate if it is greater or not than
$50,000.

If it is not greater than $10,000, go to the False action (complete the workflow as no approval is
required).

AssignUser: Enter the appropriate user based on the amount

AssignColour: Enter the required colour based on the amount

SetField: Used to restore the original credit limit - This prevents the credit limit being saved

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetDescription: This will be displayed on the console. Use {NAMECUST}-{IDGRP} to show the
Customer name and Group.

SendEmail: Choose a template and the Sage 300 user. The email address will be from the User
profile in Sage 300.

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT
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This step has no action, as it is waiting for a User to progress the workflow.

APPROVE

AddParameter: Add 2 fields: 

APPRCRLIMT to confirm the Approved credit limit. Defaults to {TOVALUE}, the
requested value.
APPRCOMMENT: for approver to enter a comment

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will save the credit limit entered on the screen. The value should be the para-
meter name as entered above {APPRCRLIMT}.

{TOVALUE} is the originally requested credit limit. If you are not prompting the user to confirm
the amount or enter a new one, you can use this to update the Credit Limit.

The True action can complete the workflow.

False Action: this means the Credit Limit wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add 2 fields: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Attach workflow to AR0024 {AMTCRLMT} Field
The workflow template is attached to the A/R Customer view (AR0024) so that the workflow starts auto-
matically when the Credit Limit is updated.

DETAILED STEPS
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Extender Setup > View Events and Scripts.

For detailed steps, refer to View Events, Scripts & WF on page 147

Select AR0024 view, on the Workflow Tab, select the Customer Credit Limit workflow and "Check" as
the Entry step.

Tip:
You can also use up to 4 parameters configured in View Events and Scripts > Workflow Tab. Para-
meters need to be used in the Workflow template using SetValue.

Using Parameters in Workflow

Configure Information Manager
Optionally, install and activate Information Manager

This is required if you want to add icons on relevant Sage 300 screens to view and progress workflow.

CONFIGURE ICONS ON SAGE 300 A/R SCREEN
To view the workflow history and progress active workflow from the AR Customer screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

Extender Workflow- Notes/DML/Extender Tray

As the workflow cannot be started manually, do not select an Entry Step.

A/R Customer workflow on A/R Screens

If you have an A/R Credit Limit approval workflow, you can add the icons to selected screens: 

A/R Customer Screen- RotoID = AR1300 and Field Label = Customer Number
A/R Customer Inquiry screen - RotoID = 1700, and field label = Customer No
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Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

testing Sage 300 workflow setup
The workflow is started when the A/R Customer credit limit is updated (by a user on a Sage 300 screen or
by an import or a custom process using the Sage 300 Views).

Update the credit limit for a Customer in A/R - E.g. change the credit limit from $10,000 to $15,000

When you save the A/R Customer, the credit limit remains set to $10,000.

USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a Workflow user who can approve,

click Approve on the console.
Confirm the credit limit to approve and a comment
Drill down to the AR Customer to check.

USING TRAY ICONS
Log on as a user who can approve,
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Find the customer or drill down from the console
Click on the Workflow icon, select Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.

Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To approve on the Remote form without logging to Sage 300 first, you need an active subscription to
the Remote Action Service. You can then configure the workflow template to use Remote Action.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 125

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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CUSTOMER ON-HOLD ALERT AND APPROVAL

Overview
AR Team users need the ability to put a customer on hold and send an email to the primary sales per-
son for the customer.

The company requires 2 different users to approve sequentially before the customer can be taken off-
hold.

Sample files
Workflow Template example- You can import the file: Manual Workflow - Set a Customer On-Hold
and email the sales person

Go to Extender Setup > Workflow Templates > Import.

Continue the setup as per below.

Requires Extender PU12.00 or above

Extender Setup key steps
To achieve the requirement, we will create a workflow template that can be manually started and con-
figure an icon on the A/R Customer inquiry screen.

Add email templates
Create a "Workflow Template" in Extender Setup > Workflow Templates - Set Cus-
tomer on hold and notify sales person.
Add Workflow Users - Understanding Workflow Users on page 125
Add Information Manager Configuration to start the Extender Workflow.

Workflow template - Step by step guide
WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name. The name cannot be updated after it is created

Can start manually: set to Yes

Note: You need to configure what screen the workflow can be started on in I/M Options >
Notes/DML/Extender Tray setup.

Auto Delete instance when complete: Yes
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Can start multiple instances: No with Message- to ensure the first request is completed before a
new one starts.

It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For more details. Workflow Templates - Screen Guide on page 130

WORKFLOW STEPS
Add 6 steps - The detailed actions for each steps will be configured below.

Set On Hold : Entry Step. Assigns the workflow to Nathalie
Wait : Record is waiting for approval.
Approve 1 : Assigns the workflow to Anne for second approval.
Waiting for 2nd Approval: Record is waiting for final approval
Take Off hold : 2nd Approver can take the customer off hold.
Reject : Close the workflow and leave the customer on hold.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

In this example,

Select the Wait Step, add 2 steps that a user can select: Approve 1 and Reject
Select the "Waiting for 2nd approval" step and add 2 steps "Take off hold" and
"Reject"

VALUES
Values are used in the workflow and saved in the workflow history.

For Customer On Hold manual workflow, the workflow will track the Customer ID to enable drill
down, custom description fields and Approvers.

Customer: to enable drilldown - Set in the first workflow step

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R customer on hold manual workflow, some of the key actions are described in this tutorial.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

SET ON HOLD
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SetValue: {VIEWID} - This is required for a manual workflow to attach the workflow to a Sage 300
View. View fields are now available in the workflow actions and in message templates.

SetDrilldown: Set the CUSTOMER value to the current customer to enable drilldown from the
console

AddParameter and AskForParameters: Prompt user for a reason to store in the workflow values.

AssignUser: Enter the appropriate user based on the amount

SetStatus: Set the workflow status to "Customer on Hold"

SetField : Used to Set the customer on hold {SWHOLD} = 1

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetDescription: This will be displayed on the console. Use {NAMECUST}-{IDGRP} to show the
Customer name and Group.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT AND WAITING FOR 2ND APPROVAL

The Wait steps have no action, as it is waiting for a User to progress the workflow.

APPROVE/FIRST APPROVAL

This step doesn't take the Customer off hold, it stores the User who first approved and assigns to
a second user.

SetValue: This action stores the User who approves - Value = APPROVER1, Field = {USER}

AssignUser: Enter the 2nd approver user. Could be a user group.

SetStatus: Enter a status meaningful for Workflow log and reports.

GoToStep: Go back to Wait if the field update has not been successful.

OFF HOLD/2ND APPROVAL

Evaluate: If the logged on user is the same as the first Approver, Display an error and go back to
Wait step.

If the logged on user is different from the first Approver, take the customer off hold.

SetField: This action will take the customer off hold. {SWHOLD} = 0

The True action can complete the workflow.
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False Action: this means the On Hold Flag {SWHOLD} wasn't updated (for example, the approver
doesn't have rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete
the workflow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

SetStatus: Enter a status meaningful for Workflow log and reports.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

SetStatus:  Rejected - Used on console and workflow history.

AddParameter: Add 2 fields: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Attach workflow to AR Customer Inquiry screen
To start the workflow manually, you don't need to add it to Extender Setup > View Events and Scripts.

Instead, you add the configuration in I/M Options > Notes/DML/Extender Tray setup.

Requirement! This requires to install and activate Information Manager. If you are only using Extender
screen icons functionality, you can install the module without activation code.
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Select RotoID AR1700 for Customer Inquiry.

Field Label: Customer No.

Select the workflow template and an Entry Step.

Enter Approver 1 and Approver 2 users in Parameters 1 and 2.

Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

Using Extender workflow to set customer on hold

Use Icon on AR Inquiry screen to put on hold

Find a customer with overdue invoices that you want to put on hold. Start the workflow on the Screen
icon.

Enter a comment when prompted.

The customer is put on hold and the sales person receives an email with the custom reason.

When the first user has approved, the second user receives a notification and can run the final approval
step.

Extender Configurator Tutorials Page 35 of 222



Extender

Viewing workflow history and logs

When the workflow is complete, you can use Workflow Log to view past instances when
the workflow was used to set the customer on hold.
View Workflow Logs to see history.

Requirement!
This functionality is available in Extender Levels Configurator, Customizer and Developer.

To use the Workflow console, users need to be configured as a Workflow User.

To configure the Tray Icon on the Sage 300 screens, you need to install Information Manager.

To use the icons, you need to configure the user as a Workflow User
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O/E ORDERS APPROVALS

Overview
A company wants to configure workflow using Orchid Extender to approve orders placed by
Retail Customers.

When an order is entered for a Retail customer, the order is immediately placed on hold and the cus-
tomer service manager receives an email notification. A user in Accounts must approve the order to
take it off hold.

When the order is approved, it is taken off hold automatically and the user who entered the order
receives an email notification.

When the order is rejected, a comment is entered and the requester receives an email.

The same workflow is required when they need to take off-hold orders put on hold manually.

Sample files
Workflow Template example- You can import the files:

Workflow template to attach to {INSERT} of an O/E Order: OE Order Insert Workflow.xlsx

Template to attach to {ONHOLD} view field: OE Order on hold.xlsx

Go to Extender Setup > Workflow Templates > Import.

Continue the setup as per below.

Requires Extender PU12.00 or above

Extender Setup key steps
This Retail O/E Approval workflow template is designed to be started automatically when a new
O/E Order is inserted for a Customer in the Retail (RTL) Customer Group. The workflow will set the order
on hold automatically.

A separate workflow to control the process to take orders Off hold starts automatically. This process is
also used for orders set on hold outside of the workflow.

In this tutorial, the customer group that requires approval is configured as a Parameter when attaching
the workflow to the Sage O/E View.

The Approver who can take the order off hold is also configured when the workflow is attached to the
Sage O/E Order view.

Add email templates "Order approved" and "Order rejected"

Configure Workflow colours: Orange to show New On-hold orders and Red for "rejected" orders.
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Create a O/E Order approval Workflow and Order On hold workflow in Extender Setup > Workflow
Templates.

Workflow template - Step by step guide - OE New Retail orders on
hold
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

Workflow Templates - Screen Guide on page 130

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever an O/E order is inserted and will
be attached to O/E Order view.

Auto Delete instance when complete: Yes - as the workflow history is available in Extender Inquir-
ies.

You can set it to No while testing to view all Orders workflow on the console.

Can start multiple instances: Yes

WORKFLOW STEPS
Add 3 steps - The detailed actions for each steps will be configured below.

Check = Entry Step: If the Customer group = Retail, request approval and set the
Order on hold flag to "on hold"
Error= If the workflow has a critical error, such as the order cannot be set on hold,
the workflow will wait for a manual intervention
Complete if the workflow has had an error, can be manually completed.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

When the order is on hold, the O/E Offhold approval workflow will be used to manage the approval
process.

The O/E Order Insert workflow can be manually progressed if it ends up in the Error step.

Select the Error Step, add a step that a user can select: Complete

VALUES
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Values are used in the workflow and saved in the workflow history.

For O/E Order Approval, the workflow will track the Order Number and Customer ID to enable drill
down and the Order total amount for reference under "Requested value" in the console.

Customer and ORDERNO: to enable drilldown - Set in the first workflow step
OrderAmount: set to the Order Total in the first step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the App

WFCOMMENT : WFCOMMENT is used to set the default On hold reason. Set to
"Retail Order set on hold by the workflow". Text can be updated in the Values sec-
tion of the screen without updating the rest of the workflow actions.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

CHECK

SetDrilldown: Set the CUSTOMER value to the current customer and the ORDERNO to the cur-
rent Order to enable drilldown to customer and order from the console.

SetDescription: This will be displayed on the console. Use {CUSTOMER}-{BILNAME}-PO:
{PONUMBER} to show the Customer number, name and the PO Number on the order.

Evaluate: Used to check if the order is a "Retail" order. Defined as an order for a customer in the
RTL Customer Group. The customer group is configured as a parameter when the workflow is
attached to the O/E Order view rather than hard coding it in the workflow.

If the Order customer group is the one configured in parameter 1 ({$1}, then approval is required.
If not, the False action is set to another action to update the status and complete the workflow, as
no approval is required, so the order is not put on hold.

AssignUser: Select {$2} as the approver is entered as Parameter 2 when the workflow is attached
to the OE Order view.

AssignColour: Enter the required colour for the console.

SetField: The Order is set to "On Hold" so that the order can be saved, but not processed further
until approved.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.
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SetField: {HOLDREASON} is set to the value {WFCOMMENT}. You can update the description in
the Values section of the workflow template.

ShowUserMessage: This is used to inform the user that the workflow has started and the order is
on hold. Use in conjunction with Evaluate {PROGRAM} to ensure the message box is only dis-
played if using a Extender screen . If a custom program running on the server inserts order, you
do not want any messages to show on the server.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

ERROR

This step has no action, as it is waiting for a User to progress the workflow.

Use Progress To Steps to configure what steps the user can start.

Workflow template - Step by step guide - O/E orders on hold
approval
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

Workflow Templates - Screen Guide on page 130

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the ONHOLD flag is updated and
will be attached to O/E Order view, {ONHOLD} field.

Auto Delete instance when complete: Yes - as the workflow history is available in Extender Inquir-
ies.

You can set it to No while testing to view all Orders workflow on the console.

Can start multiple instances: Yes

WORKFLOW STEPS
Add 4 steps - The detailed actions for each steps will be configured below.

Check = Entry Step: If the Customer group = Retail, request approval and set the
Order on hold flag to "on hold"
Wait = Record is waiting for approval.
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Off-hold = Order is approved and taken off hold
Reject = Order remains on hold and requester receives an email.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For O/E Order Approval, the request can be Approved (Order taken off hold) or Rejected (Order
remains on hold and can be deleted manually)

Select the Wait Step, add 2 steps that a user can select: Off-Hold and Reject

VALUES
Values are used in the workflow and saved in the workflow history.

For O/E Order Approval, the workflow will track the Order Number and Customer ID to enable drill
down and the Order total amount for reference.

Customer and ORDERNO: to enable drilldown - Set in the first workflow step
OrderAmount: set to the Order Total in the first step

Values are also used as variables in the workflow actions. In this example, we have configured Values
to store the App

WFCOMMENT : WFCOMMENT is used to set the default On hold reason. Set to
"Retail Order set on hold by the workflow". Text can be updated in the Values sec-
tion of the screen without updating the rest of the workflow actions.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R Customer Credit Limit approval, the most commonly used actions are configured.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

CHECK

SetDescription: This will be displayed on the console. Use {CUSTOMER}-{BILNAME}-PO:
{PONUMBER} to show the Customer number, name and the PO Number on the order.

SetDrilldown: Set the CUSTOMER value to the current customer and the ORDERNO to the cur-
rent Order to enable drilldown to customer and order from the console.

Evaluate: if the user sets the order to "off hold", ({ONHOLD} value = false), go to an action that
leaves the order on hold and notifies the user that the field can only be updated through the
workflow.
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AssignUser: Select {$2} as the approver is entered as Parameter 2 when the workflow is attached
to the OE Order view.

AssignColour: Enter the required colour for the console.

SetField : The Order is set to "On Hold" so that the order can be saved, but not processed further
until approved.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update.

SetField: {HOLDREASON} is set to the value {WFCOMMENT}. You can update the description in
the Values section of the workflow template.

SendEmail: Choose a template and the email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.

Use Progress To Steps to configure what steps the user can start.

OFF HOLD / APPROVE

SetField: This action will set the ONHOLD flag to 0. The order will not be on hold anymore.

The True action can complete the workflow.

False Action: this means the Credit Limit wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Optional, ShowUserMessage if the program is the OE1100 screen to notify the user that the order
is off-hold.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add a field: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.
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SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

Note: You could add another step to "inform customer" and complete the workflow only when
this final step is performed.

Attach workflow to OE0520 View
Add OE Order insert workflow to {INSERT} view operation. It will start when a new order is inserted.

Add OE Order on hold workflow to the ONHOLD field. It will start whenever the Order on hold field is
updated

Note: The ONHOLD workflow will start when the field is updated on the Sage 300 screen, through
other programs using the O/E Order view, including when the field is updated in a separate workflow
template.

In Extender Setup > View Events and Scripts, select the workflow and the entry step.

Parameter1 = Customer Group

Parameter2 = Approver User

For detailed steps, refer to View Events, Scripts & WF on page 147

Configure Information Manager
If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

CONFIGURE ICONS ON SAGE 300 O/E SCREEN
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To view the workflow history and progress active workflow from the O/E Order screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

As the workflow cannot be started manually, do not select an Entry Step.

Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session
as the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

Using Extender
Add orders for Retail Customers

Check that the Order is on Hold and OnHold Comment = Retail order set on hold by workflow

Note:
If you add orders for non Retail Customers, the workflow will also be started on INSERT. The workflow
goes to a Complete action, so will not be visible on the console if you select "Auto delete when com-
plete". It will be in the workflow history.

If you only want to start the workflow in some conditions and don't want to see all orders in the work-
flow history log, you need a custom script that will start the workflow when certain conditions are met.
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USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a user who can approve,

click "Off Hold" on the console to approve the order.
Drill down to the O/E Order to check.

USING TRAY ICONS
Log on as a user who can approve,

Find the Order or drill down to the O/E Order from the console
Click on the Workflow icon, select Off-Hold or Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.

Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To approve on the Remote form without logging to Sage 300 first, you need an active subscription to
the Remote Action Service. You can then configure the workflow template to use Remote Action.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 125

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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A/P PAYMENT BATCH APPROVAL

Overview
A company wants only certain users to approve A/P Payment Batches. They configure workflow using
Orchid Extender to control who can set A/P Payment Batches to "ready to post".

This A/P Payment batch workflow template is designed to be started automatically when the A/P Pay-
ment batch status is updated in Sage 300.

When a user sets the batch to Ready to post, the workflow will reset the Batch status to Check
Creation in Progress (8) until the request is approved. This ensures the batches cannot be
modified while the workflow is in progress.

When the request is approved, the batch status is set to Ready to Post and the batch is posted
automatically.

When the batch is rejected, the status is reset to Open.

The workflow updates the batch description to include Submitted or Approved to inform users.

Sample files
You can import the"A/P Payment Batch Approval sample module. It includes a workflow template and
required message templates. The workflow template is attached to the AP Payment batch status field.

AP Payment Batch Approval Module
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Note: The module is supplied on an as is basis for training and demonstration purposes only and is
not supported by Orchid Systems. If this code is deployed in a live production environment it is the
responsibility of the End User to ensure that it is operating as required.

EXTENDER SETUP KEY STEPS
To start using the AP Payment approval module, you need to follow the steps below:

Configure SMTP Email settings in Extender Options

This is required for the workflow to send emails to users, that an approval is required and when a batch is
approved or rejected.

Refer to Extender Email Tab on page 80

Configure Workflow Users

All Sage 300 users who need to approve batches on the workflow console need to be set as Workflow
Users. Extender License and Workflow Users on page 127

Check Sage 300 users email addresses
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Create Workflow User Group

Create a workflow user group called APPAYMAPPROVER. You can add the required Sage 300 users to
that group. Refer to Workflow User Groups on page 93 for details.

If you don't create a workflow user group, you can select a Sage 300 user as the approver. See Step 6
below.

Add Workflow colours

The AP Payment batch approval uses 2 colours:  URGENT if there are any errors, and ACCOUNTS for reg-
ular workflow records on the Console.
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You can choose the colour you want for the console, as long as you create Workflow Colours with the
same names. (Workflow Colours on page 92).

Import the AP Payment Batch Approval.vi file

It will create a workflow template, message templates and link the workflow to the AP Payment batch
view.

EXPAND TO VIEW DETAILED SCREENSHOTS

Create a "Workflow Template" in Extender Setup > Workflow Templates

Add message templates

To amend the message templates, refer to Message Templates on page 100
Attach the Workflow template to the AP0030 > BATCHSTAT Field

Configure the AP Payment approval module

In Extender Setup > View Events, Scripts and Workflow,
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1. Select the AP0030 view.
2. On the Workflow Tab, set the required values for your company
3. In Parameter 1, enter the Sage 300 user or Workflow User Group (e.g. APPAYMAPPROVER created

in Step 3) who can approve.
4. Set the path where to save the Batch listing Report in Parameter 2.

Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

This tutorial highlights details about some important workflow actions. It is not a detailed training of
each workflow action used in this template. For more details on workflow templates and actions, refer to
For details, refer to Workflow Templates - Screen Guide on page 130.

WORKFLOW CONFIGURATION
Template ID - The template name includes the Module ID for ease of deployment. The name cannot
be updated after it is created

Can start manually: set to No as the workflow will start whenever the A/P Payment Batch status
changes and will be attached to the A/P Payment Batch view.

Auto Delete instance when complete: Yes as the workflow history is accessible in the log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.

WORKFLOW STEPS
Add 5 steps - The main actions for each are described below:

Check - Entry Step: This determine what branch the workflow should take based on the batch
status that is updated and whether there is a pending workflow or not. It also sets some gen-
eral values for use in the workflow console and logs. If the user tries to post the batch, the
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status is reset to Check creation in progress

Wait - Record is waiting for approval.
Approve - This will set the Batch to "Ready to Post" and the batch will be posted
Reject - Rejecting user to enter a comment. The batch status is reset to Open
ErrorMessage - Used to demonstrate a suggested approach to cater for error handling in
workflow, for example if Sage security settings prevent a user from completing a workflow
action.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For A/P Batch approval, the request can be Approved or Rejected.

Select the Wait Step, add 2 steps that a user can select: Approve and Reject
Select the ErrorMessage Step, add 2 steps so that the Admin user can Approve or Reject.

VALUES
Values are used in the workflow and saved in the workflow history.

For A/P Batch Approval, the workflow will track the Batch Number to enable drill down

BATCHNO: to enable drilldown - Set in the first workflow step
APPAYMRPTPATH: stores the filepath and filename of the batch listing PDF so that it can be
attached to an email.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

CHECK

SetDrilldown: Set the CNTBTCH value to the current Batch Number to enable drilldown from the
console

Evaluate: If the requested Batch Status is 7 / Ready to Post, Approval is required. If not 7, go to a
step that sets a WFCOMMENT Value, Sets description and then complete the workflow imme-
diately.

AssignUser: Enter the appropriate user who can set A/P Payment batches to Ready to Post

AssignColour: Enter the required colour for the workflow console.
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GenerateAPPaymBatchListing: This action prints the AP Batch listing report to PDF. The file
is saved into the path configured in Parameter 4, the filepath and file name are stored in a work-
flow value defined in Parameter 2.

Tip: To modify the report used, copy the default APCBTCLZ.rpt file, update the report as
required and change the Report name configured in Parameter 3. The new report must have
the same parameters as the default batch listing report.

SetField: Used to restore the A/P Payment batch status to Check creation in progress

until approved. - This prevents the batch from being posted and updated while a workflow is
pending.

It is also used to update the Batch Description to Submitted-Original Batch Descrip-

tion so users can quickly scan the batch listing and view submitted and approved batches.

Tip: Make sure that the False action notifies the user that there was an issue preventing the
update. If SetField is false, next action is SetValue to update the WFCRITICALERROR value, and
then go to ErrorMessage Step.

SetDescription: This will be displayed on the console. Use {BATCHDESC}to show the batch
description.

SendEmail: Choose a template and the User / User group or email address to use

GoToStep: Choose Wait step if approval is required so that users can Approve or Reject on the
console.
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Complete: Action to complete the workflow, Selected If Evaluate is false, Action = Complete

Tip: If you want to send email notification to the approver, create a message template and add
a SendEmail action.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.

APPROVE

AddParameter: Optionally add a field if you want the user to enter a comment: 

APPRCOMMENT: for approver to enter a comment

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will set the Batch status to 7, Ready to post.

The True action can complete the workflow.

False Action: this means the batch status wasn't updated (for example, the approver doesn't have
rights to Sage 300). Make sure this goes back to the Wait step and doesn't complete the work-
flow. False Action could be "SendEmail" to an Admin user and then go back to "Wait" step.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

GoToStep: Go back to Wait if the field update has not been successful.

REJECT

AddParameter: Add a field: 

REJECTREASON: for user to enter a comment / reason for rejection

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

SetField: This action will set the Batch status to 1, Open.

SendEmailToStarter: Select a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Complete: Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.

If a user tries to set the batch to "Ready to post" again, a new workflow will start.

ERRORMESSAGE
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SendEmail: Select a User and a template. The action will use the email address in the Sage 300
user profile of the user who started the workflow.

Selected template to include {WFCRITICALERROR} value. Value updated in the workflow with
details of the error.

testing Extender workflow setup
The workflow starts when the A/P Payment Batch Status is updated (by a user on a Sage 300 screen or by
an import or a custom process using the Sage 300 Views).

Start the workflow

Log on to Sage 300 and set an A/P Payment batch to "Ready to Post".

The workflow is started and the batch status is reset to "Check creation in progress".

Approve or Reject the A/P Payment Batch

1. Logon to Sage 300 as a user who can approve
a. User needs to be set as a workflow user (in Extender License screen)
b. User needs rights to post an AP Payment batch in Sage 300
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.
2. Go to Extender Workflow > Console, notice the workflow instance record.
3. Click on Values Tab to see the details.
4. Use history to view the steps that the workflow has been following.
5. Click Approve on the Workflow Console -

a. This will post the batch and
b. Send an email to the user who requested the approval.

6. View the Extender Inquiries > Workflow Details Log
a. Review the history of the batch being set to "Ready to Post" and approved.
b. Drilldown to the AP Payment batch to check that the batch is posted

7. Create another batch and repeat steps. Choose Reject on the console.
a. This sets the batch to Open again.
b. Amend the batch and set Ready to Post again.
c. Approve the batch on the console.
d. Review the Workflow Logs in Extender Inquiries
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Repeat the steps

Optionally, Configure Information Manager
If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

CONFIGURE ICONS ON SAGE 300 A/P BATCH SCREEN
To view the workflow history and progress active workflow from the AP Payment /screen, configure
Information Manager , I/M Setup > Options > Notes/DML/Extender hotkey

As the workflow cannot be started manually, do not select an Entry Step.

A/P Payment Batch workflow on A/P Payment batch screen

The A/P Payment batch view has a multi-part key, including the Batch Type and the Batch Number.
The workflow key is set to PY,Batch number, so the Information Manager configuration needs to
include 2 fields as shown below.

Field 1 should be set to "PY" (with quotes) and field 2 set to BATCH NUMBER.
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Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.

Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

USING TRAY ICONS
Log on as a user who can approve and is configured as a Workflow User,

Find the A/P Payment Batch or drill down from the console
Click on the Workflow icon, select Reject
Enter a reason
Confirm the email is sent to the user who started the workflow.

Software Required
Requirement!
This functionality is available in Extender Levels Configurator and Developer.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 125

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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Using with Remote Action Service
If you want to use the Remote Action module to approve records outside of Sage 300, you need to down-
load and install the Remote Action Module on the Orchid website through your Sage 300 partner.

You can then use the AP Approval Extender module below.

AP Payment Batch Approval Module with Remote Action
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VENDOR ALERT MANUAL WORKFLOW

Overview
Purchasing team needs the ability to send alerts to Operations team about certain vendors.

In some cases, they just want to send an email notification. In other examples, they would like to track
that the operations team has seen the alert on the console.

Sample files
Workflow Export - You can import the files:

For a workflow that sends an alert, updates the workflow history and completes the workflow in one
step: AP Vendor manual alert-one step.xlsx

if you need the assigned user to confirm they have seen the notification on the workflow console, use
AP Vendor manual workflow.xlsx

Requires Extender PU12.00 or above

Extender Setup key steps
To achieve the requirement, we will create a workflow template that can be manually started and con-
figure an icon on the A/P Vendor screen.

Add Workflow Users - Understanding Workflow Users on page 125
Create a "Workflow Template" in Extender Setup > Workflow Templates : Vendor
manual alert
Add Information Manager Configuration to start the Extender Workflow.

Workflow template - Step by step guide
WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name. The name cannot be updated after it is created - This tutorial
refers to a one-step workflow.

Can start manually: set to Yes

Note: You need to configure what screen the workflow can be started on in I/M Options >
Notes/DML/Extender Tray setup.

Auto Delete instance when complete: Yes
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Can start multiple instances: No with Message- to ensure the first request is completed before a
new one starts.

It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For more details. Workflow Templates - Screen Guide on page 130

WORKFLOW STEPS
Add 1 step - The detailed actions for each steps will be configured below.

Send Comment: Entry Step. This steps also completes the workflow.

Note: If you want the assigned user to confirm that they have seen the alert, create another 2
steps, "Wait" and "Complete".

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

In this example, if you are doing a 2-step alert workflow, where the user needs to complete the work-
flow,

Select the Send Info Step, add the "Complete" step as a Progress-to step.

VALUES
Values are used in the workflow and saved in the workflow history.

For Vendor Alert manual workflow, the workflow will track the Vendor ID to enable drill down, cus-
tom description fields and Approvers.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements. In
the A/R customer on hold manual workflow, some of the key actions are described in this tutorial.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

REQUEST INFO

AddParameter: Add required fields: 

VENDORDELAY- text(size=100) - User can enter comment
AssignedUSER - user type - when using the workflow, prompt to select the user
to assign the workflow / send the alert to.

Page 60 of 222 Extender Configurator Tutorials



Extender

AskForParameters: always required after AddParameter to display the popup screen and wait
for user to enter Input.

GoToStep: Go back to Wait if the field update has not been successful.

SetValue: {VIEWID} - AP0015 for A/P Vendor This is required for a manual workflow to attach the
workflow to a Sage 300 View. View fields are now available in the workflow actions and in mes-
sage templates.

SetDrilldown: Set the VENDOR value to the current Vendor {VENDORID} to enable drilldown
from the console

AssignUser: Choose the {AssignedUSER} parameter name defined above.

Or you can enter the appropriate user If you want to hardcode the user.
If you can create a user group called APAPPROVER, you can select that group.

SetStatus: Set the workflow status to "VendorAlert"

SetDescription: This will be displayed on the console. Use {VENDNAME} to show the vendor
name.

SendEmail: Choose a template and the email address/user / user group to use -

In this example, use {CURUSER} to email the user assigned to the workflow.
Or you can email the workflow user group created APAPPROVER.

Final Action: 

Complete: Set the final action to "Complete" if you want to complete the work-
flow in one step.
GoToStep: Choose Wait step if you want the assigned user to confirm they have
seen the alert.

Note: If you want the assigned user to confirm that they have seen the alert, create another 2
steps, "Wait" and "Complete".

WAIT

The Wait steps have no action, as it is waiting for a User to progress the workflow.

COMPLETE

Complete Completes the workflow. Will be deleted from the Console if "Auto delete"is set to
Yes.
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Attach workflow to AP Vendor screen
To start the workflow manually, you don't need to add it to Extender Setup > View Events and Scripts.

Instead, you add the configuration in I/M Options > Notes/DML/Extender Tray setup.

If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

Select RotoID AP1200 for A/P Vendor.

Field Label: Vendor Number.

Using Extender workflow to start the AP Vendor manual workflow

Use Icon on A/P Vendor screen to send an alert

Enter a comment when prompted.

The assigned user receives a notification and can complete the workflow in the console, confirming they
have seen the notification.

Viewing workflow history and logs

When the workflow is complete, you can use Workflow Log to view past instances when
the workflow was used to send detailed comment about a customer.
View Workflow Logs to see history.

Requirement!
This functionality is available in Extender Levels Configurator, Customizer and Developer.

To use the Workflow console, users need to be configured as a Workflow User.

To configure the Tray Icon on the Sage 300 screens, you need to install Information Manager.
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To use the icons, you need to configure the user as a Workflow User
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I/C OPTIONS NOTIFICATION

Overview
A company wants to configure workflow using Orchid Extender to notify a user when the Serials Num-
ber of Days expires. The user needs to acknowledge that they have seen the notification.

Refer to Flowchart below.

Sample files
Workflow Export - You can import the file: I/C Option workflow.xlsx

Requires Extender PU12.00 or above
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EXTENDER SETUP KEY STEPS
This I/C Option workflow template is designed to be started automatically when the Serials-Days to
Expiry is updated in Sage 300. This workflow doesn't require approval of the change. It notifies a user,
who needs to complete the workflow to acknowledge they have seen the notification.

Create a "Workflow Template" in Extender Setup > Workflow Templates

Workflow template - Step by step guide
It is recommended to add the main steps as defined on the process flowchart first, and then configure
the detailed actions for each step.

For details, refer to Workflow Templates - Screen Guide on page 130

WORKFLOW CONFIGURATION
Template ID - Enter a descriptive name.

The name cannot be updated after it is created

Can start manually: set to No as the workflow will start whenever the field changes and will be
attached to the I/C Options view.

Auto Delete instance when complete: Yes, as the workflow history is accessible in the Log.

Can start multiple instances: Yes - If you want the workflow to behave differently if there is an
active pending workflow before a new one starts, use the "IfWorkflowExists" action.
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WORKFLOW STEPS
Add 3 steps - The detailed actions for each steps will be configured below.

Start- Entry Step. This will start the workflow whenever the field the workflow is
attached to is updated.
Wait - Record is waiting for workflow to be completed.
Complete- User to complete the workflow

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

For I/C Options, the user can complete the workflow, confirming that they have seen the notification
of the change. .

Select the Wait Step, add 1 step that a user can select: Complete

VALUES
Values are used in the workflow and saved in the workflow history.

For I/C Option notification workflow, the original value is tracked in the workflow.

ACTIONS
For each step, the template includes a series of actions to match the process flow requirements.

For a list of actions included with ExtenderConfigurator, refer to Configurator Actions on page 177

START

SetDescription: Set the description based on the field you are notifying.

SetStatus: Type an appropriate Status, will be used on the console and the workflow logs.
e.g. Notified

AssignUser: Set to {$1} - The user will be configured as a parameter when the workflow is
attached to I/C Options View.

AssignColour: Enter the required colour (optional)

SendEmail: Choose a template and the Sage 300 user. The email address will be from the User
profile in Sage 300.

GoToStep: Choose Wait step to wait for the user to complete the workflow and clear the noti-
fication.

WAIT

This step has no action, as it is waiting for a User to progress the workflow.
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COMPLETE

SetStatus: Enter a relevant description to indicate the user has seen the notification.

Complete: Complete workflow.

Attach workflow to IC0380 {SEXPDAYS} Field
The workflow template is attached to the I/C Options (IC0380) so that the workflow starts automatically
when the " Serials-Days to Expiry" field is updated.

DETAILED STEPS
Extender Setup > View Events and Scripts.

For detailed steps, refer to View Events, Scripts & WF on page 147

Select IC0380 view, on the Workflow Tab, select {SEXPDAYS} the I/C Options Workflow and "Start" as
the Entry step.

Enter the name of the Sage 300 User to notify in Parameter 1.

Tip:
You can also use up to 4 parameters configured in View Events and Scripts > Workflow Tab. Para-
meters need to be used in the Workflow template using SetValue.

Using Parameters in Workflow

Configure Information Manager
Optionally, you can configure the Information Manager tray to display Extender buttons on relevant
Sage 300 screens.

Refer to: Extender Workflow- Notes/DML/Extender Tray
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Testing Sage 300 workflow setup
The workflow is started when the I/C Options > Serials-Days to Expiry field is updated (by a user on a
Sage 300 screen or by an import or a custom process using the Sage 300 Views).

Important! You need to close the Information Manager Tray to update I/C Options.

USING THE WORKFLOW CONSOLE
Go to Extender Console, notice the workflow instance record.

Click on Values Tab to see the details.

Use history to view the steps that the workflow has been following.

Log on as a user who can approve,

click Approve on the console.
Confirm the credit limit to approve and a comment
Drill down to the AR Customer to check.

Requirement!
This functionality is available in Extender Levels Configurator and Developer.

This functionality requires Extender Developer.

To use the Workflow console, configure the user as a "Workflow User". Refer to Understanding Work-
flow Users on page 125

To use the Tray Icon on the Sage 300 screens, you need to install Information Manager, configure the
tray icons and configure the user as a "Workflow User".
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Getting Started with Extender
Depending on what you are trying to do with Extender, the Getting Started step may differ.

Example: You can review the Extender tutorials for specific examples using Extender to log Extender
changes or configure workflow on Extender records. Refer to Extender Configurator Tutorials on
page 21 and Extender Workflow Tutorials

Note: Extender is available in different editions with different functionality. Refer to Orchid Website
Extender Overview for further details.

CONFIGURE EXTENDER
Create Event types which you want to attach to Sage 300 Views and View Fields
Attach scripts and events to Views/View Fields
Configure Workflow Templates - Screen Guide on page 130
Attach Workflows to View Events, Scripts & WF on page 147
Use the Logs screen to review the logs maintained by Extender
Use View Info to familiarise yourself with the Sage 300 Views and View fields - See Extender View Info
on page 172

GETTING STARTED FOR DEVELOPERS
This documentation helps developers and technical consultants get started with Extender, It is not a fully
developed training course in Python nor the Sage 300 development environment. Refer to the technical
info section for Extender Developer Training.

FINDING HELP AND DOCUMENTATION
You can find information about setting up and using Extender in the Sage 300 help and in the product
documentation included with this release.

Online help is available on Orchid Resources - Online Help. It includes the F1 help available from the
Sage 300 screens, as well as links to training material and getting started guides.

Note: For technical support, contact your Sage business partner.

CONTEXT-SENSITIVE HELP
Sage 300 features context-sensitive help that you can use to quickly open and view articles and inform-
ation directly from Sage 300 screens.

On the Sage 300 Desktop, press F1 to view help for the current screen.
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On Sage 300 Web Screens, click the help menu at the top of the screen to see help articles and resources
related to your current task.

PRODUCT DOCUMENTATION
Extender includes guides in printable PDF format related to installation and setup. These guides are avail-
able in the Docs folder on the Sage 300 server.

Training guides are available on the Orchid website : 

https://www.orchid.systems/resources/training

Browse to the folder where Sage 300 is installed:

\DOCS\XXA\VIXXA\ and select the document or file you want to print.

Example: Docs\72A\VI72A for Version 2025

For details on general Sage 300 functionality, such as using Menu items, Finders, Working with Data
entry Grids, please refer to Sage 300 documentation.

EXTENDER VIEW INFO
When this screen first opens, the program will scan for all the currently installed and activated modules
in the open company and show them in the left hand window. A program group per active module will
be created.

Open details for a view
Click on the plus sign (+) beside the relevant program group, a list of all the views will be displayed, sor-
ted in view ID order.

Double click on the required view, the list of available view fields will be displayed in the right hand win-
dow.

You can also right click on it and select Open in New Window, or Export the selected view to a Text file.

Use view details
If you want to copy this text, right click or press Ctrl-C.

This is useful to copy and paste the field names to Extender setup screens or scripts.

Any one of these views can be included in the View Events and Scripts screen.
Any one of the view fields will be available for use in the attached PYTHON 3 scripts that are writ-
ten for this view.
Fields can be included in message templates and Extender workflow templates.

Tip: You can press F5 to open a finder for the selected view and see the records in the database.

Shortcuts to Find views and fields
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Using the Find field at the bottom of the screen, you can enter:

!rotoID - open specified view, e.g. !IC0310, !ICITEM will open the I/C Item view

!!rotoID - open specified view in a new window

#text - find specified text in current view

text - find specified text in current view, or find a view with that text in the name

ATTRIB COLUMN LEGEND
R = Required

K = Key field

E = editable

A = enabled

C = calculated field

T = type changes

P = presentation list/mask changes

X = editable changes
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PYTHON 3 SCRIPT WITH SAGE 300 VIEWS -
DOCUMENTATION
Orchid has implemented PYTHON 3 scripting around the Sage 300 Views and Sage 300 desktop screens,
so site specific business logic can be implemented using PYTHON 3 scripting and applied to Sage 300
core and 3rd Party Views (if they are developed in the Sage 300 SDK) – when records are inserted,
updated and deleted.

In the VIXXA folder of the directory where Sage 300 is installed, Developers can find details on what is
required to use PYTHON 3 with some of the main Sage 300 Views. The accpac.py file includes the avail-
able functions.

Detailed documentation of the Sage 300 functions made available in Extender can be found in the
VIXXA\Doc folder. Open any of the HTML files in your browser to navigate through the Extender func-
tionality.

Page 72 of 222 Getting Started with Extender



Extender

Tip: Open all the files in Notepad++ to enable searching

GET STARTED WITH PYTHON 3 SCRIPT
Python is a dynamic programming language that is freely available and easy to learn.

Orchid has implemented PYTHON 3 scripting around the Sage 300 Views and Sage 300 desktop screens,
so site specific business logic can be implemented using PYTHON 3 scripting and applied to Sage 300
core and 3rd Party Views (if they are developed in the Sage 300 SDK) – when records are inserted,
updated and deleted.

Useful Resources
Google “PYTHON 3 Tutorials” and you will find many sites. Some useful ones are

https://wiki.Python.org/moin/BeginnersGuide

https://www.Python.org/about/gettingstarted

http://www.Python-course.eu/Python3_course.php

Sample scripts

Sample PYTHON 3 scripts from Orchid are installed in the VIXXA\Scripts folder of the directory where
Sage 300 is installed.

Importing Python libraries/packages in a script

Some Python libraries are installed with the Extender install. You can then import them in an Extender
script.

If you want to use a Python library that is not installed with the Extender install, you can add the fol-
lowing line #@ pip(libraryname) to the script that requires the library.

How does it work?
Behind the scenes, the first time a user runs a script, if the library isn't installed on the machine, Extender
downloads the scripts from the database as they are cached for performance reasons. If a script includes
@pip, Extender also downloads the required Python packages in the user's temp directory,
%LOCALAPPDATA%\COMPANY\{orgid}\scripts\python388\site-packages folder. (or python folder if you
use the Python 3.4 version).

To do this, Extender runs @pip and python.exe, which displays the cmd prompt pop-up the first time a
user runs the screen. This should only happen once for each network user.

If you delete the files in that folder, they will be downloaded again next time the script runs.

Tip: This feature applies to all scripts, including screen scripts.
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Example:
If you need to use the requests library, add a comment line #@ pip(libraryname)

Install library

#@ pip(requests)

Note:
Some packages are not compatible with Extender, for example numpy and pandas won't work in
Extender scripts.

The issue is that numpy does not work with sub-interpreters correctly (see https://l-
ists.archive.carbon60.com/python/dev/1406603). There is nothing Extender can do about that .

Troubleshooting using Online debugging tool

You can use https://www.onlinegdb.com/online_python_debugger to help troubleshoot scripts. It helps
identify Python related issues (but it's not specific to Sage 300).

This is particularly useful when you get an error loading a script in Extender Setup > Scripts.

Select the script with an error in your preferred Text Editor, Copy to the clipboard and Paste in the
Python Editor. If the script has a syntax error, such as wrong indentation, it will point to the line with the
error.

Even with a valid script, you will see errors relating to the accpac.py - You can ignore such errors.

See Also

Tips to get started with Extender scripts

Getting Started with Extender on page 69

Setting Up Extender
You use the icons in the Extender Setup folder to:

Specify company and processing options for Extender. (Choose Options on page 78)
Setup Extender Adding Security on page 120 in Sage 300 Administrative Services.
Create and amend Event Types to be applied to required Views and Events. (Choose
Event Types. on page 90)
Configure Workflow Templates - Screen Guide on page 130
Apply Event Types , PYTHON scripts and Workflow to the required Sage 300 Views.
(Choose View Events, Scripts & WF on page 147)
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Create and amend site specific Message Templates to be used in Workflow templates
and Event Types which Send E-mails or Create I/M Notes.

Refer to: Message Templates on page 100

EXTENDER LICENSE SCREEN
To start using Extender, you need a valid serial number and license file.

If you don't have a valid license for Extender, you only see the License screen.

License screen
You use the Extender license screen to enter serial number and activation code.

When to use: 
After a new installation or an upgrade to a newer version of Sage 300.
After a subscription renewal, enter the activation code with the new expiry date.
View the components of the Orchid module you are licensed for.

How to use: 
Enter the license details, click the Add button to create the license file.
Restart the Sage desktop to enable the new license.

Note: If you have multiple Sage 300 databases, you only need to enter the activation code details in
one company. When the licence details are entered on the first company, Extender creates the
VI69A.lic file, which can then be read by all other companies configured on the same server.

Workflow Users

You also use the Extender license screen to maintain Extender Workflow users.

For details, refer to Extender License and Workflow Users on page 127

30-day Trial Licence

If you don't have an activation code for Extender, you can create a 30-day trial license.

In the License screen, enter a serial number for the module, Sage 300 version and edition you are run-
ning.

Click the Add button. This create a 30-day trial license.
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Tip: If you install a 30-day trial, enter a valid activation code before the trial expiry date to continue
using the application.

Extender license screen details

Page 76 of 222 Setting Up Extender



Extender

Subscription Licenses Expiry Date

You can check the subscription expiry date and enter a new activation code after a subscription renewal
is processed.

Subscription licenses have an expiry date. To continue using Extender, you will need to renew the sub-
scription and enter a new Activation code in the module License screen before the expiry date.

Contact your Sage 300 Business Partner for details.

Note: In the four weeks before the expiry date, users receive a warning message when logging into
Sage 300 (weekly for the first three weeks and daily in the last week). If you don't renew before the
expiry date, the software will become read-only.

Extender and Orchid modules web screens
Web screens for Orchid modules rely on Extender for ease of deployment and maintenance. To run the
Orchid Module web screens, you need to install and activate Extender, even if you don't have a license
for Extender.
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Without a license, you will not have access to Extender functionality, you can only run the web screens
for the modules that you are entitled. For details on web screens, refer to Installing EFT Web Screens.

Troubleshooting Activation Code
When saving the license information, the following problems may be encountered:

Activation code Invalid – verify the registered company name (displayed during installation) and serial
number entered match the details supplied to Orchid Systems when an activation code was requested.

Invalid serial number – the entered serial number is not valid for this product, Sage 300 version and edi-
tion.

Important! If the Sage 300 Version or Edition change, a new Serial Number and activation

code must be requested from Orchid Systems.

If the company name registered with Sage changes, a new Activation Code must be requested from
Orchid Systems.

Refer to detailed troubleshooting tips in Troubleshooting Activation Code,

Activation code and available functionality
Depending on the components you are licensed to use, some features described here may not be avail-
able for you to use. Some functionality of Extender is only active if you have purchased the required mod-
ule component.

The license screen displays what components of the Extender module are included in the activation
code.

OPTIONS
Use this form to setup Extender Options to log user sign in and configure SMTP server details to email
from Extender

Options Tab

Log User Sign in : Yes or No.

Select Yes if you want Extender to create a log entry for each user as they log into the Sage 300 com-
pany. The date and time, user id and Machine address where the user logged in from is recorded in the
log.

Select No if you do not want to log the log-in activity.
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Python Version

By default, Extender is now configured to use Python 3.8.8.

Refer to Python version for details.

Email Tab: enter Email server details
For details, refer to Extender Email Tab on the next page

Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to email from.

Port: There is no specific field for the Port in Orchid modules. You can specify a port number after filling
in the email server details. After the email server name, enter “:xx” i.e. colon xx where xx is the port
number required.

Tip: The default port is generally port 587 with TLS.

Example: smtp.office365.com:587

Email User and Email Password: Enter a correct combination of Email user and password

Note: If using multi-factor authentication and App password, enter the App password you
create in he Email Password field. Refer to Using Orchid Modules with Office365 and Multi-
Factor Authentication

Email Comes From: Enter the email address to be used when sending email.

Example: Orchid.Systems.Modules@gmail.com . You can also enter it in the format {name}
<{address}> e.g. Orchid Systems <Orchid.Systems.Modules@gmail.com>

Note: Depending on the SMTP server you use, this address may need to match

the one you enter in the Username field, or may not work unless you set up an

email alias. Consult your SMTP server documentation for details about sending

email.

Updates Tab

NOTIFY ME WHEN THERE ARE NEW UPDATES IN EXTENDER
Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers

The check is stored in the registry and it applies to this Windows user on this computer.
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If selected, when starting Sage it will check if there are product updates available for Extender

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.

Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option

turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 

EXTENDER EMAIL TAB
The Email tab lets you define your email server. When you fill in the email option on the Extender
Options, it will email directly to your email server using the selected service. You can email documents
using 2 methods, SMTP with basic authentication or App password or Microsoft Graph (when using
Microsoft Office 365 and SMTP basic authentication is not enabled).

Email Service

SMTP (Simple Mail Transfer Protocol). You can use your own SMTP server, or an SMTP ser-
vice.

Example: SMTP Email Examples on page 84

Microsoft Graph. This service sends email via Microsoft Office 365. It is generally used when
SMTP Basic authentication is not enabled in Office 365.

Refer to Office 365 and Microsoft Graph

Note: Microsoft Graph is available in the latest product updates for Sage 300 versions 2020
and above, since October 2022.

If you don't fill in the SMTP Details, Extender cannot send emails.

Email Field details
Select the Service you want to use to email: 
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Basic Authentication SMTP:

Email Server : smtp.domain.com:587 Enter the details of the SMTP Server you want to
email from.

Port: There is no specific field for the Port in Orchid modules. You can specify a port number
after filling in the email server details. After the email server name, enter “:xx” i.e. colon xx
where xx is the port number required.

Tip: The default port is generally port 587 with TLS.

Example: smtp.office365.com:587

Email User and Email Password: Enter a correct combination of Email user and pass-

word

Note: If using multi-factor authentication and App password, enter the App pass-
word you create in he Email Password field. Refer to Using Orchid Modules with
Office365 and Multi-Factor Authentication

Email Comes From: Enter the email address to be used when sending email.

Example: Orchid.Systems.Modules@gmail.com . You can also enter it in the
format {name} <{address}> e.g. Orchid Systems <Orchid.Sys-
tems.Modules@gmail.com>

Note: Depending on the SMTP server you use, this address may need to

match the one you enter in the Username field, or may not work unless

you set up an email alias. Consult your SMTP server documentation for

details about sending email.

Microsoft Graph:

This service sends email via Microsoft Office 365 where basic authentication is not enabled to use SMTP.

Refer to Office 365 and Microsoft Graph

Tenant ID. Enter the tenant ID (alternatively called the directory ID) from your Microsoft 365
account.

Client ID. Enter the client ID (alternatively called the application ID) from your Microsoft 365
account.

Client Secret. Enter the client secret from your Microsoft 365 account.
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Tip: This is actually the secret value, not the one called Secret ID. It is the one that
you only see once when you first create the client secret.

Tip: The client secret is valid for 2 years maximum. You may need to create a new
client secret if emailing with MS Graph suddenly stops working.

From Email Address. Enter the email address to be used when sending email.

Examples
Refer to the examples below for detailed settings with commonly used mail providers, such as Office 365
and Gmail.

Example: SMTP Email Examples on page 84

Test Email Configuration
You can use the "Send Test Email..." to check your email settings. You will be prompted to enter an email
address to send the test email to.
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Example:
When the email is sent successfully, you will receive a test email.

If not a log file is displayed with the error encountered.

Email sent successfully example
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Example: If you receive this email, your SMTP email is working correctly. If not, check the errors in the
log.

Tip: Test sending to an email address in the same domain as your SMTP Server and one out-
side of your domain.

Tip: CC doesn't work when testing. Even if you configure a CC address in the

Email Tab, the test email is only sent to the email address you enter when testing.

Troubleshooting Sending emails
Email Troubleshooting on page 87

SMTP Email Examples

Email with Office 365

You can email from Orchid modules using Office 365. The exact steps depend on your Office 365 con-
figuration. You can choose SMTP with basic authentication, use MFA and App Password, or use Microsoft
Graph.

Using Office 365 and MFA

Although Orchid modules don't support 2-step authentication directly, you don't need to turn off MFA
to use email using SMTP or DML with SharePoint integration. If you enable MFA, you can use it for all
applications that support it.

To use Office 365 to email from Orchid modules and to use Document Management Link and SharePoint
integration, users need to create an APP password for use in the Orchid module, as supported by
Microsoft. 

For details, refer to Using Orchid Modules with Office365 and Multi-Factor Authentication

Configure Email when using Office 365
When using Office 365 to email, basic SMTP authentication is disabled by default and you need to use
Microsoft Graph as the email service.

Refer to Office 365 and Microsoft Graph
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Note:
The details below are left in the documentation if your Office 365 setup supports basic
SMTP Authentication and App Passwords.

Email Server -> smtp.office365.com:587

Email User -> username@samplecompany.com

Email Password -> Enter Password

If using Multi-factor Authentication and App Password, enter the App passwordl.

For details, see Using Orchid Modules with Office365 and Multi-Factor Authentication

Encryption: TLS

TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails.
The SMTP Client uses the protocol configured on the operating system, based on the
.NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.

Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was
added to Orchid modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the
latest product update for your Sage 300 version.

Useful Links

Here is a link to Microsoft documentation on how to allow applications to send email via Office365.
http://technet.microsoft.com/en-us/library/dn554323.aspx

Using Gmail

You can configure Orchid modules to email using Gmail.

Since May 2022, you cannot disable 2-step authentication in the Gmail settings and you need to use App
Password.

Email Server: smtp.gmail.com:587

Email User: username@gmail.com

Email Password: App password you create for the user emailing.
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Tip: If there are spaces in the App password, remove the spaces before saving. Include only
the characters.

Encryption: TLS

Note: In some older versions of Orchid modules, for Google mail to be setup in

Outlook/other email application/device (as recipient in CC/BCC), the Google email setting

has to have the option of enable POP/IMAP ticked.

When using any other email that has Transport Layer Security (TLS) encryption along with SMTP, you
can prefix the email server field with “TLS:”.

For e.g.. TLS:securemail.server.net

Using SendGrid

IF USING SENDGRID
Orchid module Email configuration using SendGrid:

Email Server -> smtp:sendgrid.net:587

Email User -> apikey

Email Password -> Enter Password
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Encryption: TLS

E-Email Comes From -> the email address associated with the Sendgrid account

Here is a link to SendGrid documentation on integrating with the SMTP API

Sendgrid: integrating-with-the-smtp-api

Here is a link on How to send email using the SMTP Relay

SendGrid smtp guide

Using Hotmail

CONFIGURE EMAIL WHEN USING HOTMAIL OR MICROSOFT OUTLOOK.COM
Email Server -> smtp.live.com:587

Email User -> username@hotmail.com

Email Password -> Enter Password

Encryption: TLS

Email Troubleshooting

Failure sending mail

If you get the error message “Failure sending mail” – check that you have entered the correct details in

The E-mail server field
The correct combination of email user/password/comes from fields. The combination and number
of these fields that are required depends on the configuration of the email server
The correct encryption method is selected

Port

If the default port for email (25) is not in use, ensure the port is included in the Email server field
separated by a semi-colon (:). For example smtp.office365.com:587 if port “587” is being used for
e-mail.

Legacy Authentication

If you are using MFA and App password in Office 365, but are still receiving errors when testing the
SMTP email, ensure that Legacy Authentication is not blocked. Refer to Office365 and Legacy Authentic-
ation.
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TLS Version

You don't select a specific TLS version. Orchid uses the .Net SmtpClient class to send emails. The
SMTP Client uses the protocol configured on the operating system, based on the .NET version installed.

The email function supports Ssl3, Tls1.0, Tls1.1, Tls1.2 and Tls1.3.

Microsoft has recently stopped support for TLS1.0 and TLS1.1. Support for TLS 1.2 was added to Orchid
modules in April 2020 and applies to Sage 300 versions 2018 and above.

Important! If you have any issues emailing, please ensure you download and install the latest product
update for your Sage 300 version.

You get the message “E-mail sent”, but no email is received,

In many cases, there is almost no delay the “E-mail sent” message being displayed on the screen after
clicking “Send Test E-mail”

Ensure the virus checker and firewall on all machines where e-mails are to be sent from. They must
be set to exclude “..\EL6xA\sendmail.exe”
If you get a File missing error, check that the anti-virus is not deeming the sendmail.exe a virus
threat.
SMTP Server may include configuration to expect a valid client certificate from the server-
/workstations where Sage is installed. Once the certificate is installed on the client, emails can be
sent.

You are able to send emails to internal email accounts, but not to external email accounts, the most likely
cause is that your email server requires a valid username /password for sending to external addresses
and the details entered are not correct.

Note: Check your email server to see if it requires a username/password. Some require it to be blank,
for some it does not matter.

Note: Some email servers will allow you to log on as a certain user and send email as anyone, others
will only allow you to send email as the logged on user. So if you log on as "Joe", but try to send as
admin@testdomain, some email servers won't allow it.

Exceeding email limit error -

This applies to EFT Processing only.

If you are getting errors relating to "exceeding limits" when sending email remittance advice, you can
configure the options to Number of emails per minutes or Number of emails per session to match the
requirements of your email server.

EFT Options Screen Guide
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Process Scheduler emailing tips

When using Process Scheduler with Extender or Report Runner, the Process Scheduler email settings are
only used if the Schedule is configured to send emails on success or failure.

The Run Information Manager Step uses the SMTP Email configured in Information Manager a> Report
Runner and the Run Extender Script action uses the SMTP email configured in Extender.

When using Process Scheduler to email Reports configured in Report Runner, check the email con-
figuration in Information Manager, not just Process Scheduler.

When using Process Scheduler to run Extender scripts that send emails, check the email configuration in
Extender Options, not just Process Scheduler.

UPDATES TAB
Use the Options > Updates Tab to see details about product updates available. Also includes a list of
new features and fixes since the initial release.

Release Notes are available in the Help & Documentation.

NOTIFY ME WHEN THERE ARE NEW UPDATES IN ORCHID MODULE
Users can now "subscribe" to notifications of updates.

By Default, this option is not selected for end-user serial numbers

The check is stored in the registry and it applies to this Windows user on this computer.

If selected, when starting Sage it will check if there are product updates available for Orchid Module

If there is a new update, and the user hasn't previously been notified of it, then the Options screen
will open automatically on the Updates tab and display details of the new updates.

Tip: The “administrator” or “super user” or “owner” of Sage 300 should have this option

turned on. All other users should have it turned off.

CHECK FOR UPDATES AND SUPPORT REQUESTS
You can use "Check for Updates" button to view the list of new features and fixes.

To facilitate support, please include the Version and Product Updates you are running when report-
ing any issues.

Updates are available to be downloaded from the partner area of the Orchid website Product down-
loads. 
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EVENT TYPES.
The Event Types form lets you:

Create events that can be attached to changes to Views or View Field values.
Events can either

Log changes done to a View or a View fields
Run a program
Send an email
Create an Information Manager Note

Requirement! Orchid Information Manager Notes needs to be activated in the database.

Next Steps: 

See View Events, Scripts & WF on page 147

Note: Each event is identified in the background with a unique 16-character Event Type ID code.

EVENT TYPES - FIELD LIST
EVENT

Enter up to 16 characters to identify this event type.

DESCRIPTION

Enter up to 30 characters for a description to allow you to easily identify this event.

COMBINE

If the event is to be attached to multiple view fields in one view, then select one of :

Combine : to have only one event being triggered if more than one view field
changes at the same time.
Don’t Combine: to have the same number of events being triggered as the
number of view fields that are changed at the same time.

Important! If you want to track the "Before" and "After" value, select Don't Com-

bine.
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Example: if you send an email to the accounts department if the customer credit limit is
changed or when the customer terms is changed and both fields are changed at the same
time – you will have two emails being sent if you choose not to combine events. If you
choose to combine events, one email will be sent.

ACTION

Select the type of action to be associated with this event.

Depending on the Action, the following fields will be made available

Log Change :No additional fields will appear
Run Program : call a nominated program if the view field is changed. For this
Action you need to define the following :

Command : use the find icon to browse to find the program to be run
when this Event is triggered
Working folder : browse to find the working folder for the program spe-
cified in “Command” field above

Send Email : create and send an email if the view field is changed. For this
Action you need to define the following :

Email To : specify the Email address(es) separated by semi-colon “;” if
more than one to whom the Email must be sent when this event is
triggered
Email CC : specify the Email address(es) separated by semi-colon “;” if
more than one to whom the Email must be cc’d when this event is
triggered.
Email Message ID : use the finder to select the existing Message Tem-
plate to be Emailed when this event is triggered

Create I/M Note : create an Information Manager Note if the view field is
changed. For his Action you need to also define the following

Note Type : use the finder to select the existing Information Manager
Note Type to be created/updated when this event is triggered.
Key : Specify the View Field ID in braces “{xxx}” for the key field for the
View to which the event is attached. For Example: if you are creating or
amending an IM Note for customers, the Key Field would be defined as
follows {IDCUST}
Note Template : use the finder to select the existing Message Template
to be Created/updated when this event is triggered.

E-MAIL TO
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Only visible for Send Email action. Complete with the email address of the required email recip-
ient for the email to be sent when the action is triggered

E-MAIL CC

Only visible for Send Email action. Complete with the email address of the required cc recipient
for the email to be sent when the action is triggered

E-MAIL MESSAGE ID

Only visible for Send Email action. Select the required email message id for the email to be sent
when the action is triggered

NOTIFY USER OF EMAIL SENT

Set to Yes if you want an on-screen notification when an email is sent.

Select No if you want to send the email in the background without a notification.

NOTE TYPE

Only visible for Create I/M Note action. Select the required I/M Note type for the note to be
updated/created when the action is triggered

KEY

Only visible for Create I/M Note action. Enter the key field for the I/M Note. This should be the
key field in curly brackets (Braces {}) for the view to which the action will be attached. For
example, when creating an IM Note for the AR0024 View – the Customer View, the key field
should be {IDCUST}

NOTE TEMPLATE

Only visible for Create I/M Note action. Select the required I/M Note Email Message template
for the I/M Note to be created or updated

WORKFLOW COLOURS
This screen allows you to assigne RGB codes to Colour Names which can be used in your workflow.

On the workflow console, a workflow instance will be coloured based on the COLOR value in the work-
flow instance. The "AssignColour" workflow action allows you to assign a colour to a workflow instance
as part of the workflow.
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Note: You can filter by up to 5 colors on the workflow console, but you can create as many

colors as required.

STEPS

Enter a Colour Name.
Click in the colour column to select the colour

Tip: Use a name that represents where you will use the colour (e.g. urgent), rather than just Red or
Blue. This makes ongoing maintenance if you want to change the colour of Urgent tasks, you can
change the "Urgent" colour rather than update all the Red colour.

WORKFLOW USER GROUPS
Use this icon to create groups of users who can be assigned tasks in the workflow.

Steps To create a User group:
Enter a name and a Description
Insert rows in the detail grid to select Users, using the INSERT key.
Users need to be configured in Sage 300 first and should have the security rights in Sage 300 to
perform the tasks required in the workflow.

Note: You can view the user's email addresses. To amend the email address, use the Sage
300 user maintenance screen. You need to re-open the screen to view changed email
addresses.

How to use Workflow User Groups
In the AssignUser workflow action, you can enter a user group instead of a single Sage 300 user.

In the console, you can view all tasks that you are assigned to and tasks assigned to a group that you are
a part of.

Note: If you have Security rights to view all Workflow, you will also see workflow instances assigned to
all other users.
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Example:
In a workflow to Approve A/R Credit Limit, create a user group "ARAPPROVER", add Sage 300 users to
the group. The users in the Approver group need to have rights to Accounts Receivable, Customer
Maintenance and Edit Credit Limit.

Assign the workflow to the ARAPPROVER group.

VIEW EVENTS, SCRIPTS & WF
Use this form to add Extender events, custom scripts and workflows to Extender views and fields.

Select a Sage 300 View to be configured with Extender.
By clicking on the “All Views” info icon (or use F6 key) , you can select the appropriate view from the list
of available views, active in your Sage 300 database.
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Fields and Controls
REMEMBER ORIGINAL VALUES FOR: 
You can determine what fields Extender need to track the original value for. This is particular useful
for email messages.

Leave blank if you don't need the original value in the Script, workflow or email messages.
You can enter the field names you need. For example, if you only need the original value for
the Description and the name, “DESC,NAMECUST”
Use * if you want Extender to make the original value available for all fields. This is useful if you
use the original values in a script, in email messages or in a workflow, but you don't want to list
all the fields you need in advance.

Note: On some views that have many columns and that are opened many

times, e.g. the OE Shipment Header and OE Shipment detail view, using *

may have an impact on performance.

Tip:
You can also add code in the script to determine what fields the script needs the original value.

Refer to Scripts-AdvancedTips*

Events Tab
On the Events tab, you can attach an Event Type to an Extender View operation and/or View field/fields.

Requirement! The Events Tab is available if using Extender Levels Configurator, Customizer or
Developer

FIELD NAME
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Select the appropriate view field from the list of available view fields. All view fields will be available,
including the following standard operations of a Extender view

Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

EVENT CODE

Select the appropriate Event Code from the list of available Event Types. on page 90

Important!
If you need to log the Before and After Value, you need to make sure the event type you select has
been configured as "Don't Combine".

If you select the View Operation {INSERT}, {UPDATE} or {UPSERT}, the Before and After values will be
available if the event is configured as "Don't Combine". One record will be added to the LOG or
emailed for each field that is changed.

For the "Delete" action, only one record will be logged.

Refer to Event Types. on page 90

Scripts Tab
On the Scripts tab, you select the Python script to be run when the selected view is being updated. Mul-
tiple scripts can be selected, and are run in the order specified.

Requirement! The Scripts Tab is only available if using Extender Levels Customizer or Developer

ACTIVE

You can activate or deactivate a specific script without deleting it from the View

RUN ORDER

If multiple scripts have been defined, you can select the order in which they run by entering a num-
ber associated with each script. A script associated with Run Order 1 will run before a script asso-
ciated with Run Order 2 etc.

FILE NAME (F9 TO EDIT)
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If you are uploading a new script, click F6 to browse and find the .PY file to attach to this view.
When selected the script will be

Copied to the associated COMPANY directory, and this is where the “.PY” file will be invoked
from
Imported into the database

If you are attaching a script which already exists in the database, click F9 to find the existing script,
and associate with the current view.

If you want to edit an existing script, click F9

STATUS

Shows blank or “Checked Out” if currently checked out. In order to check out a script for amend-
ment, you can right hand mouse button on the script row, and select Check Out. Once checked out
you can open (to edit the script), and upload (to replace the existing script with the amended
script).

CHECKED OUT BY

User id who currently has the script checked out

Tip: Once you have uploaded a Script and it is active against a view, you can “check out” the
script to make changes to the script, to test the script while leaving the original script active. Once
you “check in” the script, the existing script will be replaced with the new script.

PARAMETER 1..PARAMETER 4

Your scripts can contain up to 4 parameters.

You can access the parameters in the Python script with the global variables Parameter1, Para-
meter2, Parameter3, Parameter4.

Note: The first few rows of the highlighted script will be shown to assist with the commenting and
verification of the attached scripts.

Tip: To check out, open, upload or Undo Checkout, right hand mouse button on the required script
and select the required action.
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Important!
If you need to amend a script after it is attached to a view, you need to check it out, open it to make
the changes, save the script and check it in to enable the changes.

If the script is amended on a separate machine, you need to re-import the PYTHON script

When PYTHON scripts are attached to a view they are

1. Imported into the associated database, so the script will dump and load with the

database

2. Copied to the Company directory, where the PYTHON script is run - If you edit the

script directly in this directory, your changes might get overwritten.

OCX Scripts do not need to be added to a Sage 300 View. The script name matches the Sage 300
screen Roto ID to indicate that the script is enabled.

Workflow Tab
On the Workflows tab, you can attach a Workflow Template to a Extender View operation and/or View
field/fields. The workflow will start automatically when the view is used in Sage 300.

You can use F9 to open the Workflow Template screen from the Screen.

FIELDS AND CONTROLS

Requirement! The WorkflowTab is available if using Extender Levels Configurator, Customizer
or Developer. If using Configurator, you can only use pre-configured actions in the workflow tem-
plate.

FIELD NAME

Select the appropriate view field from the list of available view fields. All view fields will be avail-
able, including the following standard operations of a Extender view

This allows you to attach a Workflow Template to

• Any field. If a field has an Active Workflow Template, the new value entered will be stored in
“{NEWVALUE}” and the original value reset before the record is saved. This new value will be
available in the workflow

• Insert/Update/Delete. The record will be saved and then the workflow will be started.
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Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

WORKFLOW

Select the appropriate Workflow from the list of available workflow templates. Workflow Tem-
plates - Screen Guide on page 130

ENTRY STEP

Select the step that will be run when the field changes / view operation completes.

PARAMETER 1 TO 4

You can pass up to 4 parameters to the workflow.

To use the parameter value in the workflow, use the SetValue action. You can use {$1}, {$2}, {$3},
{$4} to set the value to a field.

For details and examples, Using Parameters in Workflow on page 187

Important!
Workflow is only available for flat views: Master files (e.g. A/R Customers), Transaction Header views
(e.g. O/E Header) or Batch Header view (e.g. A/P Invoice batch)

Tip: View Events and Scripts can be exported and imported using the File Menu.

If you select Export, then only the current View configuration will be exported. The

export includes the attached events and scripts.

If you select Export All, then all the current View configurations will be exported. The

export includes the attached events and scripts for all configured views. The export

format is proprietary, and cannot be changed.

Note: Different options are available depending on the level of Extender you are running.
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MESSAGE TEMPLATES
Message templates can be used in Extender Events (Send Email and Create Information Manager Note),
Scripts and Workflow Templates.

You select an Email Message ID when you configure Extender Events (for details, View Events, Scripts
& WF on page 147) and on the Workflow Template Action setup (when using a SendEmail action) (for
details, Workflow Templates - Screen Guide on page 130).

Tip: Message templates can be exported and imported to save time re-keying similar messages

Message Templates Field List
MESSAGE ID
A message ID is a unique code of up to 16 characters that identifies a message template.

DESCRIPTION
Enter a description of up to 60 characters for the message template.

EMAIL SUBJECT
Enter a subject line for the email message. If creating a template for I/M Notes, leave the Subject
blank.

EMAIL/NOTE BODY
Enter the body of the message/note template. The body of the message/note template can be as
long as you need it to be. Variables can be inserted in the message template. See below.

COMMENT
Enter a comment up to 250 characters for the message template.

Message Variables
You can add variables to the subject line and body of your email message and/or to the contents of your
I/M Note. For more information, see Message Template Variables

Attachments
You can include standard attachments to message templates used in Extender scripts and workflow
actions.
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To configure: 

Insert a row
Browse to select files to attach to the email.
Repeat for all files you want to attach to the email.

Tip: Use UNC Path and ensure that all users who email can access the folders.

How it works: 

When you load the message template in a script, Extender adds the attachments configured in the
template automatically.
You can also attach files dynamically to the email in a script using email.attach("filename")

Email and attachments

e = Email()

e.load(“template name”) # ← adds any attachments from the email template

e.attach(“filename”) #← also add this file dynamically in the script

Using HTML messages
Email templates are sent as HTML if they contain "<html>" and "</html> Tags.

To add a line, you must use <BR> or include <p>my text</p> around each line.
If copying your existing text email templates, make sure you add <BR> wherever a new line is
required.
To add a logo to the email message, use a hyperlink with an image source file to include a link to a
logo saved on your website or another accessible site.

Insert an image / logo example

<p><a title="Orchid Systems Events" href="https://www.orchid.systems/events"><img
src="https://www.orchid.systems/sites/default/files/inline-images/OrchidWebsite_
Email.png" alt="Orchid Website" data-entity-type="file" data-entity-uuid="d728cc57-
5309-4c73-8aa8-5d2bdc7bed25" /></a></p>

Orchid module doesn't include an HTML Editor, so we suggest you use an online editor (e.g.
https://html-online.com/editor/) then paste the HTML code into the Extender Email editor.
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CUSTOM TABLES
Using Custom Tables, you can create tables within the Sage 300 company database. These tables will be
accessible via view calls, will be in the Sage 300 dictionary and the table will dump and load with the asso-
ciated company. These tables will automatically be upgraded when a newer version of Extender is loaded

Tip: If you create a table and subsequently add a new field, the new field will be added to the dic-
tionary and the existing data preserved.

Enter a unique Table name and table description.

Extender will give a unique View ID to the table.

All custom tables require at least one key.

Notes:
If using a Module, ensure that the table name is entered as [MODULEID].TableName. Extender will save
the Database Table Name with the names to the right of the "full stop".

In an Extender Python script, you can refer to the table by the Database Table Name or the View ID.

Import/Export
Use the File menu to Export / Import the Table definition.

You can also export records from and import records into the custom table.

Tips:
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Use the Custom Table Editor to enter a few records, then export Records from the File menu. Add and
Update data in the spreadsheet. Use File > Import Records to import into the custom table.

Custom Tables Field list
CUSTOM TABLES FIELDS FIELD LIST

NAME :

Enter the field name.

TYPE:

Select the field type. One of Text, Date, Time, Number, Integer (16 bit), Integer (32 bit),
Boolean.

To mask the value of a TEXT field in the custom table editor, set the List Values to
"PASSWORD"

DESCRIPTION:

Enter the custom table description. This is used in the Custom Table Editor to select which
table to maintain.

It is also used when exporting and importing records in the custom table.

SIZE

Enter the size (length) of the field. Required for Text and Number fields only.

DECIMALS:

Enter the number of decimals required. Required for Number only.

MASK:

If you want to automatically apply a mask to the field, enter the mask required.

Example:
%-12C means 12 characters, capitalised, left aligned

%12C means 12 characters, capitalised, right aligned (field will start with spaces).

Refer to the Sage 300 SDK guide for guidelines on entering the mask.

FINDER TABLE

If you require the Custom Table Screen painter to add a finder to a field, then enter or select
the View id for the finder. For example, if you want a finder on the AR Customer view, enter
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AR0024

FINDER FIELD

Select or type the field which will be returned from the finder once a record is selected. This
applies to fields setup with a Finder table.

For example, if you want a finder on the AR Customer view and when selected, the AR Cus-
tomer ID is returned, enter {IDCUST} in the Finder Field

FINDER FILTER

Type a filter string if you want the custom table editor to restrict the records shown in the
finder. This applies to fields setup with a Finder table.

Examples:
IDGRP="RTL" - This will show only customers where the Customer Group is "RTL".

IDCUST="{FIELDNAME}", where FIELDNAME is the field you want to filter by. FIELDNAME is
another field on the custom table. 

If you have a custom table with 3 fields IDCUST and IDCUSTSHPT. IDCUST has a finder on the
AR0024 ARCUS table and IDCUSTSHPT has a finder on the AR0023 / AR Ship To table. You
might want to filter the Ship-To Finder by the customer selected in the IDCUST fields.

You would configure the IDCUSTSHPT field as per the screenshot below
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DESCRIPTION FIELD

Select / Enter the field which will be displayed next to the Finder Field once a record is selected.
This applies to fields setup with a Finder table.

For example, if you want a finder on the AR Customer view, and you want to display the cus-
tomer name next to the Customer ID, Select NAMECUST as the description field.

LIST VALUES E.G. ‘0=INACTIVE;1=ACTIVE’

If you require the Custom Table Screen Painter to build a drop down list box for a field, then
enter the list of required drop down field values and descriptions separated by semi-colons(;) .
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Important! The field value has to be an integer (16 bit) or Integer (32 bit) for this to be avail-
able.

The structure of the field value should be 1=abcd, where

1 is the field value and Abcd is the displayed drop down value

Use ; (semi-colon) to separate list values. Required for all list values except the last one

On the F9 Zoom / Details View, you can add/update the list of values. Insert a new row to add a
new value.

Example:
Example, the Drop down

Active

Inactive

Would be entered as 2=Pending;1=Active;0=Inactive

Tip:

Masking field values: 
Create a field of type TEXT, and set the List Values field to PASSWORD

Custom Tables Keys Field List
FIELD LIST

NUMBER:

Enter the key number

NAME:

Enter the key name

DUPLICATES ARE:

Select one of “Allowed” or “Not Allowed” depending if duplicate key values are allowed or not.
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FIELD 1 .. FIELD 10:

Select up to 10 fields from the table to be included in the key.

Table design consideration
Rule 1: The primary key of your custom table must start with the first field in your custom table. That is
the convention and design that Sage views/tables follow.

Rule 2: If the primary key includes multiple fields, the fields must be consecutive in the Table setup.

Rule 3: If you have only one key in the table, the key can be Duplicates Allowed or Duplicates Are Not
Allowed.

If you have more than one key in the table, the primary key must be "Duplicates Are Not Allowed" and
must start with the first field in your table. Your secondary, third, or fourth keys do not have to start with
the first field, and they can be both Duplicates Allowed or Duplicates Not Allowed.

CUSTOM TABLES EDITOR

Select the required Custom Table for which you want to enter/update data and click “Load” to load all
the fields from the Custom Table onto the screen.

All the fields will be listed in order.

After entering data, click “Add” to create a new record in the Custom Table

Existing records can be “Saved” or “Deleted” as required.

.

If a Description field is configured for Finder Table fields, the description will be displayed next to the
finder field.

if a Filter Field is defined in the Custom Table, the finder will restrict the records shown based on the filter
entered.

This applies to fields setup with a Finder table.

For details on creating a custom table, refer to Custom Tables on page 102

EXTENDER SCRIPTS
Orchid has implemented PYTHON 3 scripting around the Sage 300 Views and Sage 300 desktop screens,
so site specific business logic can be implemented using PYTHON 3 scripting and applied to Sage 300
core and 3rd Party Views (if they are developed in the Sage 300 SDK) – when records are inserted,
updated and deleted.

There are four main types of scripts: 
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View scripts , attached to a specific view field or view operation such as Insert or
Update
UI Scripts - to open a screen on the Sage 300 desktop. Such scripts can be used to main-
tain Sage 300 core data, records in Extender custom tables, or gather input to trigger a
process.
Screen scripts subclass Sage 300 OCX screens and are used to add buttons, hide / add
fields, to Sage 300 screens.
Workflow Action scripts

How to use the Script List
The Scripts screen lists all scripts which have been uploaded to the current company. The script name,
Status(Active/Inactive) and Checked In/Out status will be shown, together with the first few comment
rows of the currently selected script for verification. You can also see if the script is Viewable and Has a
password.

You can upload new scripts from this screen or create new ones.

Tip:
Insert a new row and type a script name to create a new script.

When you create a new script, you get a different default script based on the script name.

If your script has ".WORKFLOW." in the name, you get the workflow sample script.

If your script is subclassing a UI (ie it has a .XXYYYY. in the name) then you get a ui subclass
sample script.
If your script has ".UI." in the name, or ends ".UI", then you get a sample ui script

Otherwise you get a sample view script.

You can also right-hand-mouse-button on any script and

View the script
Check out the script
Undo the checkout of a script
Select an Editor
Add the script to the Sage 300 Desktop.

Add a Script to the Sage desktop
Select a script, right-click on the script and select "Add the script to the desktop"
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This option brings up the tree of the existing menu, and allows you to select which branch the script
must be placed.

Note: To create new folders in the tree, use the Insert key on your keyboard, enter a name

and select the new folder. Extender cannot add a script to a folder created using the Sage

New Folder menu.

Delete a script from the desktop

In Extender Setup > Scripts, as a user with Extender Admin rights, select the script, right click on it, and
choose “Add to desktop”.

Find the script in the Sage 300 menu where it was added.

In the example screenshot, the script was added to the Extender > Inquiries menu, you need to find the
script in that menu.

Then use the DELETE key on the keyboard.

To save, there is a little trick… You need to use the X cross on the top right and Save the changes. Restart
the Sage desktop. The script should be removed for all users.
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Note: This doesn't delete the script, it just removes it from the Sage 300 desktop for all

users.
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Viewing and editing scripts
With Extender PU6 and above, you can hide and/or password protect scripts.

Scripts can have two optional lines in them:

#! password=xxx

#! viewable=true or #!viewable=false

Tip:
On the Scripts screen, if you double click on the Password column, you are prompted to add / remove
a password.

If you double click on the "viewable" column, you are prompted to add/remove a password.

If you have a password set then by default, the script is not viewable unless you add the viewable=true
line. You can't checkout the script unless you know the password, and the script is not stored as plain
text on the disk.

When you choose Edit, you will be prompted to enter the password. Scripts can be edited without re-
entering the password until you close the Custom Scripts screen.

EXAMPLES
The script below can be viewed without the password, but you need to password to check it out and
edit it.

The HidingScript example cannot be viewed or edited without the password. If you right click on it
and choose "View", you get a message "This file is not viewable."
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How to apply an OCX Screen script
With Extender PU4 and above, you can also add scripts to Sage 300 Desktop screens (OCXs).

USE Screen scripts to: 

Add tabs, fields, buttons and finders to the Sage 300 desktop screens
Hide/Remove tabs, fields, buttons and finders on a Sage 300 desktop screen
Change finders and buttons on a Sage 300 desktop screen
Interact with the underlying datasources. (Previously scripts only operated at the View level, and
therefore were not always reflected on the screen.).

Example: You can add row to an order and refresh the grid to view the row, or interact with
optional fields.

Writing a OCX screen script name:

Name of a screen script (OCX script)

Must contain the RotoID of the required screen, surrounded by a full stop and
Must have the RotoID on the first line of a script, following a hash (comment) marker
(#OE1100 for an Order Entry Screen script).
The combinations below are all valid, where RotoID is the ID of the Sage screen, for
example AR1300 for the AR Customer Screen.

{rotoID}

{anytext}.{rotoID}

{anytext}.{rotoID}.{anytext}

{rotoID}.{anytext}

Tip: If the script is called OE1100_myscript, it is not active as a screen script.
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Example:
Script Name

For Scripts without a module name:

OE1100.NewScript.py

If you are deploying your OCX script as part of module, and the module name is “Orchid.MyModule”,
then the OCX script would be called:

Orchid.MyModule.OE1100.NewScript.py

The first line of the script must be:

# OE1100

Tip:
To disable a screen script,

Edit the script and add at least 2 comment characters.

Disable a OCX Screen script

### OE1100
# such a screen script is disabled.

Workflow Action scripts
An action is a Python script that is stored in the database just like regular user scripts.

Configurator includes a number of predefined actions. For details, refer to Configurator Actions on
page 177

A workflow script can have up to 4 parameters passed to the script from the workflow template.

At the top of the script, add a new comment line, starting with ## then add P1 and the name you want to
give the parameter. The name will appear in the Workflow Template, Action Grid and F9 zoom screen.
For details on setting up Workflow templates, refer to Workflow Templates - Screen Guide on page 130.

# P1 Parameter1Name You can name up to 4 parameters that can be configured in the workflow tem-
plate.

# P2 Parameter2Name

# P3 Parameter3Name

# P4 Parameter4Name
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Example:
Look at the Workflow.Evaluate script: 

#Instructions for your script go here

## P1 Field

## P2 Operator < <= > >= <> = # you can use either <> or !=, and also = or ==

## P3 Value

The field names when using the Evaluate action will show as

Field, "Operator < <= > >= <> =" and Value

Resources
Get Started with Python 3 Script on page 73

EXTENDER MODULES
The Extender Modules enables you to create a Module – which associates Custom Tables, Events, View
Events and scripts into a single module which can be exported/imported in a single file for ease of
deployment.

How to use
You use the Modules screen to import an Extender module developed by your Sage 300 partner or expor-
ted from a development database. You can also create new Extender modules if you are configuring
Extender.

Create a module

You make the association between the Events, Scripts, View Events and scripts by the use of a unique ID 
(module name).

Tip: It is suggested to use your company name in the Module ID for ease of maintenance.

All Events, Scripts and Tables to be included in the Module must be named as follows :

[ModuleID].[TableName], [ModuleID].[ScriptName], [ModuleID].[EventName]

Components of an Extender module

You can view all the components of a module in the panel below the list of modules. You can double
click on the individual component to open the relevant screen for checking and editing.:
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For example, double-click the Event to open the Event Screen, the Message Templates to open the email
template, the custom table to view the table definition and open the custom table editor.

Tip: If you have a long list of modules, you can use CTRL-F to filter by module ID or module name

Double-click on the Table name to view and edit the Extender Custom Table definition. You can also
open the Table Editor to maintain records.

In Extender Scripts, you can right click on a script that displays a screen to edit records and choose "Add
to Desktop". This adds a menu item to the Sage 300 classic desktop.
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In the Modules > Menu Items Tab, you can view where the shortcuts have been added.

Field List and controls
To create a new module, use the INSERT key to add a new Row and enter the Module details.

Detailed Field Description

COMPANY

Enter the development company name (e.g. Orchid)

NAME

Enter the Module name (e.g. CommentTemplates)

DESCRIPTION

Enter the Module description (e.g. Comment Templates associated with the Item, copied to the OE
Order Detail when the item is added to the order)

DATE INSTALLED

The date created/imported will be displayed

WEBSITE
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Enter the company website

VERSION

Enter the Module Version

ID

Enter the Module ID. You can include a Company Code to ensure the Module ID is unique.

Important! The module ID must be used to name the Events, Scripts and Tables to be

included in the module.

INSTALLED FROM
This is populated automatically the first time you import a module file. Use Check for updates to high-
light modules with a different version in the installed from folder.

Python packages

The PIP Tab on the Modules lists all the Python packages Extender has installed as a result of @pip lines
in scripts.

When pip is run it now records a log file in the site_packages\.. folder - right click on the PIP grid
and select ‘Open folder’ - go up one level and the log files will be there.
If you right click on a module on the PIP page you can select ‘Remove ‘{xxx}’ from this computer'. It
will delete the pip module and the next time a script is run, it will reinstall the missing pip modules.
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Note: If you delete %shareddata%/Company/%orgid%/excache.ver then ALL workstations
will recheck pip modules. This can be used to download the latest version of the package.

Adding files
You can add files to the module.

On the Files Tab, use the INSERT key to upload a new file.

You can then use the getFile function to use the file in a script.

The file will be included in the module when you export it and can be imported in another database.

See details in Adding files to a module

Enable/Disable
The buttons applies to view scripts configured in View Events, Scripts and Workflow only. It sets the Act-
ive flag to No.

if you need to disable a screen script, refer to the Scripts topic. Writing a OCX screen script name: on
page 113

Export modules
Use the Export button to export Extender configuration to a file saved on a network folder. This will cre-
ate a file with a .VI extension, including all the components named with the module ID.

You can then import the file into another database.
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Import modules
Use the Import button to import an Extender module saved on a network folder. This will create and
update all the components included in the module. It is recommended to restart the Sage desktop after
importing a module.

Note: It doesn't delete any components. If you need to delete some events or scripts, you need to do
this manually.

Check for Updates
Updating Modules

On the Extender Setup > Modules screen, you can "Check for Updates". If there is a file with a newer ver-
sion in the "Installed from" folder, the module is highlighted.

Select the module and select "Update"

Example: Check for updates, select the Workflow module and Update. The latest file is imported auto-
matically from the VIXXA folder.

Examples
You can use the link below for an example of an Extender Module.

Comment Templates Module Example

Tip: The Modules screen is written using a Python script and can be used as starting point

to create a custom screen that displays Sage 300 records in a grid. Look at the VI1011.py

file in the VIXXA folder of your Sage 300 installation.

ADDING SECURITY
If your Sage 300 system requires user passwords and security profiles, you need to create Security
Groups and assign user security to Extender. All other setup options can only be run by the ADMIN user.

For information on activating security and setting up security groups, refer to the System Manager
online Help (choose the Help menu on the Sage 300 desktop) or review the chapter, “Setting Up Secur-
ity,” in the System Manager Administrator Guide (or the System Manager Setup Guide if you are using
Sage 300 Standard).

Assigning Extender security
Using the Security Groups form in the Administrative Services folder, you can assign the following secur-
ity tasks to Extender.
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Security Group Description

View Logs Can view logs populated by Extender

Edit Scripts Can Edit and Run Extender scripts using VI1001 and VI1008.

Run Scripts
Can Run scripts from the Extender Setup screens.

Note: You don't need to give Run Scripts Security rights for Extender
View or UI scripts to be active.

Access Modules Screens Can import and export modules

Access Setup Screens

Access to all setup screens, including Custom Tables and configuring
Email Messages.

Note:
This includes the following Security Groups: Access Modules Screens,
Configure Events and Run Scripts -

To Edit Scripts, you need to select the "Edit scripts" group too.

Configure Events Can attach existing events to View and view fields.

View Custom Table
records

Can access Extender's Custom Table Editor to view records in all custom
tables.

Note: You don't need access to the Custom Table Editor for a script to
use the custom table values in an Extender script or an
Information Manager Note.

Edit Custom Table
Records

Can access Extender's Custom table Editor to view, add, edit and delete
records in all custom tables.

This security group only controls access to Extender's Custom Table
Editor This doesn't control the rights to View/Add/Edit or Delete records
in the custom tables. If you are using a custom script to maintain custom
table records, you need to make sure that only the relevant users have
access to the custom script.

View All Workflows
User can view all workflow instances in the Console (whether
they are assigned to it or not).

Modify All Workflows

User can reassign workflows. This is required to use the default Reassign
Action or the Delete button on the Workflow Console, even if the work-
flow is assigned to the user.

User can progress all workflows, even when not assigned to a workflow.

View Workflow Logs User can view the workflow logs for all workflows using Work-
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flow Inquiry screens.

Configure Workflow
Configure Workflow templates in Extender Setup. you have
read/write access to Workflow Templates, User Groups, Work-
flow Colours, Message Templates

Extender security and workflow users

Note:
A Workflow User license is required for each user who needs to access Extender Workflow func-
tionality:

Extender Workflow Console: The console lets users monitor workflow instances, drill

down for detail, and progress workflows that have been assigned to them.

Start or progress Extender Workflow using the Icons on Sage 300 screens.

View workflow history using configured icons on Sage 300 screens.

Access Extender Audit Logs via icons configured on Sage 300 screens to view the

detailed history of logged records.

Custom Table Security
If you need more granular security on custom tables, where some users can view records in certain cus-
tom tables, and edit in other tables, for example, you cannot use the default Custom Table Editor. You
would need to write a custom script that controls who can view/add/edit/delete records in the various
tables.
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Setting Up Extender Workflow
Workflows can be configured to approve new records, approve field changes in Sage 300 or start auto-
matically a series of actions to alert users when something happens in Sage 300.

BEFORE YOU START
Step 1: Draw a diagram of the workflow you require.

Step 2: Assign the Visual Process Flow to follow the key steps.

Refer to Assigning Visual Process Flows
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SETUP WORKFLOW IN EXTENDER

Step 1. Use the icons in the Extender Setup folder to configure
workflow:

Step 2. Setup Extender Adding Security on page 120 in Sage 300
Administrative Services.

Step 3. Configure Workflow Users.
Refer to Extender License and Workflow Users on page 127

Step 4. If you want the workflow to send emails,
Configure Extender emails . Refer to Options on page 78
Configure Message Templates.

Step 5. Create Workflow User Groups

Step 6. Configure Workflow colors

Step 7. Add Workflow Templates
Workflow Templates - Screen Guide on page 130

APPLY WORKFLOW TO THE REQUIRED SAGE 300 VIEWS.
In most cases, the workflow is configured to start automatically when a record is updated in Sage 300.

Refer to View Events, Scripts & WF on page 147

A workflow can be started automatically
when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.
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A workflow can be started manually
You can start a workflow manually from an icon on a Sage 300 screen.

The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users below,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

OPTIONALLY, ADD ICONS TO SAGE 300 SCREENS
You can configure Information Manager to add icons to Sage 300 screens to progress workflow and view
workflow history.

Configure Information Manager to enable Workflow icons on Sage 300 screens

Install and Activate Information Manager
In I/M Options, Notes/DML/Extender Tray, add configuration rows to add workflow
icons toSage 300 screens
Refresh the Tray

UNDERSTANDING WORKFLOW USERS

Setup Workflow Users
Log in to Sage 300 as ADMIN and use the Extender Setup > Licences screen to view/add/delete users.

For details on using the screen, refer to Extender License and Workflow Users on page 127

When do you need workflow users
A Workflow User license is required for each user who needs to access Extender Workflow functionality:

Extender Workflow Console: The console lets users monitor workflow instances, drill
down for detail, and progress workflows that have been assigned to them.
Start or progress Extender Workflow using the Icons on Sage 300 screens.
View workflow history using configured icons on Sage 300 screens.
Access Extender Audit Logs via icons configured on Sage 300 screens to view the
detailed history of logged records.
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Requirement! To use the Extender icons on the screens, you need to install and activate
Information Manager. If you are not using other functionality in Information Manager, you don't need
activation details.

Note:
Workflow Users also have access to Email SmartLink: E.g. so a participant in a workflow can be easily
emailed a link to a relevant Sage 300 record.

IF USING REMOTE ACTION SERVICE
A Workflow User license is required for users to progress the workflow through Remote Action Ser-
vice.

This functionality to use a one-time link in a notification email to progress a workflow without need-
ing to be logged in to Sage 300 requires an additional subscription to Remote Action Service.

Note: Workflow Users do not need to use a Sage 300 license if their only interaction with Extender
Workflow will be via the Remote Action Service.

For details, refer to Remote Action Service : Progress Extender Workflow remotely on page 207

IF USING WORKFLOW ANYWHERE
Workflow Anywhere provides an Extender Workflow Console for your mobile device.

To use the Workflow Anywhere App, a user needs a Workflow User license and a Workflow Anywhere
User license. A Sage 300 license is required when the user refreshes the data on the App or pro-
gresses the workflow.

For details, refer to Workflow Anywhere Overview

Workflow template and Workflow Users
When you assign a workflow to a user who is not configured as a Workflow User, the AssignUser work-
flow action returns an error. The next action is configured in the False Action # field in the Workflow Tem-
plate.

Make sure the Workflow Template notifies an Admin user and proceeds with the rest of the workflow
actions.

Tip: You can add a Workflow Action to assign the workflow to ADMIN if the first AssignUser action
returns False
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How do Workflow Users work?

WORKFLOW USERS are NAMED user licenses: 

Each Workflow User license is allocated to a specific, named user.
Named users, up to the number of current Workflow User licences, are assigned in
Extender Setup.
If you are using multiple Sage 300 databases, Named users are shared across all data-
bases where Extender is activated.

Note: A Workflow User license is not required to trigger an automatic Workflow (e.g. by updating a
record in Sage 300)

EXTENDER LICENSE AND WORKFLOW USERS
Use the Licence form to review the Serial Number and Activation Code which has been applied to this
installation.

For details on the Extender License screen, refer to Extender License Screen on page 75.

Note: For details on workflow users functionality and licensing, refer to Understanding Workflow
Users on page 125

Maintain Workflow Users
Use Extender License Screen to Insert a row for each Sage 300 user that needs to progress the workflow
or view outstanding workflow records.

Tip: Use the INS key on your keyboard to insert a new row

Note: You can enter users up to the number of workflow users you are licensed for. If you enter addi-
tional users, you will receive a "Too many users" error and your changes are not saved.

IF USING WORKFLOW ANYWHERE MOBILE APP
Select Yes in the "Is Workflow Anywhere" column.

Tip: Use the space bar to toggle between Yes and Blank

Upgrade Steps for Workflow Users
When upgrading from one Sage 300 version to another, make sure the previous version license is in the
Sage 300 Shared Data folder configured for the new version. When you activate Extender to upgrade it,
the users will be imported into the new version automatically.
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You can also use the "Import users from prior version" button.

Note: If the new license includes fewer users, the first x users will be imported, up to the number in the
current license.

Example:
If upgrading from Sage 300 version 2025 to Sage 300 version 2024

1. Copy the VI71A.lic file to the Shared Data folder if upgrading to a new server.

2. Activate Extender v2025. This will update the VI72A.lic file with the previously configured users

3. If the VI71A.lic file is not available when activating, you can copy the file after upgrading and use the
Import Users from Prior Version button.

WORKFLOW TEMPLATES
Workflows can be configured to approve new records, approve field changes in Sage 300 or start auto-
matically a series of actions to alert users when something happens in Sage 300.

Note:
Workflow is only available for flat views: Master files (e.g. A/R Customers), Transaction Header views
(e.g. O/E Header) or Batch Header view (e.g. A/P Invoice batch)

Workflow Types
A workflow template is a collection of named steps. Each step can have actions that are performed auto-
matically (e.g. send an email, run a script, wait, goto step). When the workflow requires a user decision to
progress to the next steps, you can use "Progress-to" Steps.

For detailed examples, see Extender Configurator Tutorials on page 21

A workflow can be started automatically

when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.

Approval workflows have two main design options:

1. When a field is updated, the workflow is configured to reset the field to its original value and will only
update it to the requested value when it is approved. See example in A/R Credit Limit Approval on
page 23

Page 128 of 222 Setting Up Extender Workflow



Extender

2. To approve records being inserted into Sage 300, the workflow needs to be configured to set the
record "on hold" or "Inactive" so that it cannot be used or progressed further until it is approved. see
example in O/E Orders Approvals on page 37

A workflow can be started manually

You can start a workflow manually from an icon on a Sage 300 screen.

The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users on page 125,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

See example Customer On-Hold Alert and Approval on page 31

Completing a workflow

A workflow is completed when it enters a step which completes the workflow. This is done by including
an action to "Complete the workflow" in the Step actions.

If the workflow is completed, the step name on the workflow console is blank.

If the workflow template has been configured to “Automatically delete when closed” then the Workflow
Instance will be deleted when a closing workflow step has been taken. The workflow History can be used
to view previously completed workflows.

Using the workflow
All workflow (completed and outstanding) are in the workflow history.

Outstanding workflows

A workflow instance is created for each running workflow. It includes fields such as what workflow tem-
plate it is using, the current step, the user who performed the step, the date/time the step was per-
formed, etc. It also has a list of key-values, for example customer, order number, etc.

A workflow instance has a STATUS field and a COLOR field. STATUS can be used by the scripts and is dis-
played in the workflow console. Status is updated through actions configured in the workflow templates.
The COLOR field can be used to colour the rows in the workflow screen (for example, urgent items could
be red).

Setup Workflow templates - Overview
Workflow templates include:

Steps
Progress-to Steps
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Actions
Values

WORKFLOW STEPS
A workflow step is a collection of actions taken when the workflow starts or is progressed. Each step
is recorded in the workflow log and can be viewed in the workflow history.

WORKFLOW ACTIONS
Actions control what each step of the workflow does. Extender Configurator includes a certain num-
ber of pre-defined actions.

For a list of actions, refer to Configurator Actions on page 177

To add a custom action, you need to be licenced for Extender Customizer or Developer edition and
upload a custom script to the database.

PROGRESS-TO STEPS
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Pro-
gress-to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.
For example, a “requires approval” step could progress to an "Approve” or a “Reject” step.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

WORKFLOW TEMPLATES - SCREEN GUIDE
Workflow templates include:

Steps
Progress-to Steps
Actions
Values

Tips:
Workflow templates grids are resizable.

You can click on the blue labels - it's the same as pressing F9 to view the details.
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Workflow template configuration
WORKFLOW TEMPLATES: FIELDS AND CONTROLS
TEMPLATE ID
Enter a unique workflow template ID. It cannot be changed after the template is created.

If using an Extender Module, make sure the workflow name starts with the module name.

DESCRIPTION

Enter a meaningful description.

ACTIVE

Select Yes to Activate the workflow.

If you need to select No to deactivate the workflow, make sure you complete existing open work-
flow instances first.

AUTO DELETE INSTANCE WHEN COMPLETE

Defaults to No.

Select Yes to delete the workflow instance when a closing workflow step has been taken. The
instance will only be deleted once the workflow log entry has been created. The workflow history
will remain available.

CAN START MANUALLY

Select Yes to start a workflow from a Sage 300 screen. This requires Orchid
Information Manager activated and configured.

User needs to be an Workflow User to start a workflow manually.

See example setup in Customer On-Hold Alert and Approval on page 31

Select No to start the workflow automatically

The workflow can only be started when a Sage 300 record is inserted or updated (as per View
Events and Scripts configuration).

See example setup in A/R Credit Limit Approval on page 23.

Note: In both cases, you can start a workflow in a custom Extender script, if using Extender Cus-
tomizer or Developer Edition.

CAN START MULTIPLE INSTANCES
This applies to manually started workflow only.
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a. “Yes” – then users can start the same workflow for the same key field multiple times.

Tip:
Can start multiple instances: Yes - If you want the workflow to behave differently if there is
an active pending workflow before a new one starts, use the "IfWorkflowExists" action.

b. “No” – do not allow them to start another instance. But no message.

c. “No with message” – do not allow users to start another instance and give them a message
“There is already a workflow instance for workflow template: {workflow template name} and {view
name} - {record key}

Warning!
When you select "No" or "No with Message", if you update a field/View configured with the
workflow template, and an existing workflow instance is active, the workflow is not
triggered.

This may disable controls you are implementing with this workflow where this workflow has an
active instance is active. USE WITH EXTREME CAUTION. Consider using the "IfWorkflowExists"
action and "Can start multiple workflow" = Yes

Workflow Steps
A workflow step is a collection of actions taken when the workflow starts or is progressed. Each step is
recorded in the workflow log and can be viewed in the workflow history.

The Previous step and next step are visible on the workflow Console.

WORKFLOW STEPS : FIELDS AND CONTROLS
Insert a new line for each Step of the workflow. Provide a Step Name, a description and select
whether the step is an "Entry Step".

Note: You can have more than one entry step in a workflow.

When attaching a workflow template to a View, you can choose the entry step. For

details, View Events, Scripts & WF on page 147

For each step, define Actions.

For steps where a user action is required (e.g. Approval), configure the Progress-to steps.

STEPS AND PARAMETERS
You can configure up to 4 optional parameters when you attach a workflow template to a View in
View Events and Scripts and when configuring the Progress-to Steps.
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Parameter 1 is to Parameter 4 is fields on the Steps setup section of the Workflow Template allow
you to describe how the parameters are used in the workflow.

Example: In the A/R Customer Credit Limit approval workflow, Parameter 1 is the maximum
amount a user can update the credit limit without approval, Parameter 2 is the amount above
which a manager's approval is required.

REASSIGN STEP-
Extender includes a default Reassign Step on the console where you can select a user/user group to
reassign the workflow.

You can design your own Reassign step with custom actions like "send email" - If found, it will be
added to the Console automatically, replacing the default step. You don't need to add it as a Pro-
gress-to Step.

Progress-to Steps
Progress-to steps are used when a user needs to select the next Step to progress the workflow. Progress-
to steps add Controls to the workflow console. If workflow screen icons are configured in
Information Manager, Progress-to steps can be run from the configured Sage 300 screen.

TO ADD PROGRESS-TO STEPS
Select a step and if required, add a row for each step that the workflow can progress to.

You can configure parameters that will be passed to the action when selected.

PROGRESS-TO STEPS AND WORKFLOW CONSOLE
On the workflow console, you will see the available steps depending on the current step that the
workflow instance.

e.g. Approve or Reject.

PROGRESS-TO STEPS AND WORKFLOW SCREEN ICONS
If you have configured workflow on Sage 300 screens in Information Manager, Progress-to steps can
be used from the screen icons.

Add screenshot/link to Infor manager setup

e.g. Approve or Reject.

Workflow Actions
Actions control what each step of the workflow does. Extender Configurator includes a certain number of
pre-defined actions.

For a list of actions, refer to Configurator Actions on page 177

Use F9 to view the details
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Click Insert on the grid or the New button on the F9 zoom screen to create a new action.

Tip: Ensure that each Step ends with a Complete action or a GoToStep Action.

ACTIONS : FIELDS AND CONTROLS
Action #

Type an Action number.

Tip: Leave some gaps in Action numbering to make ongoing maintenance easier. You can
use Renumber before inserting rows. See below.

Action Name

Select an Action.

This will refresh the fields required for each action.

The following actions are pre-configured in Extender Workflow.

An action is a Python script that is stored in the database just like regular user scripts.

Configurator includes a number of predefined actions. For details, refer to Configurator
Actions on page 177

To add a custom action, you need to be licenced for Extender Customizer or Developer edition
and upload a custom script to the database.

Complete Fields required for each action

The field labels on F9 Zoom and the grid headings are named after the parameters configured in the
Extender Script that defines the action.

Actions can have up to 4 parameters, as defined in the Action script.

Comment

Enter up to 250 characters to document how the action is configured.

PARAMETERS AVAILABLE FOR USE IN WORKFLOW ACTIONS.
Use the Help link on the detail action screen for details.

The following values are available to use in action parameters and email templates used in the Work-
flow.SendEmail action:

{$1}, {$2}, {$3}, {$4} - step parameters

{PROGRAM} ID of calling program (e.g. OE1100 = Order Entry)

{ROTOID} ID of the calling view (e.g. AR0024 = AR Customers)

{USER} current user (e.g. ADMIN)

{field} gets a value either from the workflow instance values, or from the target view.

Page 134 of 222 Setting Up Extender Workflow



Extender

{VIEW.field} gets a value from the target view

{VALUE.name} gets a workflow instance value

{VIEWID} the view ID for this workflow instance

{VIEWKEY} the record key for this workflow instance

{KEYDESC} the description for this workflow instance

{TOVALUE} the requested value for this workflow instance

{STATUS} the current status for this workflow instance

{COLOR} the colour for this workflow instance

{CURUSER} the user or group currently assigned for this workflow instance

{WTNAME} the workflow template name for this workflow instance

{STUSER} the user who started this workflow instance

{STEPNAME} the current step for this workflow instance

{PSTEPNAME} the previous step for this workflow instance

Formatting Numbers:

Append ':{required decimals}' to the field

E.G. {ORDTOTAL:2}

TRUE ACTION # AND FALSE ACTION #
True Action #: Enter the Action # that the workflow should perform next if the Action returns True

False Action #: Enter the Action # that the workflow should perform next if the Action returns False.

The True and False Action # control what actions will actually take place in the workflow depending
on the result of the Action script.

If you set the True and False Action # to 0, the workflow step will stop with that action.

Important! If an action number is not in a True or False value, they will never be used in the work-
flow.
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Example:
Using the Evaluate Action

The Evaluate action is used to compare a field to a pre-defined value (e.g. Credit Limit greater than
a certain amount or Customer Group being a specific value, Vendor name changed from original
value).

If the result of the comparison is false, you can go to Action # 50, Approve automatically. This
action would be configured as GoToStep "Approve".

If the result of the comparison is true, you want the workflow to do 3 actions, Action # 15, Action
#20 and Action #25.

RENUMBER
Use the Renumber to re-order the actions displayed on the screen. Extender will use the action num-
ber, add a gap of 10 so that you can insert new actions and renumber the True/False actions accord-
ingly.

STANDARD ACTION CONFIGURATION AND PARAMETERS REQUIRED.

Action Name Description Parameters

AssignUser
Assign to a Work-
flow User Group

Select a user group.

To configure a new user group, refer to
Workflow User Groups on page 93.

AssignUser
Assigns a user to
the workflow
instance

You can type a Sage 300 User ID, select
a value defined in the workflow or select
a value set in a parameter when attach-
ing the workflow to a view.

Type {USER} to assign workflow the cur-
rent user.

When you assign a workflow to a user
who is not configured as a Workflow
User, the AssignUser workflow action
returns an error. The next action is con-
figured in the False Action # field in the
Workflow Template.

Make sure the Workflow Template noti-
fies an Admin user and proceeds with
the rest of the workflow actions.
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Tip: You can add a Workflow Action to
assign the workflow to ADMIN if the first
AssignUser action returns False

AddParameter

Stores input col-
lected in the work-
flow

Parameters are
added to the Values
of the workflow

Name: can be used in other actions
(such as set field or sendEmail)

Parameters

Label: description user will see when
prompted

Type: 

Parameter types can be:

> text(size=xx)

> integer

> number.0 - e.g. 10.1

> number.00 - e.g. 10.12

> number.000 - e.g. 10.123

> user - a user or user group

> date

Default Value: Optional -

Parameter values (as entered by the user
) are saved as workflow values and avail-
able on the console.

Parameters can be added to email tem-
plates. Use {PARAMNAME} in the email
template.

AskForParameters

Step will stop at that
step and wait for
user input.

True Action should
be the action you
want to perform
when user has sub-
mitted the input.

No parameter.

Execution continues at the AskForPara-
meters True Action step #.

If the user selects "Cancel" on the UI, the
action returns False.

Tip: Configure the actions in the tem-
plate if you want different process flow
if a user enters input or clicks Cancel.

This action is not active when the work-
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flow is progressed through a script, for
example the Remote Action poller.

AssignColour

Assigns a color to
a workflow
instance in the
Workflow Consol-
e

Select a color using the Finder.

To configure colors, refer to Workflow
Colours on page 92

Complete

Action to ensure
that the action com-
pletes the workflow.

If Auto delete
instance when com-
plete is set to Yes on
the workflow, the
instance will be
deleted when the
Complete step is
successful

No Parameter.

When the workflow is complete, no fur-
ther processing happens.

The next step in the Console shows as
Blank

CreatePOfromReq
Create a PO from
a requisition

Requisition requires a vendor on
the Header. All lines must use the
same vendor. No parameters

Evaluate
Used to set con-
ditional workflow

Field, Operator, Value

If evaluating a Boolean field, use 1 for
True/Yes or 0 for False/No

Notes:
If the Field is set to {PROGRAM}, the
action will compare the RotoID of the
screen running the workflow to the
value defined in the Value parameter.

If you only want the workflow to do cer-
tain actions for certain users, you can
use Evaluate {USER} to use the logged
on user in the condition.

Gen-
erateAPPay-
mBatchListing

Runs and saves as
a PDF the
AP Payment Batch
listing report

For use in a workflow template to
approve AP Payment batches

See example in A/P Payment Batch
Approval on page 46
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GetOptField

Used to read
Optional Field
Value to use in
workflow

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400
for GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Workflow Value

GoToStep Go to another work-
flow step. Select Step name

IfWorkflowExists
Returns True if
there is a pending
workflow.

Can be used in the workflow template to
have different actions if the workflow is
Active.

Can also be used in View Events
and Scripts to make a field ReadOnly if
using Extender Customizer or Developer
Edition.

IfWorkflowUI

Returns True if
the workflow is
progressed on
the Console or
the workflow
screen icons.

Used in the workflow template to have
different branches if the step is used on
the console and in a script such as the
Remote Action Poller.

Users are generally not prompted for
parameters or displayed messages when
the workflow is progressed in a script.

IsDelete

Returns True if
the workflow is
part of a
DELETE view oper-
ation.

This only applies to Master file and
Transaction views.

When a batch is "Deleted", the status is
set to "Deleted", the Delete view oper-
ation is not run.

Tip: Use the Batch status field on the
Batch if you need to trigger a workflow
when a batch is deleted.

IsInsert

Returns True if
the workflow is
part of an
INSERT View oper-
ation

Can be used when a workflow is
attached to an UPSERT View operation
or a View Field.

This only applies to Master file and
Transaction views.

When a batch is "Inserted", the batch is
created immediately without running an
"INSERT" View operation.
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Tip: Use the Number of Entries field on
the Batch if you need to trigger a work-
flow when a batch is inserted (Number
of entries = 0)

IsUpdate

Returns True if
the workflow is
part of an
UPDATE View
operation (vs an
INSERT)

Can be used when a workflow is
attached to an UPSERT View operation
or a View Field.

You may have different actions when a
new ON HOLD order is inserted vs when
an existing order is updated to "On
hold"

IsUserMemberGroup

Return True if the
user configured in
Parameter 1 is
part of the Work-
flow User Group
in parameter 2

To use it for the logged on user,
you can use {USER} in Parameter 1

Reassign

Reasssign a user to
another user/group

Displayed in the
workflow console.

If there is no reassign step then the user
is prompted for the user/group to reas-
sign to, then the workflow user is set to
that user. If you have a step called "reas-
sign" in your workflow, the custom step
is run.

Example: If you want to send an email
when a workflow is reassigned, add your
own Reassign Step.

PostBkEntry PostBkEntry

The PostBkEntry posts the bank entry
configured in the Workflow Instance ID.
Use in a workflow template associated
with the Bank Entry View.

Approver needs rights to post Bank
Entry in Sage Security

PostBatch

PostAPAd-
justmentBatch

PostAPInvoiceBatch

PostAPPay-
mentBatch

The Post_Batch actions post the relevant
batch. Batch number entered as Para-
meter 1.

The approver needs rights to Post the
batch in Sage security.
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PostARAd-
justmentBatch

PostARInvoiceBatch

PostARReceiptBatch

PostARRefundBatch

PostGLBatch

ProvPostGLBatch

SendEmail

Sends an email to
the user / user
group or email
address con-
figured in Para-
meter 2.

Parameter 1 = Email template - You can
use the finder to select the message tem-
plate.

Parameter 2 = Email address or Sage
300 User or Workflow user group.

You can use {CURUSER} to send a noti-
fication to the user assigned to the work-
flow. Make sure the SendEmail Action is
after the AssignUser Action.

User
pro-
file
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Note:

In Parameter 2, enter a list of

email addresses separated by

a ;

You can add email addresses

(someone@company.com, a

Sage User ID or an Extender

workflow user

If selecting a Sage 300 user

(e.g. ADMIN), an email is sent

to the email address con-

figured in Sage 300 User pro-

file.

If selecting a Workflow user

group (e.g. APPROVERS), all

users in the group are sent an

email, to the email address

configured in Sage

You can combine email

addresses (e.g. someone@-

company.com) and user

groups

Example: someone@-
company.com;ADMIN;APPROVERS;
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Optional: CC, Subject (to overwrite email
template subject)

SendEmailAttachments
Sends an email
with an attach-
ment

Extender Message template - Can
include variables from the view the work-
flow is attached to

Email address configured in Parameter
2: refer to SendEmail action above.

Set the path and filename of the attach-
ment in a Workflow value and enter the
workflow value name in P4.

Ensure the path is set to UNC format
and the users have access to it.

SendEmailToStarter
Sends an email to
the user who star-
ted the workflow

Email template, CC, Subject

SetDescription

Sets the workflow
description for
use in Console
and workflow
logs.

You can use any string/word as well
as workflow and view variables.

SetDrilldown

SetDrilldown sets
a value to a Sage
300 view field to
enable Drilldown
from the console
to the underlying
Sage 300 screen.

Parameter 1 is the field name that is
used as the KEY field in the vid-
rilldown.ini file.

Parameter 2 is the value you want to set.

For example {IDCUST} for the customer
number from an ARCUS workflow.

For details, refer to Drilldown in work-
flow on page 188.

SetField

Sets a configured
field to a value.

Field can be any
field on the view
that the Workflow
will be attached to

Use Extender Extender View
Info on page 172 to identify
the Field name
e.g. AMTCRLIMIT for an
A/R Customer workflow
Add the field name between
curly brackets {}.
Use values defined in the
workflow or a set value (e.g. 1
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to set OnHold to true/se-
lected)

You can use {VIEWID}, {VIEWKEY},
{KEYDESC}, {TOVALUE} - these cor-
respond to the View ID, Record Key,
Description, and Requested Value
columns in the Workflow Console
screen.

Example: To prevent a change to the
credit limit, you use SetField to restore
the value to the previous value using
SetField and {ORIGINAL_AMTCRDLMT}

Note: You can update 2 fields with
SetField . This is useful when updating
SalesPerson and SalesPercentage on
OE Order.

SetOptField
Set an optional
field value

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400
for GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Optional Field Value

SetStatus

SetStatus will set
the status of a
workflow
instance. The
Status is shown
on the workflow
Console

P1 is the status you want to set to
the workflow instance. Displayed on
the console, on the workflow logs
and in the workflow reports.

SetValue

SetValue will add
a row to the work-
flow instance val-
ues grid.

Parameter 1 is the field name that you
want to give to the Value.

Parameter 2 is the value you want to
pass. It can be hard-coded, set to a
value defined in the workflow or set to
the View Field original or new value.

Use the field name between curly
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bracket to store the new amount (e.g.
{AMTCRDLMT}

P1 can be set to {VIEWID} and value
would be the Sage 300 View ID when a
workflow is started from a screen and
not attached to a view.

ShowUserError
Displays a Error to
the logged on user
on the Sage screen.

As above.

ShowUserMessage

Displays a Message
to the logged on
user on the Sage
screen.

Parameter 1: Text to display.

For details The message can include
Variables, such as Workflow fields or Val-
ues from the workflow.

Use an Evaluate action before using the
ShowUser actions to ensure that the
message is only showing when the view
is used on a Sage 300 screen.

field: "{PROGRAM}"

operator: "="

value: "AR1300" (RotoID of the screen
that should display a message).

ShowUserWarning

Displays a Warning
to the logged on
user on the Sage
screen.

As above.

Workflow Values
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

USING VALUES
if you use the SetValue Action, the workflow log will track the value for each step of the workflow
instance.

Values can be hard-coded in the workflow, set to View fields when the workflow is attached to a view
(e.g. {ORIGINAL_FIELDNAME} , or set in the workflow based on parameters configured on View
Events and Scripts.

You can also Values from workflow instance
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{VIEWID}, {VIEWKEY}, {KEYDESC}, {TOVALUE}, {STATUS}, {COLOR}, {CURUSER}.

Tips:

You can export and import workflow templates. Choose File Menu from the Workflow

Templates Screen. "Export" exports the currently selected template, "Export All"

exports all Workflow templates. Use Import and select the file with your workflow

template/s.

When importing workflow templates, you can only INSERT new templates, where the

Template ID doesn't exist in the database. The column WTID needs to be in the

Import file with any Integer value to link the workflow steps, actions, progress to

steps and values. It will be auto-assigned during the import to the next available

value.

You can also export Message Templates, User Groups and Colours.

LINK WORKFLOW TEMPLATE TO EXTENDER VIEW OR
SCREEN

To start a workflow automatically: 
You can attach a Workflow Template to a Sage 300 View operation and/or View field/fields. The work-
flow will start automatically when the view is used in Sage 300.

For details on how to add a workflow to a Sage 300 View, refer to View Events, Scripts & WF on the
facing page

when a view field is updated – you attach the workflow template to a View field.
the insert/update/upsert/delete operation on a Sage 300 view - the workflow template
is attached to a view operation.
by a Python script run on the Sage 300 desktop or attached to a Sage view.
by a Python script run using Process Scheduler.
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To start a workflow manually:
You can start a workflow manually from an icon on a Sage 300 screen.

The logged-on user has to be configured as a Workflow User. For details refer to Understanding Work-
flow Users on page 125,

You configure which screens can start workflow in Information Manager Setup > I/M Options.

Refer to Extender Workflow- Notes/DML/Extender Tray .

View Events, Scripts & WF
Use this form to add Extender events, custom scripts and workflows to Extender views and fields.

Select a Sage 300 View to be configured with Extender.

By clicking on the “All Views” info icon (or use F6 key) , you can select the appropriate view from the list
of available views, active in your Sage 300 database.

Fields and Controls

REMEMBER ORIGINAL VALUES FOR: 
You can determine what fields Extender need to track the original value for. This is particular useful
for email messages.

Leave blank if you don't need the original value in the Script, workflow or email messages.
You can enter the field names you need. For example, if you only need the original value for
the Description and the name, “DESC,NAMECUST”
Use * if you want Extender to make the original value available for all fields. This is useful if you
use the original values in a script, in email messages or in a workflow, but you don't want to list
all the fields you need in advance.

Setting Up Extender Workflow Page 147 of 222

../../../../../../Content/Extender/EBTray/Setup-Hotkey-Workflow.htm


Extender

Note: On some views that have many columns and that are opened many

times, e.g. the OE Shipment Header and OE Shipment detail view, using *

may have an impact on performance.

Tip:
You can also add code in the script to determine what fields the script needs the original value.

Refer to Scripts-AdvancedTips*

Events Tab

On the Events tab, you can attach an Event Type to an Extender View operation and/or View field/fields.

Requirement! The Events Tab is available if using Extender Levels Configurator, Customizer or
Developer

FIELD NAME

Select the appropriate view field from the list of available view fields. All view fields will be available,
including the following standard operations of a Extender view

Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

EVENT CODE

Select the appropriate Event Code from the list of available Event Types. on page 90
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Important!
If you need to log the Before and After Value, you need to make sure the event type you select has
been configured as "Don't Combine".

If you select the View Operation {INSERT}, {UPDATE} or {UPSERT}, the Before and After values will be
available if the event is configured as "Don't Combine". One record will be added to the LOG or
emailed for each field that is changed.

For the "Delete" action, only one record will be logged.

Refer to Event Types. on page 90

Scripts Tab

On the Scripts tab, you select the Python script to be run when the selected view is being updated. Mul-
tiple scripts can be selected, and are run in the order specified.

Requirement! The Scripts Tab is only available if using Extender Levels Customizer or Developer

ACTIVE

You can activate or deactivate a specific script without deleting it from the View

RUN ORDER

If multiple scripts have been defined, you can select the order in which they run by entering a num-
ber associated with each script. A script associated with Run Order 1 will run before a script asso-
ciated with Run Order 2 etc.

FILE NAME (F9 TO EDIT)

If you are uploading a new script, click F6 to browse and find the .PY file to attach to this view.
When selected the script will be

Copied to the associated COMPANY directory, and this is where the “.PY” file will be invoked
from
Imported into the database

If you are attaching a script which already exists in the database, click F9 to find the existing script,
and associate with the current view.

If you want to edit an existing script, click F9

STATUS

Shows blank or “Checked Out” if currently checked out. In order to check out a script for amend-
ment, you can right hand mouse button on the script row, and select Check Out. Once checked out
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you can open (to edit the script), and upload (to replace the existing script with the amended
script).

CHECKED OUT BY

User id who currently has the script checked out

Tip: Once you have uploaded a Script and it is active against a view, you can “check out” the
script to make changes to the script, to test the script while leaving the original script active. Once
you “check in” the script, the existing script will be replaced with the new script.

PARAMETER 1..PARAMETER 4

Your scripts can contain up to 4 parameters.

You can access the parameters in the Python script with the global variables Parameter1, Para-
meter2, Parameter3, Parameter4.

Note: The first few rows of the highlighted script will be shown to assist with the commenting and
verification of the attached scripts.

Tip: To check out, open, upload or Undo Checkout, right hand mouse button on the required script
and select the required action.

Important!
If you need to amend a script after it is attached to a view, you need to check it out, open it to make
the changes, save the script and check it in to enable the changes.

If the script is amended on a separate machine, you need to re-import the PYTHON script

When PYTHON scripts are attached to a view they are

1. Imported into the associated database, so the script will dump and load with the

database

2. Copied to the Company directory, where the PYTHON script is run - If you edit the

script directly in this directory, your changes might get overwritten.

OCX Scripts do not need to be added to a Sage 300 View. The script name matches the Sage 300
screen Roto ID to indicate that the script is enabled.

Workflow Tab
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On the Workflows tab, you can attach a Workflow Template to a Extender View operation and/or View
field/fields. The workflow will start automatically when the view is used in Sage 300.

You can use F9 to open the Workflow Template screen from the Screen.

FIELDS AND CONTROLS

Requirement! The WorkflowTab is available if using Extender Levels Configurator, Customizer
or Developer. If using Configurator, you can only use pre-configured actions in the workflow tem-
plate.

FIELD NAME

Select the appropriate view field from the list of available view fields. All view fields will be avail-
able, including the following standard operations of a Extender view

This allows you to attach a Workflow Template to

• Any field. If a field has an Active Workflow Template, the new value entered will be stored in
“{NEWVALUE}” and the original value reset before the record is saved. This new value will be
available in the workflow

• Insert/Update/Delete. The record will be saved and then the workflow will be started.

Delete : when a view record is deleted
Insert : when a view record is inserted
Update : when a view record is updated
Update and Insert <UPSERT>: when a view record is updated or inserted

ACTIVE

Set to No if you want to Deactivate an Event temporarily without deleting it.

WORKFLOW

Select the appropriate Workflow from the list of available workflow templates. Workflow Tem-
plates - Screen Guide on page 130

ENTRY STEP

Select the step that will be run when the field changes / view operation completes.

PARAMETER 1 TO 4

You can pass up to 4 parameters to the workflow.

To use the parameter value in the workflow, use the SetValue action. You can use {$1}, {$2}, {$3},
{$4} to set the value to a field.

For details and examples, Using Parameters in Workflow on page 187
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Important!
Workflow is only available for flat views: Master files (e.g. A/R Customers), Transaction Header views
(e.g. O/E Header) or Batch Header view (e.g. A/P Invoice batch)

Tip: View Events and Scripts can be exported and imported using the File Menu.

If you select Export, then only the current View configuration will be exported. The

export includes the attached events and scripts.

If you select Export All, then all the current View configurations will be exported. The

export includes the attached events and scripts for all configured views. The export

format is proprietary, and cannot be changed.

Note: Different options are available depending on the level of Extender you are running.

Extender Workflow- Notes/DML/Extender Tray
You configure an Extender Workflow row to add Workflow icons to a Sage 300 screen.

The icons allow Workflow User to start a workflow if it can be manually started, progress a workflow to
the next step if you are an approver, and view the workflow status and workflow history.

WORKFLOW ICONS EXPLAINED
Workflow icons only show if a workflow is configured on a specific field.

One or no workflow icon can be present per screen. Subject to Sage 300 security rights, you can use
the icons to view the workflow history.

Depending on the workflow configuration, you can also use the icons to start or progress the work-
flow.

Click to start manual workflow or view workflow history. There is no pending workflow.

Click to view active workflow. The pending workflow is not assigned to the logged on user.

Click to progress your active workflow. The workflow is assigned to the logged in user and wait-
ing for an action.
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Click to progress group active workflow. The workflow is assigned to a workflow user group
that the logged in user is part of. The workflow is waiting for an action from one of the group mem-
ber.

Note: If the workflow icons are not configured in Information Manager Options, users can run the
workflow Log reports to view workflow history. Workflow users can use the workflow console to
view and progress their active workflows.

Configure Tray

Select Extender Workflow Note Type -Alert Based on Extender Script (For further details on note type,
view below)

Fields and Controls

ROTOID - UNIQUE ID FOR EACH SCREEN
Enter the RotoID of the screen that should display the Extender Workflow Icons.

Example: Enter RotoID AR1300 to display a A/R Customer workflow on the A/R Customer screen.

Tip: To know what RotoID/Field label to use, start the appropriate Sage 300 Screen (for example
AR Customers) then Right hand mouse click on the Information Manager Tray Icon (the key). Now,
as you click on fields in the Sage 300 Screen - the Infoset Hotkey Setup shows you the RotoID and
Field Name.

Setting Up Extender Workflow Page 153 of 222



Extender

FIELD LABEL
Enter the field label from the Sage 300 screen which is to trigger the display of the Extender Work-
flow icons.

If the Field Label is entered with quotes, e.g. "PY", Information Manager will use the hard coded value
in addition to the value set in the Second Field Label.

Important!
1. The same field may have different labels on different screens. See Example 1 below

2. The same field label may be used on the Header and Grid component of the same screen. See
Example 2 below. Adding "F."to the field label forces it to use the field control and "G." forces it to
use the grid control.

Examples:
1. In AR Receipt Entry there are two Document Number fields - one on the header and one in the
grid. To force the tray to use the correct one, you should use "F.DOCUMENT NUMBER" for the
screen label or "G.DOCUMENT NUMBER" for the grid field label. .

2. If you want the same list of documents to show on both the AR Customer Screen and the AR Cus-
tomer Inquiry, you need to add two rows in the IM Setup\Options on the Notes/DML/Extender
Tray tab. One for the Field Label “CUSTOMER NUMBER” and one for the Field Label “CUSTOMER
NO.”

SECOND FIELD LABEL
Enter the second field label from the Sage 300 screen which is to trigger the display of the Extender
Workflow icons. If entered, then the document list will displayed for Field 1 = Field label and Field 2 =
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Second Field Label.

Second Field Label is optional and is configured in the same manner as the Field Label.

EXTENDER WORKFLOW
Browse to select the Extender Workflow template to be added to the Sage 300 screen.

The workflow needs to be attached to a Sage 300 view that is related to the screen the icon is
attached to.

WORKFLOW ENTRY STEP
If the workflow template "Can be started manually" is set to "Yes", select an Entry Step. This will
enable users to start the workflow manually from the screen.

If the workflow template "Can be started manually" is set to "No", don't select an entry step. Th work-
flow will be started automatically if configured in View Events and Scripts and you can view the Work-
flow Log and progress the workflow from the screen.

Examples

Example:
A/R Customer workflow on A/R Screens

If you have an A/R Credit Limit approval workflow, you can add the icons to selected screens: 

A/R Customer Screen- RotoID = AR1300 and Field Label = Customer Number

A/R Customer Inquiry screen - RotoID = 1700, and field label = Customer No
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Example:
A/P Payment Batch workflow on A/P Payment batch screen

The A/P Payment batch view has a multi-part key, including the Batch Type and the Batch Number. The
workflow key is set to PY,Batch number, so the Information Manager configuration needs to include 2
fields as shown below.

Field 1 should be set to "PY" (with quotes) and field 2 set to BATCH NUMBER.

Requirement!
Selecting this option requires Orchid Extender and Information Manager to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. For details on functionality
and licensing method, refer to Understanding Workflow Users on page 125

Note:
If the Information Manager Tray is not started, the icons will not show and the user will not be able to
use the workflow icons to start or progress the workflow.

However, workflows attached to view operation or view field changes will be started and users con-
figured as Understanding Workflow Users on page 125 are able to access the Workflow Console.

You can start the tray manually in Information Manager > Tray Icon.

Using Extender Workflow
Once Extender is configured, you use it by interacting with the Sage 300 screens and views.

Many workflows are started automatically when a view field is updated or a record is inserted.

Page 156 of 222 Using Extender Workflow



Extender

To start a workflow manually: 157
Progress Workflow on the Workflow Console 157
Using Icons on Sage 300 screens 157
Progressing Workflow Outside of Sage 300 158
Workflow History 158
Using Workflow Console 158
Workflow Detail Log 162
Workflow Summary Log 163
Print Workflow History Log Report 165
Using Extender Tray Icons 166

TO START A WORKFLOW MANUALLY: 
Set "Can start manually?" = Yes on Workflow template
Add an Extender Workflow record in I/M Setup > Notes/DML/Extender Tray for the
screen where you need to add an icon to start the workflow
Open the Sage screen as a user marked as " Workflow User" , click on the Workflow
icon on the screen .
Select "Start ... (workflow name)"

Requirement!
To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 125

PROGRESS WORKFLOW ON THE WORKFLOW CONSOLE
To navigate through the workflow records, approve or reject requests and drill down to Sage 300
screens, you can use the Workflow Console.

For details on the Console, Using Workflow Console on the next page.

Requirement!
To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 125

USING ICONS ON SAGE 300 SCREENS
You can also use tray Icons configured on the Sage 300 screens in Information Manager I/M Options.

For details, Extender Workflow- Notes/DML/Extender Tray (IM Options)
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Requirement!
Information Manager needs to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 125

PROGRESSING WORKFLOW OUTSIDE OF SAGE 300

Using Remote Action Service
This enables Workflow Users to use a one-time link in a notification email to progress a workflow without
needing to be logged in to Sage 300.

For details, refer to Remote Action Service : Progress Extender Workflow remotely on page 207

Requirement!
Requires an additional subscription to Remote Action Service

To use the functionality, a user needs to be flagged as a Workflow User. Understanding Workflow
Users on page 125

Note: Workflow Users do not need to use a Sage 300 license if their only interaction with Extender
Workflow will be via the Remote Action Service.

Using Workflow Anywhere
Workflow Anywhere provides an Extender Workflow Console for your mobile device.

Requirement! To use the Workflow Anywhere App, a user needs a Workflow User license and a Work-
flow Anywhere User license. A Sage 300 license is required when the user refreshes the data on the
App or progresses the workflow.

For details, refer to Workflow Anywhere Overview

WORKFLOW HISTORY
Workflow logs are available to users based on security setup.

Refer to Workflow Detail Log on page 171

USING WORKFLOW CONSOLE
Requirement! You need to be a Workflow User to open this screen. Refer to Understanding Workflow
Users on page 125
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The Workflow Console displays workflow instances. A workflow instance is created when a workflow is
started. It is updated when workflow steps are run.

It includes fields relating to the workflow template it is using, the current step, the requested value for
workflow requiring a specific field approval, etc. It also has a list of key-values, for example customer,
order number, etc.

The Console lets you progress the workflow to the next steps if you have the appropriate security rights.

Console and Security Groups
The Console screen lets you see all active workflows if you have the “View All Workflow Instances” secur-
ity group , or just those assigned you or to a group which you are a part of.

Refer to Adding Security on page 120.

Note: Unassigned shows workflows assigned to a Sage user or user group that is not configured in
Workflow Users in Extender Licence

Tip: If you use a Workflow button when you are not assigned to the workflow and don't have "Modify
All workflow instances" security group, you will get a security error message and the workflow will not
progress.

how to use console grid
FILTERING THE CONSOLE
You can filter by up to 5 colors on the console. To configure colors on the console, refer to Workflow
Colours on page 92

You can also use CTRL F to filter on any fields.

Select the Template column on a row on the console, use CTRL-F and select Template = "AR Credit
Limit workflow". This will display only Workflow records for the AR Credit Limit workflow.

You can use CTRL -F > Clear filter to remove all filters and view all records.

FIELDS ON CONSOLE
Template ID: Set when the instance is started

Tip: Double click on the Template name to open the workflow template screen if you have security
rights to Edit Workflow setup. For details, Workflow Templates - Screen Guide on page 130

Started On: Date when instance started

Started At: Time when instance started

Started By: User who started the workflow (manually or through a View operation)

Assigned To: User or user group currently assigned to the workflow.
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View ID: Populated automatically by the workflow if it is attached to a View in View Events and
Scripts, or populated using SetValue in the workflow template.

Record Key: populated by Key field for the record subject to the workflow (can be a Customer num-
ber, an Order Number, a Batch Type and Batch number combination

Description*: Configured in the workflow template.

Requested Value: This is populated automatically when the workflow is attached to a specific field in
View Events and Scripts.

You can use SetValue action, Value field = {TOVALUE}, value = {VIEWFIELD} such as ORDTOTAL when
the workflow is attached to a View operation such as UPDATEor INSERT

Step: Shows the current step the workflow is on. If there are Progress-to steps defined for this step,
you will see a custom button for each step defined as Progress-to.

Status*: Configured in the workflow template.

USE CTRL F TO FILTER ON ANY FIELDS.
Select the Template column on a row on the console, use CTRL-F and select Template = "AR Credit
Limit workflow". This will display only Workflow records for the AR Credit Limit workflow.

You can use CTRL -F > Clear filter to remove all filters and view all records.

how to use console buttons
You can progress a workflow to another step. So the buttons you can see on the console depend on
what row /Workflow instance you are looking at and how the workflow is configured.

All workflows will have some default buttons:

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 188

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

HISTORY
Use the History button to view details of previous actions on the workflow record selected on the con-
sole.

VALUES
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Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

Typically, values are used to store the original value, the new value, the cut off limit.

REASSIGN STEP: 
Use this button to reassign a workflow to another user or user group.

If you have added a Reassign Step in the workflow template, the Reassign Step will include the con-
figured actions instead of the default one.

DELETE:
Use this button to remove a workflow instance from the console.

If the workflow is configured to "Auto-delete when complete", this will delete the workflow instance
from the console and the Workflow log will be updated.

If the workflow is NOT configured to "Auto-delete when complete", this will update the workflow
instance to clear the next step to complete the workflow. No specific actions will be taken by that
action. You can use DELETE again to remove the instance from the console.

NOTE ON COMPLETED WORKFLOWS
When a workflow is complete (the instance has been through a "Complete" Action), the step name
on the console is blank.

Many workflow templates are setup as "Auto-delete instance when complete". This option deletes
completed workflow from the console.

If the instance is deleted when the workflow is complete, the workflow log keeps the audit trail of pre-
vious workflow instances. Go to Extender Inquiries > Workflow Summary Log or Workflow Detail Log
to view workflow history that have been deleted from the console.

Refer to Workflow Summary Log on page 169 or Workflow Detail Log on page 171

workflow template configuration and console layout
Refer to Workflow Templates - Screen Guide on page 130 and Configurator Actions on page 177 for
details. It is recommended practice to include the actions below in all steps of the workflow templates to
make the console and workflow history log clearer and suited to your business practice.

DESCRIPTION
Use the SetDescription action in the workflow template to set the Workflow Status in the console and
in the workflow log depending on what step of the workflow you are in.

STATUS
Use the SetStatus action in the workflow template to set the Workflow Status in the console and in
the workflow log depending on what step of the workflow you are in.
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ROW COLOURS
You can configure the workflow using the AssignColour action to assign a colour in the console
depending on what step of the workflow you are in.

WORKFLOW DETAIL LOG
This screen lets you view the workflow detail log, including all steps each workflow instance has followed.

Every time a step is run, an entry is made in the workflow log table.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.

FILE MENU TO CHANGE SORT ORDER.
Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE DETAIL LOG
Clicking Values will show the values associated with this log entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.

The workflow status is updated when the SetStatus action is included in a workflow step as per the
workflow template configuration. It is recommended practice to ensure each step in the workflow
includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Log buttons
REFRESH
Use this button to refresh the details on the screen.
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For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 188

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

Typically, values are used to store the original value, the new value, the cut off limit.

WORKFLOW SUMMARY LOG
This screen lets you view the workflow summary log, including users who started the workflow and date
when the workflow was started.

Every time a workflow is started, an entry is made in the workflow summary log table. The latest step and
latest workflow status are updated when the workflow progresses through the various steps.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.

Tip: Double click on the Template name to open the workflow template screen if you have security
rights to Edit Workflow setup. For details, Workflow Templates - Screen Guide on page 130

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

FILE MENU TO CHANGE SORT ORDER.
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Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE SUMMARY LOG

The Summary Log shows the Step that the workflow is on and the last status update.

Clicking Details will show the detailed steps associated with the selected workflow entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.

Note: The workflow status is updated when the SetStatus action is included in a workflow step as
per the workflow template configuration. It is recommended practice to ensure each step in the
workflow includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Summary Log buttons
REFRESH
Use this button to refresh the details on the screen.

For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 188

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

DETAIL LOG
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Use the Detail Log button to view details of previous actions on the workflow record selected on the
console.

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

PRINT WORKFLOW HISTORY LOG REPORT
Open Extender > Extender Reports > Workflow History Logs.

Select the default report or Browse to find a custom report.

Tip:
Extender includes one default report VIWFHistLog.rpt. You can duplicate the report, rename it and use
Crystal Reports to create your own report.

Make sure it includes the same parameters as the default report if you want to run it from the Extender
screen.

REPORT PARAMETERS
From and To Workflow ID: used to identify the range of Workflow templates to include on the
report.

From Step/To Step: Enter Steps to filter by in the report. Refer to the workflow template for the step
name.

Filter by Step refer to the "Step Name" as per the Workflow Detail Log Inquiry screen.

From Date/ To: field to identify the range of events to be included on the report

From User /To: to restrict the range of events to a single user. If left blank, all users will be included
on the report

From Record Key / To: Enter the Key fields you need the report to filter by. Refer to the Inquiries >
Workflow Summary Log

Show Details: 

Select Yes to include all steps that the workflow instances have been through.

Select No: The report will only include one row per workflow instance, including the latest step and
status.
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Note:
If the report "Show Details" is set to "Yes", the User refer to the user who performed the workflow
step and the date is the date/time when the workflow step was performed.

If the report "Show Details" is set to "No", the user refers to the user who started the workflow and
the date is the date the workflow was started.

USING EXTENDER TRAY ICONS
If configured in Information Manager and you are setup as a Workflow User, you can use icons on the
Sage 300 screens to start a workflow, progress an existing workflow or view workflow history.

Refer to Workflow Icons Explained on page 176 for a detailed description of the icons.
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Extender Inquiries and Reports

Inquiries for Extender 167
Reports for Extender 174

INQUIRIES FOR EXTENDER
You use the icons in the Extender Inquiries folder to:

Review the View records inserted, updated and deleted and the View fields amended –
for those views which have had Log events attached to them. The date/time and user id
of the user who did the amendment is logged, together with the actual change.
(Choose Logs)
Use View Info to explore all the views per Sage 300 Module activated in the current
database, together with the associated fields for the views. (Choose View Info)

Log Inquiries.
The Log form lets you view the changes to the views that have been configured to be logged.

You can filter the data by:

Date range
View ID
Field
User id
Range of User Ids

Use [Ctrl F] in any of the columns to filter the log contents by the selected column.

The current filter is shown along the bottom of the screen, and is saved per user per screen.

Tip: You can apply a filter on multiple columns by first clicking [Ctrl] on the first column required and
applying the filter, and then by clicking [Ctrl] on the second column required and applying the filter.

Tip: If the filter is not cleared prior to closing the screen, it will be remembered and re-applied the next
time the same user opens the same screen.
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Tip:
You can view the Log for a particular view in the original screen. For example if you want to view the
changes made to the Customer view from the Customer entry screen, highlight any text field and enter
` (back tick) and [tab]and the Extender Log will be displayed, filtering on the appropriate View. An
example of a text field on the Customer screen on the processing tab is the Credit Bureau Information
Rating field or the Credit Bureau Information Number field. Other examples are the Address fields on
the Address tab.

`[tab] cannot be entered on a date, a number, a check box field or a lookup field with a mask on what
can be typed in the field. If the text field already has information – for example the Customer name,
you need to select all the text (highlight it), then type `[tab] – the VI Log will be displayed and the ori-
ginal text restored to the field.

If you are using Information Manager and have licences for Workflow Users, you can configure an icon
on the Sage 300 screen to view the Logs.

For details, refer to Extender LOG- Notes/DML/Extender Tray on page 199.

EXTENDER LOG - FIELD LIST
DATE
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The date the change was made

TIME

The time the change was made

VIEW ID

The View ID that was changed

CHANGE NUMBER

The number of changes done in the same event at the same time

USER ID

The Sage 300 user id who made the change

KEY

The key value of the view that was changed

FIELD NAME

The view field name that was changed

OLD VALUE

The original value of the View Field prior to being changed

NEW VALUE

The new value of the View Field after the change was done

Workflow Summary Log
This screen lets you view the workflow summary log, including users who started the workflow and date
when the workflow was started.

Every time a workflow is started, an entry is made in the workflow summary log table. The latest step and
latest workflow status are updated when the workflow progresses through the various steps.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.
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Tip: Double click on the Template name to open the workflow template screen if you have security
rights to Edit Workflow setup. For details, Workflow Templates - Screen Guide on page 130

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

FILE MENU TO CHANGE SORT ORDER.
Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE SUMMARY LOG

The Summary Log shows the Step that the workflow is on and the last status update.

Clicking Details will show the detailed steps associated with the selected workflow entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.

Note: The workflow status is updated when the SetStatus action is included in a workflow step as
per the workflow template configuration. It is recommended practice to ensure each step in the
workflow includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Summary Log buttons

REFRESH
Use this button to refresh the details on the screen.

For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
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When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 188

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

DETAIL LOG
Use the Detail Log button to view details of previous actions on the workflow record selected on the
console.

Tip:
You can double click on columns in the Summary Log to open the Details Log screen.

Use the Values button on the Details Log to view values configured in the workflow for each step.

Workflow Detail Log
This screen lets you view the workflow detail log, including all steps each workflow instance has followed.

Every time a step is run, an entry is made in the workflow log table.

HOW TO USE
Use CTRL F to filter by any columns on the screen.

If you want to find all "AR Credit Limit" workflow steps, select the Template ID Column, CTRL F, and
select the Template you want to filter by. You can then add other filter criteria by selecting a new
column and selecting CTRL F again.

FILE MENU TO CHANGE SORT ORDER.
Use the File Menu to change the Sort order, based on the workflow Start Date/Time.

Sort Oldest Record First
Sort Newest Record First

WHAT IS INCLUDED IN THE DETAIL LOG
Clicking Values will show the values associated with this log entry.

If the Last Step is blank, it generally means the workflow is completed as there are no more steps to
follow.
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The workflow status is updated when the SetStatus action is included in a workflow step as per the
workflow template configuration. It is recommended practice to ensure each step in the workflow
includes a "SetStatus" action to make the log easier to read at a glance.

The Description in the workflow log is set using the SetDescription action in the Workflow Template
configuration.

SECURITY GROUP
Need View Workflow logs security group

Workflow Log buttons

REFRESH
Use this button to refresh the details on the screen.

For example, if new workflow have been started, progressed or completed since you opened the
screen.

DRILL DOWN
When configured in the workflow template, each workflow instance allows drilling down to a Sage
300 screen– for example, you could drill down to the customer, or to the order.

A workflow instance has a list of values associated with it – for example, a customer number or an
order number. Drill down works on this list of values. Refer to details in Drilldown in workflow on
page 188

Example:
If the workflow has a value called IDCUST then drill down to the AR Customer screen will be
enabled for the workflow.

VALUES
Values are variables that can be defined in the Workflow templates and used in the Workflow actions.
Such values are included in the workflow history Log file.

Typically, values are used to store the original value, the new value, the cut off limit.

Extender View Info
When this screen first opens, the program will scan for all the currently installed and activated modules
in the open company and show them in the left hand window. A program group per active module will
be created.

Open details for a view
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Click on the plus sign (+) beside the relevant program group, a list of all the views will be displayed, sor-
ted in view ID order.

Double click on the required view, the list of available view fields will be displayed in the right hand win-
dow.

You can also right click on it and select Open in New Window, or Export the selected view to a Text file.

Use view details
If you want to copy this text, right click or press Ctrl-C.

This is useful to copy and paste the field names to Extender setup screens or scripts.

Any one of these views can be included in the View Events and Scripts screen.
Any one of the view fields will be available for use in the attached PYTHON 3 scripts that are writ-
ten for this view.
Fields can be included in message templates and Extender workflow templates.

Tip: You can press F5 to open a finder for the selected view and see the records in the database.

Shortcuts to Find views and fields
Using the Find field at the bottom of the screen, you can enter:

!rotoID - open specified view, e.g. !IC0310, !ICITEM will open the I/C Item view

!!rotoID - open specified view in a new window

#text - find specified text in current view

text - find specified text in current view, or find a view with that text in the name

Extender Inquiries and Reports Page 173 of 222



Extender

ATTRIB COLUMN LEGEND
R = Required

K = Key field

E = editable

A = enabled

C = calculated field

T = type changes

P = presentation list/mask changes

X = editable changes

REPORTS FOR EXTENDER
You use the icon in the Extender Reports folder to:

Print the View records inserted, updated and deleted and the View fields amended – for
those views which have had Log events attached to them. The date/time and user id of
the user who did the amendment is logged, together with the actual change. (Choose
Print Logs)
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Print Log
1. Open Extender > Extender Reports > Print Logs
2. Use the From Date/ To field to identify the range of events to be included on the report

3. Use the View id to restrict the range of events to a single view. If left blank, all views will
be included on the report

4. Use the Field id to restrict the range of events to a single field. If left blank, all fields will
be included on the report

5. Use the User id to restrict the range of events to a single user. If left blank, all users will
be included on the report

6. Use the User id from/To field to identify the range of users to be included on the report

Print Workflow History Log Report
Open Extender > Extender Reports > Workflow History Logs.

Select the default report or Browse to find a custom report.

Tip:
Extender includes one default report VIWFHistLog.rpt. You can duplicate the report, rename it and use
Crystal Reports to create your own report.

Make sure it includes the same parameters as the default report if you want to run it from the Extender
screen.

REPORT PARAMETERS
From and To Workflow ID: used to identify the range of Workflow templates to include on the
report.

From Step/To Step: Enter Steps to filter by in the report. Refer to the workflow template for the step
name.

Filter by Step refer to the "Step Name" as per the Workflow Detail Log Inquiry screen.

From Date/ To: field to identify the range of events to be included on the report

From User /To: to restrict the range of events to a single user. If left blank, all users will be included
on the report
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From Record Key / To: Enter the Key fields you need the report to filter by. Refer to the Inquiries >
Workflow Summary Log

Show Details: 

Select Yes to include all steps that the workflow instances have been through.

Select No: The report will only include one row per workflow instance, including the latest step and
status.

Note:
If the report "Show Details" is set to "Yes", the User refer to the user who performed the workflow
step and the date is the date/time when the workflow step was performed.

If the report "Show Details" is set to "No", the user refers to the user who started the workflow and
the date is the date the workflow was started.

Workflow Technical Info

Workflow Icons Explained 176
Configurator Actions 177
Using Parameters in Workflow 187
Drilldown in workflow 188
Workflow Best Practices Tips 192
Writing custom actions for Workflow 195

WORKFLOW ICONS EXPLAINED
Workflow icons only show if a workflow is configured, the user is configured as a Workflow User, and
the Information Manager tray is started.

To setup workflow icons in Sage 300 screens, refer to Extender Workflow- Notes/DML/Extender Tray

One or no workflow icon can be present per screen. Subject to Sage 300 security rights, you can use the
icons to view the workflow history.

Depending on the workflow configuration, you can also use the icons to start or progress the workflow.

Click to start manual workflow or view workflow history. There is no pending workflow.

Click to view active workflow. The pending workflow is not assigned to the logged on user.

Click to progress your active workflow. The workflow is assigned to the logged in user and waiting
for an action.

Page 176 of 222 Workflow Technical Info

../../../../../../Content/Extender/EBTray/Setup-Hotkey-Workflow.htm


Extender

Click to progress group active workflow. The workflow is assigned to a workflow user group that
the logged in user is part of. The workflow is waiting for an action from one of the group member.

Note: If the workflow icons are not configured in Information Manager Options, users can run the
workflow Log reports to view workflow history. Workflow users can use the workflow console to view
and progress their active workflows.

Note:
If the Information Manager Tray is not started, the icons will not show and the user will not be able to
use the workflow icons to start or progress the workflow.

However, workflows attached to view operation or view field changes will be started and users con-
figured as Understanding Workflow Users on page 125 are able to access the Workflow Console.

You can start the tray manually in Information Manager > Tray Icon.

CONFIGURATOR ACTIONS

Action Name Description Parameters

AssignUser
Assign to a Work-
flow User Group

Select a user group.

To configure a new user group, refer to
Workflow User Groups on page 93.

AssignUser
Assigns a user to
the workflow
instance

You can type a Sage 300 User ID, select a
value defined in the workflow or select a
value set in a parameter when attaching
the workflow to a view.

Type {USER} to assign workflow the cur-
rent user.

When you assign a workflow to a user
who is not configured as a Workflow User,
the AssignUser workflow action returns an
error. The next action is configured in the
False Action # field in the Workflow Tem-
plate.

Make sure the Workflow Template noti-
fies an Admin user and proceeds with the
rest of the workflow actions.
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Tip: You can add a Workflow Action to
assign the workflow to ADMIN if the first
AssignUser action returns False

AddParameter

Stores input col-
lected in the work-
flow

Parameters are
added to the Values
of the workflow

Name: can be used in other actions (such
as set field or sendEmail)

Parameters

Label: description user will see when
prompted

Type: 

Parameter types can be:

> text(size=xx)

> integer

> number.0 - e.g. 10.1

> number.00 - e.g. 10.12

> number.000 - e.g. 10.123

> user - a user or user group

> date

Default Value: Optional -

Parameter values (as entered by the user )
are saved as workflow values and avail-
able on the console.

Parameters can be added to email tem-
plates. Use {PARAMNAME} in the email
template.

AskForParameters

Step will stop at that
step and wait for
user input.

True Action should
be the action you
want to perform
when user has sub-
mitted the input.

No parameter.

Execution continues at the AskForPara-
meters True Action step #.

If the user selects "Cancel" on the UI, the
action returns False.

Tip: Configure the actions in the template
if you want different process flow if a user
enters input or clicks Cancel.

This action is not active when the work-
flow is progressed through a script, for
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example the Remote Action poller.

AssignColour

Assigns a color to
a workflow
instance in the
Workflow Console

Select a color using the Finder.

To configure colors, refer to Workflow Col-
ours on page 92

Complete

Action to ensure that
the action completes
the workflow.

If Auto delete
instance when com-
plete is set to Yes on
the workflow, the
instance will be
deleted when the
Complete step is suc-
cessful

No Parameter.

When the workflow is complete, no fur-
ther processing happens.

The next step in the Console shows as
Blank

CreatePOfromReq
Create a PO from a
requisition

Requisition requires a vendor on the
Header. All lines must use the same
vendor. No parameters

Evaluate
Used to set con-
ditional workflow

Field, Operator, Value

If evaluating a Boolean field, use 1 for
True/Yes or 0 for False/No

Notes:
If the Field is set to {PROGRAM}, the
action will compare the RotoID of the
screen running the workflow to the value
defined in the Value parameter.

If you only want the workflow to do cer-
tain actions for certain users, you can use
Evaluate {USER} to use the logged on user
in the condition.

Gen-
erateAPPaymBatchListing

Runs and saves as
a PDF the
AP Payment Batch
listing report

For use in a workflow template to
approve AP Payment batches

See example in A/P Payment Batch
Approval on page 46

GetOptField
Used to read
Optional Field

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
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Value to use in
workflow

PO Header Optional Fields or G/L0400 for
GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Workflow Value

GoToStep Go to another work-
flow step. Select Step name

IfWorkflowExists
Returns True if
there is a pending
workflow.

Can be used in the workflow template to
have different actions if the workflow is
Active.

Can also be used in View Events
and Scripts to make a field ReadOnly if
using Extender Customizer or Developer
Edition.

IfWorkflowUI

Returns True if the
workflow is pro-
gressed on the
Console or the
workflow screen
icons.

Used in the workflow template to have dif-
ferent branches if the step is used on the
console and in a script such as the
Remote Action Poller.

Users are generally not prompted for para-
meters or displayed messages when the
workflow is progressed in a script.

IsDelete

Returns True if the
workflow is part of
a DELETE view
operation.

This only applies to Master file and Trans-
action views.

When a batch is "Deleted", the status is
set to "Deleted", the Delete view oper-
ation is not run.

Tip: Use the Batch status field on the
Batch if you need to trigger a workflow
when a batch is deleted.

IsInsert

Returns True if the
workflow is part of
an INSERT View
operation

Can be used when a workflow is attached
to an UPSERT View operation or a View
Field.

This only applies to Master file and Trans-
action views.

When a batch is "Inserted", the batch is
created immediately without running an
"INSERT" View operation.
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Tip: Use the Number of Entries field on
the Batch if you need to trigger a work-
flow when a batch is inserted (Number of
entries = 0)

IsUpdate

Returns True if the
workflow is part of
an UPDATE View
operation (vs an
INSERT)

Can be used when a workflow is attached
to an UPSERT View operation or a View
Field.

You may have different actions when a
new ON HOLD order is inserted vs when
an existing order is updated to "On hold"

IsUserMemberGroup

Return True if the
user configured in
Parameter 1 is part
of the Workflow
User Group in para-
meter 2

To use it for the logged on user, you
can use {USER} in Parameter 1

Reassign

Reasssign a user to
another user/group

Displayed in the
workflow console.

If there is no reassign step then the user is
prompted for the user/group to reassign
to, then the workflow user is set to that
user. If you have a step called "reassign"
in your workflow, the custom step is run.

Example: If you want to send an email
when a workflow is reassigned, add your
own Reassign Step.

PostBkEntry PostBkEntry

The PostBkEntry posts the bank entry con-
figured in the Workflow Instance ID. Use
in a workflow template associated with
the Bank Entry View.

Approver needs rights to post Bank Entry
in Sage Security

PostBatch

PostAPAd-
justmentBatch

PostAPInvoiceBatch

PostAPPay-
mentBatch

PostARAd-
justmentBatch

The Post_Batch actions post the relevant
batch. Batch number entered as Para-
meter 1.

The approver needs rights to Post the
batch in Sage security.
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PostARInvoiceBatch

PostARReceiptBatch

PostARRefundBatch

PostGLBatch

ProvPostGLBatch

SendEmail

Sends an email to
the user / user
group or email
address con-
figured in Para-
meter 2.

Parameter 1 = Email template - You can
use the finder to select the message tem-
plate.

Parameter 2 = Email address or Sage 300
User or Workflow user group.

You can use {CURUSER} to send a noti-
fication to the user assigned to the work-
flow. Make sure the SendEmail Action is
after the AssignUser Action.

User
pro-
file
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Note:

In Parameter 2, enter a list of

email addresses separated by a

;

You can add email addresses

(someone@company.com, a

Sage User ID or an Extender

workflow user

If selecting a Sage 300 user

(e.g. ADMIN), an email is sent

to the email address configured

in Sage 300 User profile.

If selecting a Workflow user

group (e.g. APPROVERS), all

users in the group are sent an

email, to the email address con-

figured in Sage

You can combine email

addresses (e.g. someone@-

company.com) and user groups

Example: someone@-
company.com;ADMIN;APPROVERS;

Optional: CC, Subject (to overwrite email
template subject)

SendEmailAttachments Sends an email Extender Message template - Can include
variables from the view the workflow is
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with an attach-
ment

attached to

Email address configured in Parameter
2: refer to SendEmail action above.

Set the path and filename of the attach-
ment in a Workflow value and enter the
workflow value name in P4.

Ensure the path is set to UNC format and
the users have access to it.

SendEmailToStarter
Sends an email to
the user who star-
ted the workflow

Email template, CC, Subject

SetDescription

Sets the workflow
description for use
in Console and
workflow logs.

You can use any string/word as well
as workflow and view variables.

SetDrilldown

SetDrilldown sets
a value to a Sage
300 view field to
enable Drilldown
from the console
to the underlying
Sage 300 screen.

Parameter 1 is the field name that is used
as the KEY field in the vidrilldown.ini file.

Parameter 2 is the value you want to set.

For example {IDCUST} for the customer
number from an ARCUS workflow.

For details, refer to Drilldown in workflow
on page 188.

SetField

Sets a configured
field to a value.

Field can be any field
on the view that the
Workflow will be
attached to

Use Extender Extender View
Info on page 172 to identify the
Field name
e.g. AMTCRLIMIT for an
A/R Customer workflow
Add the field name between
curly brackets {}.
Use values defined in the work-
flow or a set value (e.g. 1 to set
OnHold to true/selected)

You can use {VIEWID}, {VIEWKEY},
{KEYDESC}, {TOVALUE} - these correspond
to the View ID, Record Key, Description,
and Requested Value columns in the
Workflow Console screen.
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Example: To prevent a change to the
credit limit, you use SetField to restore the
value to the previous value using SetField
and {ORIGINAL_AMTCRDLMT}

Note: You can update 2 fields with
SetField . This is useful when updating
SalesPerson and SalesPercentage on
OE Order.

SetOptField
Set an optional
field value

Parameter 1 = Optional Field View ID -
Use View Info to select - Use PO0623 for
PO Header Optional Fields or G/L0400 for
GL Account Optional Field

Parameter 2 = Optional Field Name

Parameter 3 = Optional Field Value

SetStatus

SetStatus will set
the status of a
workflow instance.
The Status is
shown on the
workflow Console

P1 is the status you want to set to the
workflow instance. Displayed on the
console, on the workflow logs and in
the workflow reports.

SetValue

SetValue will add a
row to the work-
flow instance val-
ues grid.

Parameter 1 is the field name that you
want to give to the Value.

Parameter 2 is the value you want to pass.
It can be hard-coded, set to a value
defined in the workflow or set to the View
Field original or new value.

Use the field name between curly bracket
to store the new amount (e.g.
{AMTCRDLMT}

P1 can be set to {VIEWID} and value
would be the Sage 300 View ID when a
workflow is started from a screen and not
attached to a view.

ShowUserError
Displays a Error to
the logged on user
on the Sage screen.

As above.
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ShowUserMessage

Displays a Message
to the logged on
user on the Sage
screen.

Parameter 1: Text to display.

For details The message can include Vari-
ables, such as Workflow fields or Values
from the workflow.

Use an Evaluate action before using the
ShowUser actions to ensure that the mes-
sage is only showing when the view is
used on a Sage 300 screen.

field: "{PROGRAM}"

operator: "="

value: "AR1300" (RotoID of the screen
that should display a message).

ShowUserWarning

Displays a Warning
to the logged on
user on the Sage
screen.

As above.

Parameters to be used in workflow actions
The following values are available to use in action parameters and email templates used in the Work-
flow.SendEmail action:

{$1}, {$2}, {$3}, {$4} - step parameters

{PROGRAM} ID of calling program (e.g. OE1100 = Order Entry)

{ROTOID} ID of the calling view (e.g. AR0024 = AR Customers)

{USER} current user (e.g. ADMIN)

{field} gets a value either from the workflow instance values, or from the target view.

{VIEW.field} gets a value from the target view

{VALUE.name} gets a workflow instance value

{VIEWID} the view ID for this workflow instance

{VIEWKEY} the record key for this workflow instance

{KEYDESC} the description for this workflow instance

{TOVALUE} the requested value for this workflow instance

{STATUS} the current status for this workflow instance

{COLOR} the colour for this workflow instance

{CURUSER} the user or group currently assigned for this workflow instance

{WTNAME} the workflow template name for this workflow instance
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{STUSER} the user who started this workflow instance

{STEPNAME} the current step for this workflow instance

{PSTEPNAME} the previous step for this workflow instance

Formatting Numbers:

Append ':{required decimals}' to the field

E.G. {ORDTOTAL:2}

USING PARAMETERS IN WORKFLOW
Parameters can be used when attaching a workflow to a Extender view and when configuring the Pro-
gress To Steps.

To use the parameters in the workflow, use {$1}, {$2}, {$3} and {$4} in the entry step of the workflow.

Tip:
Remember to include a description of how the parameters are used in the workflow template.

Parameter 1 is to Parameter 4 is fields on the Steps setup section of the Workflow Template allow you
to describe how the parameters are used in the workflow.

PARAMETERS AND VIEW EVENTS AND SCRIPTS
You can configure up to 4 parameters when attaching a workflow to a Sage 300 View in View events
and scripts.

To use the parameter value and store it as a workflow value, include a SetValue action in the Entry
Step step

PARAMETERS AND PROGRESS TO STEPS
Each of the Progress To steps can also include up to 4 parameter fields that the next steps can use.

To use the parameter value and store it as a workflow value, include a SetValue action in the Pro-
gress-to Step step

SetValue and parameter example.
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PARAMETERS AND MANUAL WORKFLOW.
When configuring screen icons in Information Manager > Notes/DML/Extender Tray, you can enter
up to 4 parameters that can be saved in the workflow in the Entry Step.

Refer to Extender Workflow- Notes/DML/Extender Tray .

DRILLDOWN IN WORKFLOW
Drilldown is the ability to open a Sage 300 screen from the workflow console.

Requirement! Users need to be configured as a Workflow User and have security rights in Sage 300 to
the relevant module and functionality.
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Note:
Drilldown opens the Sage 300 screen and includes customisations done with Extender OCX scripts
(new buttons, etc). If there are Information Manager Notes or Document Management Link details con-
figured for the screen, they will open too.

Using the SetDrilldown action configured in the vidrilldown.ini or
viuserdrilldown.ini files
To enable drilldown for a workflow, you need to configure the key fields you want to drill down to in the
workflow template.

You use SetDrilldown action, Field= Sage 300 key field name (e.g. IDCUST) and Value = {IDCUST} - name
of the key field in the Sage 300 view.

TO FIND OUT THE FIELD NAME TO USE
You can also look at the vidrilldown.ini file in the VIXXA folder of your Extender installation.

CONFIGURING CUSTOM DRILLDOWN.
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Drill downs are defined in the vidrilldown.ini file. Do not modify the vidrilldown.ini file as it could be
overwritten with a product update.

Users can add their own viuserdrilldown.ini file in the customisation folders to add additional drill-
downs.

Drilldowns come from the following files:

1. The customization directory for the current user and organization

2. The customization directory for the current user and default organization

3. The customization directory for the default user and current organization

4. The default customization directory

5. The vixxa folder

Example: Custom Table in Extender

If you want to configure Drilldown to an Extender custom table, you need a custom script to dis-
play the table myscript.py and configure a custom drilldown in the viuserdrilldown.ini file.

vidrilldown.ini entry for custom tables

RotoId=VI1007 
Parameters=SCRIPT=myscript.py\nDOCNUM=%value%

Tip: If you see multiple records for the same drill down, it is likely that the same configuration
exists in the vidrilldown.ini and a viuserdrilldown.ini files. Ensure that the viuserdrilldown.ini file
only includes custom options that don't exist in the default file.

Examples: [A/R Customer Number]

Use SetDrilldown , Drilldown field name = {CUSTOMER} (as per the drilldown.ini file, Value =
{IDCUST} as per the ARCUS View field name.

Fields=IDCUST

RotoID=AR1300

Parameters=IDCUST={IDCUST}

DrillDownText=Open A/R Customer {IDCUST}
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O/E Order Number workflow

You can add SetDrilldown IDCUST to the current order customer and SetDrilldown ORDNUMBER for
the current Order. When looking at that order on the Console, you can drill down to the Customer or
to the Order.

A/P Payment Batch

SetDrilldown: Field = PYBATCH or APPAYBATCH, Value = {CNTBTCH} for batch number

A/P Invoice Batch

SetDrilldown: Field = APINVBATCH, Value = {CNTBTCH} for batch number
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Using Workflow value to configure drilldown
You can add a workflow value called "DRILLDOWN.xxx" where xxx can be up to 10 characters. This is use-
ful to drilldown to screens that don't have key values.

The value should be either:

desc|rotoid, or

desc|rotoid|parameters

Examples:
To drilldown to the EFT Options screen, with no key value, add a workflow value DRILLDOWN.EFT =
EFT Options|EL2000

To drilldown to the GL Batch , you can add a workflow value DRILLDOWN.GLBATCH . Value GL
Batch|GL2100|BATCHID={BATCHID}\nENTRYNBR=1

WORKFLOW BEST PRACTICES TIPS

General
1. Plan the workflow and draw a flow chart including key steps and decision points.
2. When a workflow is attached to a view field or view operation, every time the view field changes, a

workflow instance is created (even if no approval is required).

Note: If you only want the workflow to start in some circumstances, you need a custom script
and a license for Extender Customizer or Developer.
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3. Set "Auto-delete instance when complete" to Yes for most workflow. This enables you to use the
Console to manage outstanding tasks assigned to you / your group in pending workflows. The
Workflow inquiries can be used to view all previous workflows.

Actions in workflow template
COMPLETING WORKFLOW
Ensure the key branches in the workflow end with a "Complete" step. If the workflow is not com-
pleted, and there are no Progress To Actions, you need to use the "DELETE" button on the console to
clear the console.

TRUE/FALSE ACTIONS
When using SetField action in particular, ensure you have different actions for True / False

False action on critical actions of the worklow should go to a step called "ErrorMessage" that sends
an email, sets the colour to Red, assigns the record to a Power user.

SetField can return "False" if the field name is wrong or if the assigned user doesn't have sufficient
rights in Sage 300.

VALIDATING WORKFLOW ACTIONS

Check spelling of the step when using GoToStep, ensure the step exists in the work-
flow. If you rename a step in the workflow, make sure you check all the actions. If
not, users will receive an error message "Step ABC does not exist" and the workflow
will not progress to the next step.

Approval workflow to prevent fields being updated.
1. To prevent a field from being changed, the entry step needs to have an action SetField

= {ORIGINAL_FIELDNAME} (e.g. {ORIGINAL_AMTCRLIMT}). This action is required
whether there is a workflow active or not.

2. When the change is approved, the Approval step needs an action to set the field value
to the requested value SetField = {TOFIELD}

3. Workflow "Can start multiple instances" should be set to Yes and if you want to control
what happens when there is an active workflow, use the IfWorkflowExists action.

4. In most cases, when an active workflow already exists (IfWorkflowExists action = True),
the workflow displays a message to users if run from a Sage 300 screen and completes
the new workflow, leaving the original workflow instance active.
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Example:
In the A/R Credit Limit approval: 

Check step includes an action to restore the old credit limit using SetField. This action is run whether
there is a workflow active or not.

SetField {AMTCRLIMT} = {ORIGINAL_AMTCRLIMT}

Approve step includes an action to set the credit limit to the requested credit limit

SetField {AMTCRLIMT} = {TOVALUE}

Actions in steps and workflow console
Refer to Workflow Templates - Screen Guide on page 130 and Configurator Actions on page 177 for
details. It is recommended practice to include the actions below in all steps of the workflow templates to
make the console and workflow history log clearer and suited to your business practice.

DESCRIPTION
Use the SetDescription action in the workflow template to set the Workflow Status in the console and
in the workflow log depending on what step of the workflow you are in.

STATUS
Use the SetStatus action in the workflow template to set the Workflow Status in the console and in
the workflow log depending on what step of the workflow you are in.

ROW COLOURS
You can configure the workflow using the AssignColour action to assign a colour in the console
depending on what step of the workflow you are in.

Tip: You can use SetValue {TOVALUE}, insert a field from the record, such as {ORDTOTAL} when attach-
ing a workflow to a View operation to have visibility in the console and the workflow logs.

Configurator actions that require another one.
To prompt a user for parameter, you need to use " AddParameter" and " AskForParameters".

To display a message on a screen where the workflow is triggered, use Evaluate to check that the pro-
gram is a Sage 300 Screen / Roto ID and then ShowUserMessage or ShowUserWarning or ShowUserError
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WRITING CUSTOM ACTIONS FOR WORKFLOW
When using Extender Customizer or Developer Edition, you can write or import custom workflow actions.
Workflow actions are Python Extender Scripts that follow certain rules. For details on Extender scripts,
refer to Extender Scripts on page 107

Naming Extender scripts used as Workflow Actions
User defined CustomWorkflow Actions must contain the string “Workflow” in their name to allow
Extender to identify them as Workflow Actions:

[MODULE NAME].Workflow.ActionName

ActionName should be a short descriptive name with no spaces.

Tip: For details on Extender modules, refer to Extender Modules on page 115

Scripts return value
The scripts that define the custom actions are expected to return 0 for success, 1 for failure.

Note:
The result from a custom action determines whether the workflow will follow a True or False decision
branch.

Traditionally, 1 represents True, 0 represents False.

However, Workflow custom actions return 0 = True, 1 = False.

This falls in line with the 0 = success, 1 = failure convention prevalent in Sage 300 SDK development.

Therefore, for a custom action to direct a workflow down a True branch, it must return 0 (not 1).

Workflow actions and parameters
Use Parameter at the top of the script to define parameters and field names in the grid

Actions have up to 4 parameter fields
In the workflow template, you can assign a value to the parameter, up to 250 characters for each para-
meter.

Parameters are called P1, P2, P3 and P4. Each is given a label in the script.
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Parameter Labels in workflow action

## P1 Template
## P2 To
## P3 CC
## P4 Subject # leave blank to use the template subject
## P1.FinderView=VI0008
## P1.FinderField=MSGID
## P1.FinderFields=MSGID,TEXTDESC,COMMENTS,BODY

Workflow actions can have finders for the parameters.
You need to configure FinderView for the Sage 300 view storing the details, FinderField for the key field
and FinderFields for the fields you want to view in the finder grid.

Use FinderOrder to set the View Index for the FinderField

Use FinderFilter to filter the records.

Look at the Workflow.AssignColour or the Workflow.SendEmail workflow actions for example scripts.

Finder for workflow action parameter

## P1 Customer # for a finder to select an active customer setup in AR
## P1.FinderView=AR0024
## P1.FinderField=IDCUST
## P1.FinderFields=IDCUST,NAME
## P1.FinderOrder=0  #Key number
## P1.FinderFilter=SWACTV=1 #valid filter string including FIELDNAME=VALUE.
## P1.FinderFilter=IDGRP="RTL"  #example with a string

Examples: 
If you want to start a workflow when a Customer's address details are updated, you can configure a work-
flow on each address field you want to track. However, this would create a workflow record for each field.
So you would need to approve change to each field separately. You could also attach a workflow to an
{UPDATE} view operation and the workflow would include a series of Evaluate actions to identify which
fields have changed. While this would work for 2 or 3 fields, it might become cumbersome for all the
fields that make up an address.

Page 196 of 222 Workflow Technical Info



Extender

You could write a custom action "HasAddressChanged" that would return 0 if any address field has
changed, 1 if no address field has changed.

Configure Tray Icon to display Extender Logs and
Workflow
If you want to configure icons on Sage 300 screens to progress the workflow and to view workflow his-
tory, you need to configure Information Manager.

Install and activate Information Manager for your version of Sage 300.
Setup I/M Options for Extender Workflow. For details, Extender Workflow- Notes/DML/Extender
Tray

In Information Manager, I/M Options > Notes/DML/Extender Tray

AUTOMATICALLY START THE NOTES/DML/EXTENDER
Select "Yes" for the "Automatically Start Notes/DML Tray" option

The Tray will automatically start for all Sage 300 users, using their currently logged on credentials.

In order for Notes or Documents to be displayed for the user, the tray icon needs to be running while
the user is active in Sage 300 .

Note: Individual Users can overwrite the Notes setup in the IM Transactions / Notes User
Options. See details in Information Manager documentation
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DISPLAYING THE TRAY ICON ON THE TASKBAR.
Depending on your workstation setup, you may need to customise the Notification Area Icons for the
Tray icon to display on the Taskbar.

Refresh the Tray icon if you have made any changes on the IM Setup>Options in the current session as
the Tray icon reads the current setup when the company is first opened.
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Tip: If you have multiple Tray icons, Close the Sage 300 desktop and re-open to refresh the con-
figuration.

USING WORKFLOW ICONS
To enable functionality in the Workflow Console, workflow icons and Extender Log icons, the logged on
user needs to be set as a Workflow User.

Refer to Extender License and Workflow Users on page 127

Tip: ADMIN is automatically configured as a Workflow User.

EXTENDER LOG- NOTES/DML/EXTENDER TRAY
You configure an Extender Log row to add Extender Log icons to a Sage 300 screen.

The icons will allow you view the log entries for fields which have been configured with a LOG event.

Select Extender Log Note Type.

ROTOID - UNIQUE ID FOR EACH SCREEN
Enter the RotoID of the screen that should display the Extender Log Icons.

Example: Enter RotoID AR1300 to display a A/R Customer workflow on the A/R Customer screen.
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Tip: To know what RotoID/Field label to use, start the appropriate Sage 300 Screen (for example
AR Customers) then Right hand mouse click on the Information Manager Tray Icon (the key). Now,
as you click on fields in the Sage 300 Screen - the Infoset Hotkey Setup shows you the RotoID and
Field Name.

FIELD LABEL
Enter the field label from the Sage 300 screen which is to trigger the display of the Extender Log
icons.

If the Field Label is entered with quotes, e.g. "PY", Information Manager will use the hard coded value
in addition to the value set in the Second Field Label.

Important!
1. The same field may have different labels on different screens. See Example 1 below

2. The same field label may be used on the Header and Grid component of the same screen. See
Example 2 below. Adding "F."to the field label forces it to use the field control and "G." forces it to
use the grid control.

Examples:
1. In AR Receipt Entry there are two Document Number fields - one on the header and one in the
grid. To force the tray to use the correct one, you should use "F.DOCUMENT NUMBER" for the
screen label or "G.DOCUMENT NUMBER" for the grid field label. .

2. If you want the same list of documents to show on both the AR Customer Screen and the AR Cus-
tomer Inquiry, you need to add two rows in the IM Setup\Options on the Notes/DML/Extender
Tray tab. One for the Field Label “CUSTOMER NUMBER” and one for the Field Label “CUSTOMER
NO.”
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SECOND FIELD LABEL
Enter the second field label from the Sage 300 screen which is to trigger the display of the Extender
Log icons. If entered, then the document list will displayed for Field 1 = Field label and Field 2 =
Second Field Label.

Second Field Label is optional and is configured in the same manner as the Field Label.

EXTENDER LOG
Select the View ID that has the Log Events you want to access from the Sage 300 screen.

Example:
If you have a LOG event attached to A/R Credit Limit and On Hold fields, you can add the icons to selec-
ted screens.

A/R Customer - RotoID = AR130 and Field Label = Customer Number, View AR0024

A/R Customer Inquiry screen (RotoID = 1700, and field label = Customer No, View

AR0024

EXTENDER LOG ICONS ON SCREENS
This will add an Extender Log icon to the screen.

If there are Log records for the selected record on the screen, the icon will show with lines as below.

Requirement!
Selecting this option requires Orchid Extender and Information Manager to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. For details Understanding
Workflow Users on page 125

EXTENDER WORKFLOW- NOTES/DML/EXTENDER TRAY
You configure an Extender Workflow row to add Workflow icons to a Sage 300 screen.
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The icons allow Workflow User to start a workflow if it can be manually started, progress a workflow to
the next step if you are an approver, and view the workflow status and workflow history.

WORKFLOW ICONS EXPLAINED
Workflow icons only show if a workflow is configured on a specific field.

One or no workflow icon can be present per screen. Subject to Sage 300 security rights, you can use
the icons to view the workflow history.

Depending on the workflow configuration, you can also use the icons to start or progress the work-
flow.

Click to start manual workflow or view workflow history. There is no pending workflow.

Click to view active workflow. The pending workflow is not assigned to the logged on user.

Click to progress your active workflow. The workflow is assigned to the logged in user and wait-
ing for an action.

Click to progress group active workflow. The workflow is assigned to a workflow user group
that the logged in user is part of. The workflow is waiting for an action from one of the group mem-
ber.

Note: If the workflow icons are not configured in Information Manager Options, users can run the
workflow Log reports to view workflow history. Workflow users can use the workflow console to
view and progress their active workflows.

Configure Tray
Select Extender Workflow Note Type -Alert Based on Extender Script (For further details on note type,
view below)
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Fields and Controls
ROTOID - UNIQUE ID FOR EACH SCREEN
Enter the RotoID of the screen that should display the Extender Workflow Icons.

Example: Enter RotoID AR1300 to display a A/R Customer workflow on the A/R Customer screen.

Tip: To know what RotoID/Field label to use, start the appropriate Sage 300 Screen (for example
AR Customers) then Right hand mouse click on the Information Manager Tray Icon (the key). Now,
as you click on fields in the Sage 300 Screen - the Infoset Hotkey Setup shows you the RotoID and
Field Name.

FIELD LABEL
Enter the field label from the Sage 300 screen which is to trigger the display of the Extender Work-
flow icons.
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If the Field Label is entered with quotes, e.g. "PY", Information Manager will use the hard coded value
in addition to the value set in the Second Field Label.

Important!
1. The same field may have different labels on different screens. See Example 1 below

2. The same field label may be used on the Header and Grid component of the same screen. See
Example 2 below. Adding "F."to the field label forces it to use the field control and "G." forces it to
use the grid control.

Examples:
1. In AR Receipt Entry there are two Document Number fields - one on the header and one in the
grid. To force the tray to use the correct one, you should use "F.DOCUMENT NUMBER" for the
screen label or "G.DOCUMENT NUMBER" for the grid field label. .

2. If you want the same list of documents to show on both the AR Customer Screen and the AR Cus-
tomer Inquiry, you need to add two rows in the IM Setup\Options on the Notes/DML/Extender
Tray tab. One for the Field Label “CUSTOMER NUMBER” and one for the Field Label “CUSTOMER
NO.”

SECOND FIELD LABEL
Enter the second field label from the Sage 300 screen which is to trigger the display of the Extender
Workflow icons. If entered, then the document list will displayed for Field 1 = Field label and Field 2 =
Second Field Label.

Second Field Label is optional and is configured in the same manner as the Field Label.

EXTENDER WORKFLOW
Browse to select the Extender Workflow template to be added to the Sage 300 screen.

The workflow needs to be attached to a Sage 300 view that is related to the screen the icon is
attached to.

WORKFLOW ENTRY STEP
If the workflow template "Can be started manually" is set to "Yes", select an Entry Step. This will
enable users to start the workflow manually from the screen.

If the workflow template "Can be started manually" is set to "No", don't select an entry step. Th work-
flow will be started automatically if configured in View Events and Scripts and you can view the Work-
flow Log and progress the workflow from the screen.
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Examples

Example:
A/R Customer workflow on A/R Screens

If you have an A/R Credit Limit approval workflow, you can add the icons to selected screens: 

A/R Customer Screen- RotoID = AR1300 and Field Label = Customer Number

A/R Customer Inquiry screen - RotoID = 1700, and field label = Customer No
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Example:
A/P Payment Batch workflow on A/P Payment batch screen

The A/P Payment batch view has a multi-part key, including the Batch Type and the Batch Number. The
workflow key is set to PY,Batch number, so the Information Manager configuration needs to include 2
fields as shown below.

Field 1 should be set to "PY" (with quotes) and field 2 set to BATCH NUMBER.

Requirement!
Selecting this option requires Orchid Extender and Information Manager to be installed and activated.

To use the functionality, a user needs to be flagged as a Workflow User. For details on functionality
and licensing method, refer to Understanding Workflow Users on page 125

Note:
If the Information Manager Tray is not started, the icons will not show and the user will not be able to
use the workflow icons to start or progress the workflow.

However, workflows attached to view operation or view field changes will be started and users con-
figured as Understanding Workflow Users on page 125 are able to access the Workflow Console.

You can start the tray manually in Information Manager > Tray Icon.
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Remote Action Service : Progress Extender Work-
flow remotely
When a Workflow Action is assigned to an individual (or group member), they can be notified by email.
That email is configured to contain a unique hyperlink to a Remote Action service web page/fleeting
form.

The Remote Action page is entirely independent from Sage 300, and merely requires internet access. The
form is unique to a given user and Workflow Action.

The form is configurable in the Workflow Template. E.g. it could include Approve and Reject buttons, cap-
ture a comment, and capture new values for a Sage 300 field related to the action.

Completed forms are pulled into Sage 300 when required. Orchid Process Scheduler can be used to poll
the Remote Action site automatically on a regular basis for newly completed action data, and feed the
results back into Sage 300 to progress the Workflow. Completed forms are then deleted from the web-
site.

To get started, refer to Remote Action Service - Getting Started on the next page

Refer to Online Help for details. Remote Action Service Online Documentation

Remote Action user guide can be found online: User Guides
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Remote Action Service - Getting Started 208
Remote Action Message Templates 213
Add Remote Action to Workflow Template 215

REMOTE ACTION SERVICE - GETTING STARTED
Remote Action service is used in conjunction with Extender workflow to enable approvals of Sage 300
records outside of the Sage 300 environment. Approvers receive a one time email link that they can use
to complete the Approval (or rejection) form.

For details on how it works - refer to Remote Action Service : Progress Extender Workflow remotely on
the previous page

In most cases, you configure the Extender Workflow as per your required flowchart first without Remote
Action Service. Once you have tested the workflow template, you can add a Remote Action Service
action to send the email to the approvers with the link to approve outside of Sage 300.
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Example: Tutorial: Remote Action tutorial - A/R Credit Limit approvals

Requirement!
The following modules are required to use the Remote Action Service: 

Extender (Configurator or Developer)
Workflow Users
Remote Action Subscription
Process Scheduler Level 1 and above to automate completed form retrieval (optional
but highly recommended)

Prerequisites - install Extender and Remote action service

Extender setup

Ensure the latest product update for Extender installed and activated.
In Extender Options, set the Python version to version 3.8.8 - Refer to Python Version
on page 79
In Extender Options > Email Tab, configure the SMTP Details as Remote Action service
needs to email. Refer toExtender Email Tab on page 80
Configure Workflow Users. Extender License and Workflow Users on page 127

Install Remote Action Service

Subscribe to the Remote Action Service through your Sage 300 Business partner and
have the token available.
Import the RemoteAction.vi module

REMOTE ACTION MODULE DETAILS
The Remote Action module includes the Extender custom tables and scripts required to configure
and manage the service.

Remote Action Scripts
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Workflow Actions

It also includes three workflow actions to build the form hyperlink and email the on-time link to the
workflow users.

SendRemoteActionCommentAmountFormEmail includes a comment and an amount field for the
approver to complete. Amount defaults to the requested value in the workflow.

Example: Used to Approve A/R Credit limit

SendRemoteActionCommentFormEmail: includes a comment field only.

SendRemoteActionFormEmail: No user input is captured. Form only includes the buttons configured
in the workflow template.

Custom Table and Configuration record

Remote Action includes a default handler in the Remote Action Handlers custom table for use with
the workflow. This is created when you install Remote Action module. In some rare cases, if the con-
figuration record is missing, you may need to add it manually.

Form Type: workflow_approval

Handler Class: remote_actions.handlers.workflow_approval.WorkflowApprovalFormHandler
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Install Process Scheduler

Although this is optional, it is highly recommended to automate the retrieval of the completed remote
action forms. Refer to Running the Poller with Process Scheduler on page 213

Configure Remote Action module
Step 1: Go to Remote Action menu, select Configure and enter the token provided.
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Note: If you don't have a token, contact your Sage 300 Business Partner to enable the service.

Step 2: Run Remote Action Option - Optionally, enter a website address for the logo you want to see
on the form and an email address to be displayed on the form. For details, refer to Remote Action
Admin.

Step 3: Add Extender Message templates to configure the notification email and the remote form con-
tent. For details, Remote Action Message Templates on the facing page

Step 4: Include one of the Remote Action in a workflow template - For details, Add Remote Action to
Workflow Template on page 215

Configure Remote Action poller
To process the remote requests into Sage 300, you can run the Extender RemoteAction.poller script. The
script is in the Extender > Remote Action menu

Note: The script can only be run manually by the ADMIN user.

POLLER DESCRIPTION
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Poller is an Extender script designed to process all completed requests and bring the action results
into Sage 300 to progress the workflow.

The RemoteAction.poller connects to the Remote Action Service to retrieve and process completed
forms. For each form, it progresses the workfow according to the details submitted by the user on
the Remote Action form.

For example, if the user approves the workflow request, the workflow status is updated as per the
Approve step configured in the workflow template.

If the poller encounters any error, for example another user has already approved the workflow,
using their Remote Action link or using the Extender console, the poller will log an error.

Running the Poller with Process Scheduler

In most cases, you configure Process Scheduler to run the script and use Windows Task Scheduler to
update the data automatically as often as required.

Setting Up Process Scheduler - Configure Process Scheduler to run the imports automatically

Setting Up the Windows Scheduled Task - Task Scheduler

Tips:
The user configured in Process Scheduler Companies needs to have "Modify all workflow" rights in
Sage Security Groups as it needs to progress the workflow records. It also needs to have all the Sage
security rights to perform the actions in the Approve/Reject steps (e.g. Post batches, update Customer
or Vendor).

It is important that an admin user reviews the Process Scheduler Logs regularly.

REMOTE ACTION MESSAGE TEMPLATES
Remote action service uses Extender message templates in two ways: 

1. Configure the email notification sent to the users who need to approve the record / acknowledge the
alert.

2. Configure the remote form that users navigate to from the email

Refer to Message Templates on page 100

The Remote Action module includes two default message templates.
REMOTEACTION.WFAPPROVALFORMEMAIL and REMOTEACTION.WFAPPROVALFORM

You can create new message templates for the different workflows that use Remote Actions.

Tip: Name the message template with a module ID to facilitate installation between test and live serv-
ers.
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Email message templates
Message templates can include variables including field names of the Sage 300 views the workflow is
attached to.

To send a Remote Action link, the email message selected in the workflow template action needs to
include a special variable {FORMURL} to build the unique link for remote action. This requires an active
Internet connection and an active subscription to the Remote Action service. See details in Remote
Action Admin

Tip: If the token is invalid or the subscription to the service has expired, {FORMURL} cannot be
replaced.

Sample HTML Email Template with {FORMURL}

<html>
<body>
<p>Hi  {CURUSER} team member</p>

<p> <b> Company {ORG} - {CONAME} <b></p>

<p>There are workflow records marked for your attention</p>

<p>Please review</p>

<p>The request was made on {DD}/{MM}/{YYYY} at {HOUR}:{MINUTE}:{SECOND}  by {USER}</p>

<p>To Approve / Reject remotely, click on the link below</p>

<p>{FORMURL}</p>

<p>If you want to see more details or drill down to the detailed entry, use the Sage 300 work-
flow console to accept / reject, use the link below</p> <p><a href="orchid:
{ORG}/VI1015/&amp;All=Assigned%20only%20to%20&amp;me">Workflow Console</a></p>
<p>&nbsp;</p>
<p>&nbsp;</p>

</body>
</html>

Tip: When using Remote Action to progress the workflow, make sure the message template used to
notify users that the workflow has been progressed (request approved or rejected), includes
{RUNUSER}. Refer to When using the Remote Action Service, user {RUNUSER} as the workflow {USER} is
the user who runs the poller script or the user configured in Process Scheduler.

Form template
The message template subject becomes the form title.

The message template body becomes the content of the form.

If you have configured a logo in Remote Action Admin, the logo is displayed at the top of the form.
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Note:
You can use HTML Tags in the Remote Form message template. Commonly used HTML Tags have
been white-listed in the service.

If you use HTML message template for the form, it must include HTML and BODY Tags.

Sample HTML Form Template

<html>
<body>
<p>Company {ORG} - {CONAME}</p>

<p>Workflow records available to review.</p>

<p>Please review ....</p>

<p>The request was made on {DD}/{MM}/{YYYY} at {HOUR}:{MINUTE}:{SECOND} by  {USER}</p>

</body>
</html>

The form message template (both subject and body) can include variables to display values from Sage
300. Refer to Message Template Variables.

For more details on the form configuration, refer to Form Description

ADD REMOTE ACTION TO WORKFLOW TEMPLATE

Remote Action includes three standard actions
Requirement! The standard actions can be used with Extender Configurator (as well as Developer).

Select the appropriate action to build the form and email the link to the approver (Workflow user or user
group)

SendRemoteActionCommentAmountFormEmail: Select this workflow action to include a comment
(up to 250 characters) and an amount field on the form.

Both fields are mandatory. The amount field defaults to the Requested value in the workflow

SendRemoteActionCommentFormEmail: Select this workflow action to include an amount field on
the form. The amount field defaults to the requested value in the workflow.

SendRemoteActionFormEmail: Select this action if you don't need to capture input from the
approver. The Form includes only the buttons configured in P4.
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action parameters
All actions require 4 parameters in the workflow template.

Email Template (P1): Select the message template to send the email including the FORMURL link to users
who need to approve the record.

To (P2): Enter a valid Sage User or Workflow User Groups -

Requirement! Users need an Extender Workflow named user licence to progress the workflow and
use the Remote Action Service.

Form Template (P3): Select the message template used to build the remote form. Message subject is
Form Title and Message Body is Form content.

Form button lists (P4): Enter a comma separated list of Labels=Stepname pairs. The stepname needs to
be a valid workflow step. You need at least 2 buttons on each form.
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Example:
OK-Approve=Approve,Not-OK=Reject - The form will show 2 buttons: OK-Approve and Not-OK

The workflow template includes 2 steps: Approve and Reject.

For details, refer to : 

Form Description

Remote Action Message Templates on page 213

user input
User input captured on the remote forms is saved in workflow values

Comment field = APPROVALCOMMENT

Amount field = APPROVALAMOUNT

To use the values in the workflow templates, you need to use workflow values with the same name, for
example in the SetField action, you can update a Numeric field on the record with the
{APPROVALAMOUNT} workflow value.

Remote Action Service : Progress Extender Workflow remotely Page 217 of 222

../../../../../../Content/RemoteAction/Form-Description.htm


Extender

Example:

EXAMPLE WITH AR CREDIT LIMIT

The example workflow uses the SendRemoteActionCommentAmountFormEmail . In the Approve
step, the workflow updates the A/R Customer credit limit field to the value entered on the form.

The form defaults to the requested value, but the approver can overwrite.

Notes:
Step with user input - you can configure Remote Action to collect user input. When the same step can
be used on the Workflow console in Sage 300 and using Remote Action, the parameters entered on
the remote form are saved in the workflow when the requests are processed in Sage 300 by the poller
script (or Process Scheduler). In such scenarios, the users are not prompted to enter data in Process
Scheduler.

Useful reference

Refer to Workflow Templates - Screen Guide on page 130

Advanced: How to configure actions
Refer to Amend Remote Form
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Requirement! Requires Extender Developer Edition.
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